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This preface describes the contents of Basic System Administration and provides pointers 

to VMware® technical and educational resources. 

This preface contains the following topics:

 “About This Book” on page 11

 “Technical Support and Education Resources” on page 13

About This Book
This manual, Basic System Administration, describes how to start and stop the Virtual 

Infrastructure Client components, build your VMware Infrastructure environment, 

monitor and manage the information generated about the components, and set up roles 

and permissions for users and groups using the VMware Infrastructure environment. 

This manual also provides information for managing, creating, and configuring virtual 

machines in your datacenter. 

In addition, this manual provides brief introductions to the various tasks you can 

perform within the system as well as cross‐references to the documentation that 

describes all the tasks in detail. 

Revision History
This manual is revised with each release of the product or when necessary. A revised 

version can contain minor or major changes. Table P‐1 provides you with the revision 

history of this manual.

Preface
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Intended Audience
The information presented in this manual is written for system administrators who are 

experienced Windows or Linux system administrators and who are familiar with 

virtual machine technology and datacenter operations.

Document Feedback 
If you have comments about this documentation, submit your feedback to: 

docfeedback@vmware.com

VMware Infrastructure Documentation
The VMware Infrastructure documentation consists of the combined VirtualCenter and 

ESX Server documentation set. 

You can access the most current versions of this manual and other books by going to:

http://www.vmware.com/support/pubs

Conventions 
Table P‐2 illustrates the typographic conventions used in this manual. 

Table P-1.  Revision History

Revision Description

20060615 ESX Server 3.0 and VirtualCenter 2.0 version of VMware Infrastructure 3 
Basic System Administration. This is the first edition of this manual.

20060921 ESX Server 3.0.1 and VirtualCenter 2.0.1 version of VMware Infrastructure 
3 Basic System Administration. This edition includes minor changes to 
virtual machine template, new virtual machine wizard, and migration 
information.

Table P-2.  Conventions Used in This Manual

Style Elements

Blue (online only) Cross‐references and email addresses

Blue boldface (online only) Links

Black boldface User interface elements such as button names and menu items

Monospace Commands, filenames, directories, and paths

Monospace bold User input

mailto:docfeedback@vmware.com
http://www.vmware.com/support/pubs
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Abbreviations Used in Graphics
The graphics in this manual use the abbreviations listed in Table P‐3.

Technical Support and Education Resources
The following sections describe the technical support resources available to you.

Self-Service Support
Use the VMware Technology Network (VMTN) for self‐help tools and technical 

information:

 Product information – http://www.vmware.com/products/

 Technology information – http://www.vmware.com/vcommunity/technology

 Documentation – http://www.vmware.com/support/pubs

 VMTN Knowledge Base – http://www.vmware.com/support/kb

 Discussion forums – http://www.vmware.com/community

Italic Document titles, glossary terms, and occasional emphasis

< Name >  Variable and parameter names

Table P-2.  Conventions Used in This Manual (Continued)

Style Elements

Table P-3.  Abbreviations

Abbreviation  Description

VC  VirtualCenter

VI  Virtual Infrastructure Client

server  VirtualCenter Server

database  VirtualCenter database

hostn  VirtualCenter managed hosts

VM#  Virtual machines on a managed host

user#  User with access permissions

dsk#  Storage disk for the managed host

datastore  Storage for the managed host

SAN Storage area network type datastore shared between managed hosts

tmplt  Template

http://www.vmware.com/products/
http://www.vmware.com/vcommunity/technology
http://www.vmware.com/support/pubs
http://www.vmware.com/support/kb
http://www.vmware.com/community
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 User groups – http://www.vmware.com/vcommunity/usergroups.html

For more information about the VMware Technology Network, go to 

http://www.vmtn.net.

Online and Telephone Support
Use online support to submit technical support requests, view your product and 

contract information, and register your products. Go to 

http://www.vmware.com/support.

Customers with appropriate support contracts should use telephone support for the 

fastest response on priority 1 issues. Go to 

http://www.vmware.com/support/phone_support.html.

Support Offerings
Find out how VMware support offerings can help meet your business needs. Go to 

http://www.vmware.com/support/services.

VMware Education Services
VMware courses offer extensive hands‐on labs, case study examples, and course 

materials designed to be used as on‐the‐job reference tools. For more information about 

VMware Education Services, go to http://mylearn1.vmware.com/mgrreg/index.cfm.

http://www.vmware.com/vcommunity/usergroups.html
http://www.vmware.com/vcommunity
http://www.vmware.com/support
http://www.vmware.com/support/phone_support.html
http://www.vmware.com/support/services
http://mylearn1.vmware.com/mgrreg/index.cfm
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1

This chapter introduces VMware Infrastructure components and the operations that 

you use when managing your virtual machines through ESX Server or VirtualCenter 

Server. 

This chapter contains the following topics:

 “Two Approaches to Managing Virtual Machines” on page 17

 “Components of VMware Infrastructure” on page 19

 “Virtual Infrastructure Client Interfaces” on page 21

 “Optional VirtualCenter Components” on page 21

 “Managed Components” on page 22

 “Functional Components” on page 24

 “Access Privileges Components” on page 25

Two Approaches to Managing Virtual Machines
Virtual Infrastructure Client (VI Client) is a flexible, configurable solution for managing 

your virtual machines. There are two primary methods for managing your virtual 

machines: 

 Directly through an ESX Server (a single or standalone host) that can manage only 

those virtual machines, and their resources, installed on it.

 Through a VirtualCenter Server that manages multiple virtual machines and their 

resources distributed over many ESX Server hosts.

VMware Infrastructure 
Components 1
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The figure below illustrates the components in an ESX Server Virtual Infrastructure.

Figure 1-1.  VMware Infrastructure Components with an ESX Server

The figure below illustrates the components in a VirtualCenter Server Virtual 
Infrastructure.

Figure 1-2.  VMware Infrastructure Components with a VirtualCenter Server
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Chapter 1 VMware Infrastructure Components

Components of VMware Infrastructure
To run your VMware Infrastructure environment, you need the following items:

 ESX Server – The virtualization platform used to create the virtual machines as a 

set of configuration and disk files that together perform all the functions of a 

physical machine. 

Through ESX Server, you run the virtual machines, install operating systems, run 

applications, and configure the virtual machines. Configuration includes 

identifying the virtual machine’s resources, such as storage devices.

The server incorporates a resource manager and service console that provides 

bootstrapping, management, and other services that manage your virtual 

machines. 

Each ESX Server has a VI Client available for your management use. If your ESX 

Server is a registered host with the VirtualCenter Management Server, a VI Client 

that accommodates the VirtualCenter features is available.

 VirtualCenter – A service that acts as a central administrator for VMware ESX 

Server hosts that are connected on a network. VirtualCenter directs actions on the 

virtual machines and the virtual machine hosts (the ESX Server hosts). 

 VirtualCenter Management Server (VirtualCenter Server) – The working core of 

VirtualCenter. VirtualCenter Server is a single Windows Service and is installed to 

run automatically. As a Windows Service, the VirtualCenter Server runs 

continuously in the background, performing its monitoring and managing 

activities even when no VI Clients are connected and even if nobody is logged on 

to the computer where it resides. It must have network access to all the hosts it 

manages and be available for network access from any machine where the VI 

Client is run. 

 VirtualCenter database – A persistent storage area for maintaining status of each 

virtual machine, host, and user managed in the VirtualCenter environment. The 

VirtualCenter database can be remote or local to the VirtualCenter Server machine. 

The database is installed and configured during VirtualCenter installation. 

If you are accessing your ESX Server directly through a VI Client, and not through 

a VirtualCenter Server and associated VI Client, you do not use a VirtualCenter 

database.

 Datastore – The storage locations for the virtual machine files specified when 

creating virtual machines. Datastores hide the idiosyncrasies of various storage 

options (such as VMFS volumes on local SCSI disks of the server, the Fibre Channel 

SAN disk arrays, the iSCSI SAN disk arrays, or Network Attached Storage (NAS) 
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arrays) and provide a uniform model for various storage products required by 

virtual machines. 

 VirtualCenter agent – On each managed host, software that collects, 

communicates, and executes the actions received from the VirtualCenter Server. 

The VirtualCenter agent is installed the first time any ESX Server host is added to 

the VirtualCenter inventory.

 Host agent – On each managed host, software that collects, communicates, and 

executes the actions received through the VI Client. It is installed as part of the ESX 

Server installation. 

 VirtualCenter license server – Server that stores software licenses required for 

most operations in VirtualCenter and ESX Server, such as powering on a virtual 

machine. 

VirtualCenter and ESX Server support two modes of licensing: license 

server‐based and host‐based. In host‐based licensing mode, the license files are 

stored on individual ESX Server hosts. In license server‐based licensing mode, 

licenses are stored on a license server, which makes these licenses available to one 

or more hosts. You can run a mixed environment employing both host‐based and 

license server‐based licensing. 

VirtualCenter and features that require VirtualCenter, such as VMotion, must be 

licensed in license server‐based mode. ESX Server‐specific features can be licensed 

in either license server‐based or host‐based mode. 

For complete information on installing these components, refer to the Installation 

and Upgrade Guide. For complete information on configuring ESX Server, refer to 

the Server Configuration Guide.
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Virtual Infrastructure Client Interfaces
Virtual Infrastructure Client interface options include:

 Virtual Infrastructure Client (VI Client) – A required component and the primary 

interface for creating, managing, and monitoring virtual machines, their resources, 

and their hosts. It also provides console access to virtual machines.

VI Client is installed on a Windows machine with network access to your ESX 

Server or VirtualCenter Server installation. The interface displays slightly different 

options depending on which type of server you are connected to. While all 

VirtualCenter activities are performed by the VirtualCenter Server, you must use 

the VI Client to monitor, manage, and control the server. A single VirtualCenter 

Server or ESX Server can support multiple, simultaneously connected VI Clients. 

 Virtual Infrastructure Web Access (VI Web Access) – A Web interface through 

which you can perform basic virtual machine management and configuration and 

get console access to virtual machines. It is installed with your ESX Server. Similar 

to the VI Client, VI Web Access works directly with an ESX Server host or through 

VirtualCenter. Refer to the VI Web Access Administrator’s Guide for additional 

information.

 VMware Service Console – A command‐line interface for configuring your ESX 

Server. Typically, this is used in conjunction with a VMware technical support 

representative.

Optional VirtualCenter Components
Additional VirtualCenter features include:

 VMotion – A feature that enables you to move running virtual machines from one 

ESX Server to another without service interruption. It requires licensing on both 

the source and target host. The VirtualCenter Server centrally coordinates all 

VMotion activities.

 VMware HA – A feature that enables a cluster with High Availability. If a host goes 

down, all virtual machines that were on the host are promptly restarted on 

different hosts. 

When you enable the cluster for HA, you specify the number of hosts you would 

like to be able to recover. If you specify the number of host failures allowed as 1, 

HA maintains enough capacity across the cluster to tolerate the failure of one host. 

All running virtual machines on that host can be restarted on remaining hosts. By 

default, you cannot power on a virtual machine if doing so violates required 

failover capacity. See Resource Management Guide.
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 VMware DRS – A feature that helps improve resource allocation across all hosts 

and resource pools. VMware DRS collects resource usage information for all hosts 

and virtual machines in the cluster and gives recommendations (or migrates 

virtual machines) in one of two situations:

 Initial placement – When you first power on a virtual machine in the cluster, 

DRS either places the virtual machine or makes a recommendation. 

 Load balancing – DRS tries to improve resource utilization across the cluster 

by performing automatic migrations of virtual machines (VMotion) or by 

providing a recommendation for virtual machine migrations.

 VMware Infrastructure SDK package – APIs for managing virtual infrastructure 

and documentation describing those APIs. The SDK also includes the 

VirtualCenter Web Service interface, Web Services Description Language (WSDL), 

and example files. This is available through an external link. To download the SDK 

package, refer to http://www.vmware.com/support/developer.

Managed Components
VirtualCenter monitors and manages various components of your virtual and physical 

infrastructure. Some components are available for organizing potentially hundreds of 

virtual machines and other objects. They can be renamed to represent their purposes; 

for example, they can be named after company departments or locations or functions. 

The managed components are:

 Virtual Machines and Templates – A virtualized x86 personal computer 

environment in which a guest operating system and associated application 

software can run. Multiple virtual machines can operate on the same managed host 

machine concurrently. Templates are a designated type of virtual machine.

 Hosts – The primary component upon which all virtual machines reside. If the 

Virtual Infrastructure Client is connected to a VirtualCenter Server, there can be 

many hosts. If the Virtual Infrastructure Client is connected to an ESX Server, there 

can be only one host.

 Resource pools – A structure that allows delegation of control over the resources 

of a host. Resource pools are used to compartmentalize all resources in a cluster. 

You can create multiple resource pools as direct children of a host or cluster and 

NOTE When VirtualCenter refers to a host, this means the physical machine on which the 

virtual machines are running. All virtual machines within the VMware 

Infrastructure environment are physically on ESX Server hosts. The term host in 

this manual means the ESX Server host that has virtual machines on it.
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configure them. Then delegate control over them to other individuals or 

organizations. The managed resources are CPU and memory from a host or cluster. 

Virtual machines execute in, and draw their resources from, resource pools.

 Clusters – A collection of ESX Server hosts with shared resources and a shared 

management interface. When you add a host to a cluster, the host’s resources 

become part of the cluster’s resources. The cluster manages the resources of all 

hosts. Refer to the Resource Management Guide.

 Datastores – Virtual representations of combinations of underlying physical 

storage resources in the datacenter. These physical storage resources can come 

from the local SCSI disk of the server, the Fibre Channel SAN disk arrays, the iSCSI 

SAN disk arrays, or Network Attached Storage (NAS) arrays.

 Networks – Networks that connect virtual machines to each other in the virtual 

environment or to the physical network outside.

 Folders – Containers used to group objects and organize them into hierarchies. 

This is not only convenient but also provides a natural structure upon which to 

apply permissions. 

There are three types of folders, each of which can contain other folders (of the 

same type) and exactly one other type of object. These objects are: 

 Datacenters

 Virtual machines (which include templates)

 Compute resources (which include hosts and clusters) 

The datacenter folders form a hierarchy directly under the root node and allow 

users to group their datacenters in any convenient way. Within each datacenter is 

one hierarchy of folders with virtual machines and/or templates and one hierarchy 

of folders with hosts and clusters.

 Datacenters – Unlike a folder, which is used to organize a specific object type, a 

datacenter is an aggregation of all the different types of objects needed to do work 

in virtual infrastructure: hosts, virtual machines, networks, and datastores.

Within a datacenter there are four separate hierarchies. Because it is not possible to 

put networks or datastores into folders, these four hierarchies are always flat lists:

 Virtual machines (and templates)

 Hosts (and clusters)

 Networks

 Datastores
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Datacenters act as the namespace boundary for these objects. You cannot have two 

objects (for example, two hosts) with the same name in the same datacenter, but 

you can have two objects with the same name in different datacenters. Because of 

the namespace property, VMotion is permitted between any two compatible hosts 

within a datacenter, but even powered off virtual machines cannot be moved 

between hosts in different datacenters. Moving an entire host between two 

datacenters is permitted.

Functional Components
The functional components monitor and manage tasks. The functional components are 

available through a navigation button bar in the VI Client. The options are:

 Inventory – A view of all the monitored objects in VirtualCenter. Monitored 

objects include datacenters, resource pools, clusters, networks, datastores, 

templates, hosts, and virtual machines.

 Scheduled tasks – A list of activities and a means to schedule those activities. This 

is available through VirtualCenter Server only.

 Events – A list of all the events that occur in the VirtualCenter environment. Use 

the Navigation option to display all the events. Use an object‐specific panel to 

display only the events relative to that object.

 Admin – A list of environment‐level configuration options. The Admin option 

provides configuration access to Roles, Sessions, Licenses, Diagnostics, and 

System Logs. When connected to an ESX Server, only the Roles option appears. 

 Maps – A visual representation of the status and structure of the VMware 

Infrastructure environment and the relationships between managed objects. This 

includes hosts, networks, virtual machines, and datastores. This is available only 

through VirtualCenter Server.

Various information lists are generated and tracked by your Virtual Infrastructure 

Client activity: 

 Tasks – These activities are scheduled or initiated manually. Tasks generate event 

messages that indicate any issues associated with the task. 

 Events – Messages that report Virtual Infrastructure activity. Event messages are 

predefined in the product. 

 Alarms – Specific notifications that occur in response to selected events. Some 

alarms are defined by product default. Additional alarms can be created and 

applied to selected inventory objects or all inventory objects. 
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 Logs – Stored reference information related to selected event messages. Logs are 

predefined in the product. You can configure whether selected logs are generated.

Access Privileges Components
Each user logs on to a VirtualCenter or an ESX Server through the VI Client. Each user 

is identified to the server as someone who has rights and privileges to selected objects, 

such as datacenters and virtual machines, within the VMware Infrastructure 

environment. VirtualCenter Server itself has full rights and privileges on all hosts and 

virtual machines within the VMware Infrastructure environment. The server passes on 

only those actions and requests from a user that the user has permission to perform.

The server grants access to each Virtual Infrastructure Client object, datacenter, folder, 

or virtual machine. To do this, you assign a role and a user (or group) to each object.

Individual permissions are assigned through the VI Client by pairing a user and a role 

and assigning this pair to a Virtual Infrastructure Client object:

 Users and Groups – For VirtualCenter, users and groups are created and 

maintained through the Windows domain or Active Directory database. Users and 

groups are registered with VirtualCenter, or created and registered with an ESX 

Server, through the process that assigns privileges. 

 Roles – A set of access rights and privileges. There are selected default roles. You 

can also create roles and assign combinations of privileges to each role. 
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Basic System Administration describes the tasks you must complete to configure the 

Virtual Infrastructure Client (VI Client) and virtual machines. Before using the 

information in Basic System Administration, read the Introduction to VMware 

Infrastructure for an overview of system architecture and the physical and virtual 

devices that make up a VMware Infrastructure system.

This introduction summarizes the contents of this guide so that you can find the 

information you need. This guide covers these subjects: 

 VMware Infrastructure components

 Administration tools

 System configuration

 Virtual machine management and configuration

 Access and permissions management

 System administration and management

Getting Started
The introductory discussion spans seven chapters and describes the system 

components, system management tools, and the basic tasks you must complete to 

configure your Virtual Infrastructure Client. The introductory part contains the 

following chapters:

 Using this Document – Summarizes the contents of this guide so that you can find 

the information you need. 

Using this Document 2
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 VMware Infrastructure Components – Introduces you to the VMware 

Infrastructure components and operations you use when managing your virtual 

machines through ESX Server or VirtualCenter Server. 

 Starting and Stopping the VMware Infrastructure Components – Describes how to 

start and stop each of the VMware Infrastructure components. This includes the 

ESX Server, VirtualCenter Server, Virtual Infrastructure Client, Virtual 

Infrastructure Web Access, VirtualCenter host agent, VirtualCenter license server, 

and the VMware Service Console.

 Using the VI Client – Describes the specific layout and navigation of the VI Client. 

 System Configuration – Contains information for configuring administration 

options, VirtualCenter Server settings, and managing host configuration options. 

It also includes some basic system configuration information, such as how to 

access and configure log files and set up SNMP.

 Managing the VI Client Inventory – Describes how to perform tasks with objects in 

your VMware Infrastructure environment. This includes folders, datacenters, 

clusters, resource pools, networks, and datastores. These objects are used to 

manage or organize the monitored and managed hosts and virtual machines.

 Managing Hosts in VirtualCenter – Describes how to perform managed 

host‐related tasks. 

Virtual Machine Management
The virtual machine management discussion consists of seven chapters that provide a 

basic understanding of virtual machines and how to manage, configure, and customize 

them. The virtual machine management part contains the following chapters:

 Creating Virtual Machines – Describes how to create virtual machines by using the 

New Virtual Machine wizard and by cloning existing virtual machines.

 Managing Virtual Machines – Describes virtual machine tasks, including adding a 

virtual machine to and removing it from the VI Client and powering on and off 

virtual machines.

 Configuring Virtual Machines – Describes how to edit and configure your existing 

virtual machines. It also discusses advanced virtual machine configuration 

options.

 Using Snapshots – Explains how to capture the entire state of the virtual machine 

using the snapshots feature.

 Working with Templates and Clones – Describes creating templates and using 

virtual machine templates to create and provision new virtual machines.
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 Migrating Virtual Machines – Describes the process of migrating or moving a 

virtual machine from one host to another.

 Customizing Guest Operating Systems – Explains how to customize the identity 

and network settings of your virtual machine’s guest operating system so that it is 

ready to begin work immediately in your target environment.

System Administration
The system administration part contains the following chapters:

 Managing Users, Groups, Permissions, and Roles – Describes how to manage 

access to VMware Infrastructure inventory objects. It explains how to configure 

users, groups, roles, and permissions.

 Monitoring Your Vmware Infrastructure Environment – Describes the 

performance monitoring pieces of the Virtual Infrastructure Client data presented 

in the VI Client. It also describes the Virtual Infrastructure Client Maps feature.

 Managing Tasks, Events, and Alarms – Describes how to create, configure, and use 

tasks, events, and alarms. 

Appendixes
Basic System Administration provides these four appendixes with specialized 

information you might find useful when configuring your VMware Infrastructure 

environment:

 Defined Privileges – Includes tables with the permissions and roles that are 

available with the VMware Infrastructure system.

 Installing the Microsoft Sysprep Tools – Describes how to install the Microsoft 

Sysprep tools on your VirtualCenter Server machine. Installing the Sysprep tools 

is a requirement if you plan to customize a Windows guest operating system.

 Performance Chart Measurements – Includes tables with the measurement options 

for each resource monitored on a host.
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This chapter includes information on how to start and stop each one of the major 

VMware Infrastructure components, ESX Server and VirtualCenter Server. 

This chapter contains the following topics:

 “ESX Server” on page 31

 “VirtualCenter Server” on page 33

 “VI Client” on page 34

 “VI Web Access” on page 36

 “VMware Service Console” on page 37

ESX Server
When you install ESX Server, it starts itself through the installation reboot process. If 

your ESX Server is shut down, you must manually restart it.

To start your ESX Server

On the physical box where the ESX Server is installed, press the power button until the 

power on sequence begins.

The ESX Server boots, discovers its virtual machines, and proceeds with its normal ESX 

Server functions.

You have the option to power off or restart (reboot) any ESX Server host managed by 

VirtualCenter. Powering off a managed host disconnects it from the VirtualCenter 

Server but does not remove it from the inventory. 

Starting and Stopping the 
VMware Infrastructure 
Components 3
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To reboot or shut down your ESX Server

1 Start a Virtual Infrastructure Client.

Refer to “Configuring VirtualCenter Communication” on page 68 for information.

2 Display the inventory panel and the appropriate ESX Server hosts.

3 If connected to a VirtualCenter Server, display the inventory’s: Hosts & Clusters 

panel. Select the appropriate root folder (by default labeled Hosts & Clusters) or 

subfolder.

4 Select the appropriate ESX Server in the inventory panel. 

5 From the main or right‐click pop‐up menu, choose Reboot or Shut Down, as 

appropriate. 

 If Reboot is selected, the ESX Server shuts down and reboots.

 If Shut Down is selected, the ESX Server shuts down. You must manually 

power the system back on.

6 Provide a reason for the shut down. 

This information is added to the log.

To manually stop your ESX Server

1 Log on to your ESX Server service console.

Refer to “Connecting to the Service Console” on page 38 for information on 

accessing the service console.

2 Execute the shutdown command. 

For example:

: shutdown -h now

ESX Server gracefully shuts down. When it is finished, a message indicates that it 

is safe to power off your system.

3 Press the power button until the machine powers off. 
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VirtualCenter Server
VirtualCenter manages multiple hosts that can contain multiple virtual machines. To 

perform any activities with the VirtualCenter, you must use the Virtual Infrastructure 

Client. 

The VirtualCenter Server starts when you start the Windows machine on which it is 

installed. It also restarts when this machine is rebooted.

The following sections discuss starting and stopping elements related to VirtualCenter:

 “Verifying That VirtualCenter Server Started” on page 33

 “Restarting the VirtualCenter Server” on page 34

 “Stopping the VirtualCenter Server” on page 34

Verifying That VirtualCenter Server Started
VirtualCenter is a service, so proceed to your Windows services list and verify that the 

service started.

To verify that the VirtualCenter Server is running

1 Go to the Services display for your version of Windows.

For example, select Control Panel > Administrative Tools > Services. Click 

VMware Infrastructure Server. 

The Status column indicates whether the service started.

2 Right‐click the VMware Infrastructure Server and choose Properties. In the 

VMware VirtualCenter Services Properties dialog box, click the General tab and 

view the service status. 

NOTE When VirtualCenter is installed, all users in the local machine’s Administrators group 

are assigned the Administrator role with full privileges in the VirtualCenter 

environment. A VirtualCenter Administrator must set permissions for all other 

VirtualCenter users. Refer to “Assigning Access Permissions” on page 263 for 

additional information. 
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Restarting the VirtualCenter Server
The VirtualCenter Server service starts when the machine on which it is installed is 

booted. If you have manually stopped the VirtualCenter Server service or must start it 

for any reason, perform the steps below.

To restart the VirtualCenter Server through Windows Services

1 Go to the Services display for your version of Windows.

For example, select Control Panel > Administrative Tools > Services. Click 

VMware Infrastructure Server. 

2 Right‐click VMware Infrastructure Server, choose Start, and wait for startup to 

complete.

3 Close the Properties dialog box. 

Stopping the VirtualCenter Server
The VirtualCenter Server is a Windows service. You can use the Windows interface to 

select the service and stop it.

You should not have to stop the VirtualCenter Server. It is best for the VirtualCenter 

Server to have continuous operation. Continuous operation ensures that all monitoring 

and task activities are performed as expected.

To stop the VirtualCenter Server

1 Go to the Services display for your version of Windows.

For example, select Start > Control Panel > Administrative Tools > Services. Click 

VMware VirtualCenter Service.

2 Right‐click the VMware VirtualCenter Server, choose Stop, and wait for it to stop.

3 Close the Properties dialog box. 

VI Client
The Virtual Infrastructure Client is used to log on to either a VirtualCenter Server or an 

ESX Server. Each server supports multiple VI Client logons. The VI Client can be 

installed on any machine that has network access to the VirtualCenter Server or an ESX 

server. 

By default, administrators are allowed to log on to a VirtualCenter Server. 

Administrators here are defined to be either:
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 Members of the local Administrators group if the VirtualCenter Server is not a 

domain controller.

 Members of the domain Administrators group if the VirtualCenter Server is a 

domain controller.

Starting the VI Client and Logging On
The VI Client is the interface to both the ESX Server and the VirtualCenter Server. When 

you start the VI Client, it has a single opening page. When you log on, the VI Client 

displays only the features and functions that are appropriate to the type of server you 

logged on to. 

To start a VI Client session

1 Log on to your Windows system.

2 The first time you start the VI Client, log on as the administrator.

a If the managed host is not a domain controller, log on as either <local host 
name>\<user> or <user>, where <user> is a member of the local 

Administrators group. 

b If the managed host is a domain controller, you must log on as 

<domain>\<user>, where <domain> is the domain name for which the 

managed host is a controller and <user> is a member of that domain’s 

Domain Administrators group. This practice of running on a domain 

controller is not recommended.

3 Launch the VI Client.

4 Double‐click a shortcut or choose the application through Start > Programs > 

VMware > VMware Virtual Infrastructure Client 2.

5 Log on to the desired server.

6 Enter or choose the server name, your user name, and your password for that 

server. Click Log In to continue. 

If this is the first time you have logged on to the VirtualCenter Server, an empty 

Inventory screen appears. Add a datacenter and host to begin monitoring and 

managing your virtual machines through the Virtual Infrastructure Client. Refer to 

“Managing the VI Client Inventory” on page 91 for additional information.

NOTE Only previously typed servers appear in the Server pull‐down list. 
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Stopping the VI Client and Logging Off
When you no longer must view or alter the activities that VirtualCenter is performing, 

log off of the VI Client. 

To stop a VI Client session

1 Click the close box (X) in the corner of the VI Client window, or choose File > Exit.

The VI Client shuts down. The VI Client is logged off the server. The server 

continues to run all its normal activities in the background. Any scheduled tasks 

are saved and performed by the VirtualCenter Server.

VI Web Access
VI Web Access is the Web interface through which you can manage your virtual 

machines. VI Web Access is installed when you install ESX Server. As with the VI 

Client, VI Web Access can either be used to connect directly to an ESX Server or to 

VirtualCenter. The functionality of VI Web Access is a subset of VI Client functionality.

The VI Web Access console provides a remote mouse‐keyboard‐screen (MKS) for the 

virtual machines. You can interact with a guest operating system running in a virtual 

machine and connect remotely to the virtual machine’s mouse, keyboard, and screen.

For information on how to use VI Web Access to configure virtual machines for ESX 

Server and VirtualCenter, see the Virtual Infrastructure Web Access Administrator’s Guide. 

Logging In and Out of VI Web Access
VI Web Access uses a Web interface and an internet connection to access your ESX 

Server or VirtualCenter Server. 

To log in to VI Web Access

1 Launch your Web browser.

2 Enter the URL of your ESX Server or your VirtualCenter Server installation:

https://<host or server name>/ui

NOTE Closing a VI Client does not stop the server. 
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The VI Web Access login page appears. 

The login page contains fields for your user name and password. This user name 

and password are the same credentials you would use if you connected using the 

VI Client. Also, the same permissions are used to determine if a user can view and 

manipulate objects. VI Web Access does not have its own concept of users or 

permissions.

3 Type your user name and password, and click Log In. 

The VI Web Access home page appears. 

After your user name and password are authorized by VI Web Access, the VI Web 

Access home page appears. The VI Web Access home page contains:

 Details about virtual machines on the server to which you are connected.

 The option to access the details page for a virtual machine where you find 

information about virtual devices, configuration options, and a summary of 

recent events.

To log out of VI Web Access

Click the Log Out link found at the corner of every page. You are prompted to confirm 

that you want to log out.

VMware Service Console
In previous versions of ESX Server, the service console was one of the interfaces to ESX 

Server hosts. Starting with ESX Server 3, many of the commands are deprecated. 

Service console is typically used only in conjunction with a VMware technical support 

representative. 

The VMware Infrastructure SDK is used for scripted manipulation of your VMware 

Infrastructure instead. The Virtual Infrastructure Client is the primary interface to all 

NOTE If you are using any remote client devices through VI Web Access, they are 

disconnected when you log out.
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non‐scripted activities, including configuring, monitoring, and managing your virtual 

machines and resources.

Using DHCP for the Service Console
The recommended setup is to use static IP addresses for the service console. You can set 

up the service console to use DHCP, if your DNS server is capable of mapping the 

service console’s host name to the dynamically generated IP address.

If your DNS server cannot map the host’s name to its DHCP‐generated IP address, you 

must determine the service consoleʹs numeric IP address yourself. Another caution 

against using DHCP is that the numeric IP address might change as DHCP leases run 

out or when the system is rebooted. For this reason, VMware does not recommend 

using DHCP for the service console unless your DNS server can handle the host name 

translation. 

Connecting to the Service Console
Whether you use the service console locally or through a remote connection, you must 

log on using a valid user name and password.

If you have direct access to the computer where ESX Server is running, you can log on 

to the physical console on that computer. 

To log on to the ESX Server service console

Press Alt‐F2 to get to the log on screen.

Depending on the security settings for your ESX Server computer, you might be able to 

connect remotely to the service console using ssh or Telnet. For more information on the 

security settings, refer to the Server Configuration Guide.

Using Commands on the Service Console
The service console runs a modified version of Linux, and many of the commands 

available on Linux or UNIX are also available on the service console. Detailed usage 

notes for most service console commands are available as manual or man files. 

To view the man page for a particular command

At the service console command line, type the man command followed by the name of 

the command for which you want to refer to information, for example:

CAUTION Do not use dynamic (DHCP) addressing when sharing the network adapter 

assigned to the service console with virtual machines. ESX Server requires a 

static IP address for the service console when sharing a network adapter. 
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: man <command>

For additional information on commands, refer to the following resources:

 For more detailed information on ESX Server related commands, see the Server 

Configuration Guide. 

 For more information on Linux commands, consult a Linux reference book. 
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This chapter describes the specific layout and navigation of the VI Client. It also 

contains information for configuring admin options, VirtualCenter Server settings, and 

managing host configuration options. 

This chapter contains the following sections:

 “VI Client Overview” on page 41

 “Sorting and Filtering Lists” on page 54

 “Using Custom Attributes” on page 55

 “Selecting and Viewing Objects” on page 57

VI Client Overview
The Virtual Infrastructure Client adapts to the server it is connected to. When the VI 

Client is connected to a VirtualCenter Server, the VI Client displays all the options 

available to the VMware Virtual Infrastructure environment, based on the licensing you 

have configured and the permissions of the user. When the VI Client is connected to an 

ESX Server, the VI Client displays only the options appropriate to single host 

management.

The default Virtual Infrastructure Client layout is a single window with a menu bar, a 

navigation bar, a toolbar, a status bar, a panel section, and pop‐up menus.

Using the VI Client 4
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Figure 4-1.  Virtual Infrastructure Client Layout 

The VI Client areas are covered in the following sections:

 “Menu Bar” on page 43

 “Pop‐Up Menus” on page 45

 “Console Menu” on page 45

 “Navigation Bar” on page 46

 “Inventory View Tabs” on page 49

 “Toolbar” on page 52

 “Status Bar, Recent Tasks, and Triggered Alarms” on page 53

 “Panel Sections” on page 53

Menus
Navigation 
barToolbar Inventory tabs

Status  Information panelStatus barInventory panel

Pop-up menuConsole button
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Menu Bar
The menu bar provides access to all commands and operates in a manner consistent 

with other Windows applications. The tables below list all the menu items available 

from these five menus. The menu items available vary depending upon whether the VI 

Client is connected to a VirtualCenter Server or an ESX Server. The menu bar options 

are:

 File Menu – Similar to the File menu in most applications with two exceptions:

 A print menu item is not available on the File menu. To print, use the Print 

Screen mechanism in Windows to take a copy of the VI Client window or 

export the VirtualCenter data to another format and print from another 

application. 

 A save menu item is not available. The VI Client is similar to a browser. Most 

user manipulations are persistent in the display of the VirtualCenter data.

In Table 4‐1, an asterisk (*) indicates items that are available only when connected 

to VirtualCenter Server.

 Edit Menu – Displays menu items relevant to the selected object.

 View Menu – Controls which panels are visible. This provides a menu item for 

selecting one of the navigation buttons.

In Table 4‐3, an asterisk (*) indicates items that are available only when connected 

to VirtualCenter Server.

Table 4-1.  File Menu Items

File >  New > Virtual Machine | Add Host* | Cluster* | Resource Pool | Folder* 
| Datacenter* | Alarm* | Scheduled Task* | Add Permission

File >  Export >  Export Events* | Export List | Licenses | Export Maps*

File >  Report >  Host Summary | Performance

File >  Exit 

Table 4-2.  Edit Menu Items

Edit > Rename | Remove | Customization Specifications | VI Client Settings

Table 4-3.  View Menu Items

View > Toolbar | Status Bar | Inventory | Scheduled Tasks* | Events | Administration 
| Maps* | Filtering
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When connected to the VirtualCenter Server, the View > Inventory menu parses the 

inventory object views into groups.

 Inventory Menu – Displays menu items relevant to the selected object in the 

inventory panel.

In Table 4‐5, an asterisk (*) indicates items that are available only when connected 

to VirtualCenter Server.

Table 4-4.  View Menu > Inventory Items

View >  Inventory > Hosts & Clusters | Virtual Machines & Templates | Networks | 
Datastores

Table 4-5.  Inventory Menu Items

Inventory >  Datacenter > New Folder | New Cluster | Add Host | Remove | 
Rename

Inventory >  Virtual Machine >  Power On | Power Off | Suspend | Reset | Shut 
Down Guest | Standby Guest | Restart Guest | 
Snapshot | Migrate | Clone | Clone to Template | 
Convert to Template | Open Console | Sent 
Ctrl+Alt+Del | Answer Question | Report 
Performance | Install VMware Tools | Edit Settings 
| Rename | Remove from Inventory | Delete from 
Disk

Inventory >  Templates* >  Power On | Power Off | Suspend | Reset | Shut 
Down Guest | Restart Guest | Snapshot | Migrate 
| Clone | Clone to Template | Convert to Template 
| Open Console | Sent Ctrl+Alt+Del | Answer 
Question | Report Performance | Install VMware 
Tools | Edit Settings | Rename | Remove from 
Inventory | Delete from Disk

Inventory >  Host >  New Virtual Machine | Connect* | Disconnect* | 
Enter Maintenance Mode | Shut Down | Reboot | 
Report Summary | Report Performance | 
Advanced Settings | Remove* | Relocate VM Files

Inventory >  Cluster* >  Add Host | New Virtual Machine | New Resource 
Pool | Edit Settings | Remove | Rename

Inventory >  Resource Pool >  New Virtual Machine | New Resource Pool | 
Report Performance* | Remove | Rename

Inventory >  Datastore* >  Browse Datastore | Rename | Remove | Refresh

Inventory >  Network* >  Remove

Inventory >  Permission >  Add | Delete | Properties
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 Administration Menu – Displays configuration options that apply across the 

Virtual Infrastructure environment. 

In Table 4‐6, an asterisk (*) indicates items that are available only when connected 

to VirtualCenter Server.

 Help Menu – Displays the online help options, links to the VMware Web site, and 

product version information.

Pop-Up Menus
Pop‐up menus provide direct access to many of the menu items. Pop‐up menus are 

available from most objects in both the inventory panel and the information panel.

To view a pop-up menu

Right‐click the selected object or press Shift+F10.

Console Menu
The console of a powered‐on virtual machine is available through a connected server. 

To view the virtual machine console

Click the Inventory Navigation button, click a powered‐on virtual machine in the 

Inventory panel, and click the Console tab in the Information panel.

To pop out the virtual machine console

Click the pop‐out icon in the navigation bar. 

A copy of the Console window separates from the VI Client. Additional menus appear.

Inventory >  Alarm* >  Properties | Remove

Inventory >  Scheduled Task* >  Run | Remove | Properties

Table 4-6.  Administration Menu Items

Administration >  Custom Attributes* | VMware VirtualCenter Settings* | Role | 
Session* | Edit Message of the Day* | Collect Diagnostic 
Information* | Legacy Templates*

Table 4-5.  Inventory Menu Items (Continued)
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Additional menu items are available from the pop‐out Console window.

All connections to the virtual machine see the same display information. The message 

line indicates if others are viewing the virtual machine.

The pop‐out virtual machine Console has the following menu items. The embedded 

Console has similar menu items but does not include all of the external Console menu 

items.

Navigation Bar
The navigation bar provides shortcut buttons that load the matching toolbar and panel 

into the VI Client window. The navigation bar combines and displays associated tasks 

and information. When a button has been selected, it remains selected to indicate the 

current view. The buttons represent the VI Client functional areas. Depending upon 

whether the VI Client is connected to a VirtualCenter Server or an ESX Server, the listed 

buttons vary.

Each navigation bar button has a primary information panel and associated tabs. The 

Inventory button has an inventory panel from which you can select objects. Each 

Table 4-7.  Virtual Machine Pop-Out Console Menu Items

File >  Exit

View >  Autofit | Fit | Fit Guest to Window

VM >  Power On | Power Off | Suspend | Reset | Shut Down Guest | Restart Guest | 
Snapshot | Migrate | Clone | Clone to Template | Convert to Template | Open 
Console | Sent Ctrl+Alt+Del | Answer Question | Report Performance | Install 
VMware Tools | Edit Settings | Rename | Remove from Inventory | Delete from 
Disk

The message line indicates 
the number of active 
connections to this virtual 
machine. 

Additional Console menu 
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selected object has its own set of associated information panel tabs. This information is 

in one of the following two sets of panels:

Navigation bar provides shortcuts to generalized areas of related activities. The options 

are Inventory and Admin, when the VI Client is connected to either an ESX Server or a 

VirtualCenter Server. When the VI Client is connected to a VirtualCenter Server 

additional options are available: Scheduled Tasks, Events, and Maps and Inventory 

button pull‐down menu items (Hosts & Clusters, Virtual Machines & Templates, 

Networks, and Datastores).

Figure 4-2.  Navigation bar shortcuts

To view the Inventory button options

Click the arrow on the Inventory navigation bar button to refer to the inventory group 

options. Choose View > Inventory > Hosts and Clusters (or Virtual Machines and 

Templates, Networks, or Datastores. 

Refer to “Managing the VI Client Inventory” on page 91 for information on the 

differences between the Inventory button views. 

 Inventory button – A view of all the monitored objects in VirtualCenter. 

Monitored objects include datacenters, resource pools, clusters, networks, 

datastores, templates, hosts, and virtual machines.

The Inventory button displays an inventory panel and an information panel. The 

information panel contains several tabs. The set of tabs that is displayed varies 

depending upon the inventory object selected in the inventory panel. 

There are four different Inventory button views: 

 Hosts and Clusters – displays the inventory hierarchy of all inventory objects 

except templates, networks, and datastores. 

 Virtual Machines and Templates – displays the list of virtual machines and 

templates.

 Networks – displays the list of networks.

 Datastores – displays the list of datastores.



Basic System Administration

48 VMware, Inc. 

All four of the Inventory options are divided into two subpanels, the inventory 

panel and the information panel. This Inventory option displays all the objects 

contained within VirtualCenter, such as folders, datacenters, hosts, clusters, 

resource pools and virtual machines. When connected to an ESX Server the 

inventory option displays all the objects contained within the ESX Server, such as 

host, resource pools, and virtual machines. Through selecting objects in either of 

the two subpanels, you perform and specify actions.

There are four different inventory views. Each relates to some of the eight different 

inventory objects: hosts, clusters, folders, datacenters, virtual machines and 

templates, resource pools, networks, and datastores. 

All four views have the (single) root node, allow any folders below the root node 

(that can only contain other folders and datacenters) and datacenters. Below 

datacenters the hierarchy is split up into networks, datastores, virtual machine and 

templates, and hosts, clusters, and resource pools. 

 Scheduled Tasks button – A list of activities and a means to schedule those 

activities. This is available through VirtualCenter Server only.

The Scheduled Tasks and Events buttons, available only when connected to a 

VirtualCenter Server, display a single information panel. 

 Events button – A list of all the events that occur in the VirtualCenter environment. 

Use the Navigation option to display all the events. Use an object‐specific panel to 

display only the events relative to that object.

 Admin button – A list of environment‐level configuration options. The Admin 

option provides configuration access to Roles, Sessions, Licenses, Diagnostics, and 

System Logs. When connected to an ESX Server only, the Roles option appears. 

The Admin button displays a set of tabbed information panels. Selected 

configuration options are available through these tabs. 

 Maps button – A visual representation of the status and structure of the Virtual 

Infrastructure environment. This includes hosts, networks, virtual machines, and 

datastores. This is available through VirtualCenter Server only.

The Maps button, available only when connected to a VirtualCenter Server, 

displays an inventory panel and a topology panel. 

To change the look of the navigation bar

Right‐click the navigation bar and choose the appropriate option.
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Inventory View Tabs
You can access the general display of data and activity through the information panel 

of the VI Client window. The information panel is the visual center of your monitoring 

activities. Through the information panel, you can view status, resource usage, and 

performance information about your hosts, virtual machines, and datacenters. In the 

information panel, you can also view scheduled tasks, available templates, and a list of 

events. 

When the VI Client is connected to a VirtualCenter Server a Maps option is also 

available. Refer to “Monitoring Your Vmware Infrastructure Environment” on 

page 269 for information on the Maps feature. 

When an object is removed from the inventory, its log and event history remains until 

purged through the aging processes. Data is kept for a specified window of time. As the 

time window shifts, older data is purged. 

 Admin tabs – A subset of the Admin button. The Admin tabs are a set of panels 

that display configuration‐oriented information pertaining to the serve that the VI 

Client is connected to. The tab options are Roles and System Logs. When the VI 

Client is connected to a VirtualCenter Server, a Sessions and Licenses tab is also 

available. 

 Inventory tabs – A subset of the Inventory button. The Inventory tabs are a set of 

panels that display task‐oriented information pertaining to the selected inventory 

object. Each inventory object has its own set of tabs. The tab options are: Summary, 

Datacenters, Virtual Machines, Hosts, Migrations, Resource Allocation, 

Performance, Configuration, Tasks &Events, Alarms, Console, Permissions, and 

Maps. 

When you click the Inventory button in the navigation bar, an information panel 

appears on the right side of the screen. When you select an object (host, virtual 

machine, folder, datacenter, cluster, resource pool) from the inventory panel, the 

information panel displays tabs corresponding to the selected object. This data 

remains until you click another Inventory button. 

NOTE You can use either the navigation bar or the information panel tabs to view events 

information. 
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Table 4‐8 lists the available panels and their source mapping. 

Table 4-8.  Inventory View Tabs

Panel Name

ESX Server or 
VirtualCenter 
Server

Button, Tab, or 
Toggle Description

Admin both navigation bar 
button

Lists selected configuration options and 
information. 

Alarms  VirtualCenter inventory panel 
tab

Lists the configured alarms for the 
selected object. 

Alarms  VirtualCenter toggle button Lists the triggered alarms for the selected 
object. 

Configuration both inventory panel 
tab

Provides access to configuring the 
selected host. 

Console  both inventory panel 
tab

Displays a remote console to interact 
directly with the virtual machine. 
Through the remote console you can take 
selected actions upon the virtual machine. 

Datacenters  VirtualCenter inventory panel 
tab

Lists the datacenters organized under the 
selected folder. 

Datastores Virtual Center navigation bar 
button: Datastores

Provides access for managing datastores. 

Events  ESX Server inventory panel 
tab

Lists the event messages that report on the 
status of the selected object. 

Hosts  both inventory panel 
tab

Lists the hosts assigned to the selected 
inventory object. 

Inventory both navigation bar 
button: Hosts & 
Clusters

Provides access for managing all the 
inventory objects. 

Licenses VirtualCenter admin panel tab Lists the licenses configured in the license 
server. 

Maps VirtualCenter navigation bar 
button

Displays relationships between the 
selected inventory objects. 

Migrations VirtualCenter inventory panel 
tab

Lists the migrations suggested or 
completed for the selected cluster. 

Networks Virtual Center navigation bar 
button: Networks

Provides access for managing networks. 
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Performance  both inventory panel 
tab

Displays the performance charts for the 
selected host or virtual machine resources. 
The charts for datacenters and hosts 
display combined charts that show the 
usage of each resource. 

Permissions  both inventory panel 
tab

Lists the users and groups that have 
permissions on the selected object and at 
what level the permission was assigned. 

Resource 
Allocation

VirtualCenter inventory panel 
tab

Lists the distribution of the selected host’s 
resources: CPU, memory. 

Roles both admin panel tab Provides access for configuring user roles. 

Scheduled Tasks VirtualCenter navigation bar 
button

Provides access for creating and 
managing scheduled tasks. 

Sessions VirtualCenter admin panel tab Lists the VI Client sessions connected to 
the VirtualCenter Server. 

Summary  both inventory panel 
tab

Displays a collection of data for the 
selected object. 

System Logs both admin panel tab Lists selected log files for the servers. 

Tasks  VirtualCenter toggle button Lists the recent tasks for the selected 
object. 

Tasks & Events  VirtualCenter inventory panel 
tab

Lists the tasks completed and the event 
messages that report on the status of the 
selected object. 

Templates Virtual Center navigation bar 
button: Virtual 
Machines & 
Templates

Provides access for managing templates. 

Virtual 
Machines 

both inventory panel 
tab

Lists the virtual machines assigned to the 
selected datacenter or host and group. To 
access, click the Virtual Machines tab and 
the virtual machines in the group are 
displayed. 

Table 4-8.  Inventory View Tabs (Continued)

Panel Name

ESX Server or 
VirtualCenter 
Server

Button, Tab, or 
Toggle Description
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Toolbar
The toolbar provides buttons for the most commonly used actions.

To view or hide a toolbar

Choose View > Toolbars.

Different toolbar buttons are displayed depending on the navigation task and 

inventory object selected. Some toolbar options might be dimmed depending on the 

object selected.

To change the look of the toolbar

Right‐click the toolbar and choose the appropriate option.
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Status Bar, Recent Tasks, and Triggered Alarms
The status bar appears at the bottom of the window. It contains icons to view triggered 

alarms or recent tasks. The Tasks button displays any currently running or recently 

completed active tasks. Included is a progress bar indicating the percentage complete 

of each task. The recent tasks and the triggered alarm panels display across the bottom 

of the VI Client window.

To hide or view the status bar

Choose View > Status bar.

To hide or view recent tasks or triggered alarms

Click the Tasks or Alarms icons in the status bar.

Panel Sections
In the body of the VI Client page is a panel section. In most views, there is a right and 

a left panel: the inventory panel and the information panel. These panels can be resized.

 Inventory panel — Displays a hierarchical list of Virtual Infrastructure objects 

when the Inventory or Maps button is selected from the navigation bar. 

 Information panels — Display lists and charts. Depending on the navigation 

button or Inventory button item selected, the information panel is divided into 

tabbed elements.

To select an object 

Single‐click the appropriate object in either the inventory panel or on the information 

panel.
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To close or open a panel 

Click the arrow in the panel menu bar. 

When the panel is hidden, the panel menu bar is a strip along the side of the VI Client 

window.

To resize a panel 

Click a resizing panel side and drag it to an appropriate size.

Your choices for the panels are persistent across VI Client sessions. If you run multiple 

VI Client sessions using different user names, the settings from the last session to quit 

determine the values for the next VI Client session.

Sorting and Filtering Lists
Sort any list in the VI Client by clicking the column label heading. A triangle in the 

column head shows the sort order as ascending or descending.

You can also filter a list, sorting and including only selected items. A filter is sorted by 

a keyword. Choose the columns you want to include in the search for the keyword.

To sort a list 

Click a column heading to sort the list by entries in that column. The current selection 

does not change. 

To change between ascending and descending order 

Click the triangle in the column heading.

To choose items in a list 

Click an individual item. Press Shift‐click or Ctrl‐click to choose multiple items. All 

lists can be sorted. 

To view or remove columns in a list 

Right‐click the column header and choose the column name from the list.

To filter the list view

1 Click the arrow to view a list of attributes from which to choose. Type text directly 

into the filtering field to specify search criteria. 

The Filter field does not support boolean expressions or special characters and is 

not case sensitive. 



VMware, Inc. 55

Chapter 4 Using the VI Client

 

2 Click OK to display only those virtual machines that match the criteria. Click Clear 

to change the filter.

The list is updated based on whether filtering is on or off. For example, if you are in the 

Virtual Machines tab, you have filtered the list, and the filtered text is “powered on”, 

you only refer to a list of virtual machines whose state is set to powered on. If the state 

of any of these virtual machines changes to something else, they are removed from the 

list. New virtual machines that are added are also being filtered. Filtering is persistent 

for the user session.

To remove a filter 

Click Clear, or delete the entry in of the filtering field and click OK. 

The VI Client displays the full list of available items.

To choose columns to search for the filtering keyword 

Right‐click in the contains field, and select or deselect the appropriate column names.

Filtering is inclusive, not exclusive. If the keyword is found in any of the selected 

columns, the line item is included in the list. 

To export a list

1 Select the list to export.

2 Choose File > Export > Export List.

3 Type a file name, select a file type in the dialog box, and click Save.

A file is stored in the specified file name, file type, and location.

Using Custom Attributes
Attributes are the resources that are monitored and managed for all the managed hosts 

and virtual machines in your Virtual Infrastructure environment. Attributes’ status and 

states appear on the various inventory panels. 

Custom attributes can be used to associate user‐specific meta‐information with virtual 

machines and managed hosts. After you create the attributes, set the value for the 

attribute on each virtual machine or managed host, as appropriate. This value is stored 

with VirtualCenter and not with the virtual machine or managed host. Then use the 

new attribute to filter information about your virtual machines and managed hosts. If 

NOTE There is a one‐second interval between keystrokes. If you type in the text and wait for 

one second, the search starts automatically. You don’t have to click OK or Enter.
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you no longer need the custom attribute, remove it. A custom attribute is always a 

string. 

For example, suppose you have a set of products and you want to sort them by sales 

representative. Create a custom attribute for sales person name, Name. Add the custom 

attribute, Name, column to one of the list views. Add the appropriate name to each 

product entry. Click the column title Name to sort alphabetically.

The custom attributes feature is available only when connected to a VirtualCenter 

Server.

To add a custom attribute

1 Choose Administration > Custom Attributes.

This option is not available when connected only to an ESX Server.

2 Add a custom attribute and click Add.

The attribute is added to the list of virtual machine characteristics. 

3 To change the attribute name, click in the Name field and type the name you want 

to assign to the attribute.

4 Enter the values for the custom attribute.

a Select the object (one level up the hierarchy) that contains the objects to which 

you want to apply the attribute. 
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For example, if you want to enter attribute values for managed hosts, select the 

datacenter and the Hosts tab for a list of hosts.

b For each managed host or virtual machine, click the new attribute’s column.

In the information panel, the new attribute is added to the header.

c Type the attribute value that is appropriate for each managed host or virtual 

machine.

Selecting and Viewing Objects
This section describes common Windows procedures that affect the Virtual 

Infrastructure Client. Navigation topics are discussed in the following sections:

 “Selecting Objects” on page 57

 “Monitoring Objects” on page 58

 “Performing Actions on Objects” on page 59

Selecting Objects
VirtualCenter objects are datacenters, networks, datastores, resource pools, clusters, 

hosts, and virtual machines. Selecting an object does the following:

 Allows you to view the status of the object.

 Enables the menus so you can choose actions to take on the object.

To select an object 

1 Click the appropriate navigation bar option such as Inventory, Scheduled Tasks, 

Events, Admin, or Maps.

2 If you select Inventory, browse through the hierarchy in the inventory panel until 

you see the icon for an object. Click it. 

When an object is selected, the object label in the inventory panel backfills and the 

information panel updates its display to reflect the data for the selected object. 

To view an object menu 

Select the appropriate object and choose the appropriate action from the menu bar. 

Alternatively, right‐click the object.

A pop‐up menu with the object’s available actions appears.

For each type of object, such as datacenter, host, or virtual machine, a corresponding set 

of tabs appears in the information panel. For example: 
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 If you select a managed host in the inventory panel while connected to 

VirtualCenter, the information panel displays Summary, Virtual Machines, 

Resource Allocation, Performance, Configuration, Tasks & Events, Alarms, 

Permissions, and Maps tabs.

 If you select the inventory panel while connected to an ESX Server, the information 

panel displays Summary, Virtual Machines, Resource Allocation, Performance, 

Configuration, Users & Groups, System Logs, Events and Permissions tabs. 

 If you select a datacenter, the information panel displays Virtual Machines, Hosts, 

Tasks & Events, Alarms, Permissions, and Maps tabs.

The inventory panel and information panel share a single selection list. Selecting an 

object in one panel deselects any other object in the other panel.

Menu actions, from either the menu bar or a pop‐up menu, apply to the currently 

selected object. If no object is selected, no menu actions are available. A pop‐up menu 

can appear only for a selected object. Refer to “Pop‐Up Menus” on page 45 for 

additional information on the pop‐up menu options. 

To change the name of an object 

Select an item and press F2 or click the text of the selected item. Type the new name.

Monitoring Objects
VI Client monitors VirtualCenter or ESX Server activities. For a host to be monitored by 

VirtualCenter, it must be registered with the VirtualCenter Server. Refer to “Adding a 

Host” on page 101 for information on adding objects to your VirtualCenter Server. If an 

ESX Server host is not registered with a VirtualCenter Server, you can connect to the 

ESX Server directly, also using the VI Client.

To check the status of an object

1 Start the VI Client. 

2 Click the appropriate button in the navigation bar. 

 If you click the Inventory or Maps button, drill through the inventory panel 

lists to view individual objects such as hosts, datacenters, and virtual 

machines.

 If you click the Scheduled Tasks, Events, or Admin button, the information 

panel displays the scheduled tasks, events, or administrative wizard 

appropriate to the choice. 

3 Click the object to view it.
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When you select an object, the object label in the inventory panel is shown in blue 

and the information panel updates its display to reflect the object’s data. 

4 Click the appropriate tab in the information panel.

The data corresponding to the object and tab selected is shown. Click through the 

tabs to view the information about the object, as needed.

Performing Actions on Objects
This section describes only the basic process for performing tasks in the Virtual 

Infrastructure Client. This section does not describe specific settings and conditions. 

Refer to the chapter or book specific to the task you want to perform for additional 

information.

To view an object, you must have the necessary permission assigned for that object. The 

type of action you can take on an object depends upon the specific privileges assigned 

to your username and group. 

There are three methods for taking actions upon objects in VirtualCenter:

 Selecting the action from the menu bar at the top of the VirtualCenter window. 

Refer to “Menu Bar” on page 43.

 Selecting the action from the object’s pop‐up menu or button. The procedure listed 

below describes how to choose the action from the object menu or button.

 Scheduling the action through the Scheduled Tasks panel. Refer to “Managing 

Scheduled Tasks” on page 293 to information on scheduling tasks.

To perform an action on a Virtual Infrastructure object

1 Start the Virtual Infrastructure Client.

2 Connect to the appropriate server.

3 To select an object you want to view or upon which you want to perform an action, 

select the appropriate inventory view, browse through the hierarchy in the 

inventory panel until you see its icon, and click it. 

An object can be selected in the inventory panel or the information panel.

If the object is not in the view:

 Verify you are logged on to the correct server.

 Add the host to VirtualCenter control, if needed. Refer to “Managing Hosts in 

VirtualCenter” on page 99 for information.

4 Once an object is selected:
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 Choose a menu item from the main menu.

 Right‐click the object and choose from the pop‐up menu.

5 Follow the prompts.

Depending on the action you selected, either the view in the information panel changes 

or a wizard prompts you for information to complete the transaction. 
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This chapter includes basic system configuration information, such as how to access 

and configure log files, configure firewalls, and set up SNMP. Some topics have 

extensive information discussed in separate chapters or books. Where this occurs, 

references are provided. 

Some of the topics in this chapter are typically one‐time configuration tasks, though 

certainly the settings can be altered when needed. 

This chapter contains the following topics:

 “Host Configuration for ESX Server and VirtualCenter” on page 61

 “VirtualCenter Configuration” on page 66

 “Configuring VirtualCenter Communication” on page 68

 “Virtual Machine Configuration” on page 71

 “Working with Active Sessions” on page 73

 “SNMP Configuration” on page 74

 “System Log Files” on page 81

Host Configuration for ESX Server and VirtualCenter
ESX Server hosts are configured and managed through the Virtual Infrastructure 

Client. Some host‐related configuration is specific to VirtualCenter. Other host 

configuration applies to standalone hosts as well as VirtualCenter registered host 

scenarios.

System Configuration 5
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The Server Configuration Guide describes the tasks you must complete to configure ESX 

Server host networking, storage, and security. In addition, it provides overviews, 

recommendations, and conceptual discussions to help you understand these tasks. It 

explains how to deploy an ESX Server host to meet your needs. Before using the 

information in the Server Configuration Guide, read the Introduction to Virtual 

Infrastructure for an overview of system architecture and the physical and virtual 

devices that make up a Virtual Infrastructure system.

This section summarizes the host configuration options and the contents of the Server 

Configuration Guide so that you can find the information you need. 

Configuring a Host
Select a host and the Configuration tab for the host. The configuration tab displays all 

of the configuration options available. 

Hardware Tab

The hardware tab displays the following configuration options:

 Processors – Displays the host’s processor information such as type, speed, 

manufacturer. The properties dialog box allows you to enable or disable 

Hyperthreading.

 Memory – Displays the host’s memory configuration, including total memory 

available, amounts for the host’s system, amounts for the virtual machines, and 

amounts for the ESX Server Service Console. The properties dialog box allows you 

to set the amount dedicated to the ESX Server Service Console.

 Storage (SCSI, SAN, NFS) – Displays the storage volumes configured for the host 

and details about each storage device. This includes volume labels, file system 

type, block size, extents, and capacity. The Refresh, Remove, Add Storage, and 

Properties dialog boxes allow you to change volume properties, add extents, 

manage paths, add disk or LUN datastores, and add network file system (NFS) 

datastores. 

 Networking – Displays current networks attached to the host. The Refresh, Add 

Networking, Remove, and Properties dialog boxes allow you to configure ports 

and network adapters, and define connection types to the host’s virtual machine, 

VMkernel, and service console.

 Storage Adapters – Displays storage adapter configuration, such as device type, 

SAN identification, LUN identification, path, and capacity. The Rescan, Hide 

LUNs, and Properties dialog boxes allow you to scan for new storage devices or 

VMFS volumes, hide the LUN information for each selected storage adapter, and 

view VMotion configuration status.
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 Network Adapters – Displays network adapter information, including device 

type, speed, vSwitch, and network identification.

Software Tab

The software tab displays the following configuration options:

 Licensed Feature – Displays the current status of licensing in your Virtual 

Infrastructure environment. This includes license sources, license server, or license 

file; license type; and add‐on licensing, such as VMotion or HA. The Edit dialog 

boxes allow you to specify license source, license types, and licensing for 

additional features.

 DNS and Routing – Displays DNS and routing information. This includes host 

name and domain, DNS servers connected to the host, search domains, and default 

gateways. The Properties dialog box allows you to specify these identification 

items. 

 Virtual Machine Startup/Shutdown – Displays a list of virtual machines on the 

host and their startup or shutdown status. The Properties dialog box allows you to 

configure when to power on and power off each resident virtual machine. Options 

include starting or stopping at selected times relative to the host powering off or 

powering on. 

 Security Profile – Displays the firewall information for incoming and outgoing 

connections. The Properties dialog box allows you to define remote access 

conditions. This includes Shell type, SNMP, and several associated clients, servers, 

and agent incoming and outgoing communication ports and protocols.

 System Resource Allocation – Displays the host’s resource allocation settings. This 

includes memory and CPU usage. The Edit dialog boxes allow you to configure 

amounts of CPU shares and memory shares are reserved for host use. The 

Simple/Advanced toggled dialog box allows you to configure the host’s resource 

pools CPU and memory reserved shares for selected host functions.

 Refer to the Resource Management Guide for complete information on configuring 

and using your virtual machine resources.

 Advanced Settings – Displays a list of settings that VMware recommends you use 

only when directed to by VMware technical support.

NOTE Refer to the Server Configuration Guide for configuration information on configuring 

networking, storage, and security.
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Viewing Network Configuration Information

The ESX Server networking chapters provide you with a conceptual understanding of 

physical and virtual network concepts, a description of the basic tasks you must 

complete to configure your ESX Server host’s network connections, and a discussion of 

advanced networking topics and tasks. The networking section contains the following 

chapters:

 Networking – Introduces you to network concepts and guides you through the 

most common tasks you must complete when setting up the network for the ESX 

Server host. 

 Advanced Networking – Covers advanced networking tasks such as setting up 

MAC addresses, editing virtual switches and ports, and DNS routing. In addition, 

it provides tips on making your network configuration more efficient.

 Networking Scenarios and Troubleshooting – Describes common networking 

configuration and troubleshooting scenarios.

Viewing Storage Configuration Information

The ESX Server storage chapters provide you with a basic understanding of storage, a 

description of the basic tasks you perform to configure and manage your ESX Server 

host’s storage, and a discussion of how to set up raw device mapping. The storage 

section contains the following chapters:

 Introduction to Storage – Introduces you to the types of storage you can configure 

for the ESX Server host. 

 Configuring Storage – Explains how to configure local SCSI storage, Fibre 

Channel storage, and iSCSI storage. It also addresses VMFS storage and 

network‐attached storage.

 Managing Storage – Explains how to manage existing datastores and the file 

systems that comprise datastores.

 Raw Device Mapping – Discusses raw device mapping, how to configure this type 

of storage, and how to manage raw device mappings by setting up multipathing, 

failover, and so forth.

Viewing Security Configuration Information

The ESX Server security chapters discuss safeguards VMware has built into ESX Server 

and measures you can take to protect your ESX Server host from security threats. These 

measures include using firewalls, leveraging the security features of virtual switches, 

and setting up user authentication and permissions. The security section contains the 

following chapters:
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 Security for ESX Server Systems – Introduces you to the ESX Server features that 

help you ensure a secure environment for your data and gives you an overview of 

system design as it relates to security.

 Securing an ESX Server Configuration – Explains how to configure firewall ports 

for ESX Server hosts and VMware VirtualCenter, how to use virtual switches and 

VLANs to ensure network isolation for virtual machines, and how to secure iSCSI 

storage.

 Authentication and User Management – Discusses how to set up users, groups, 

permissions, and roles to control access to ESX Server hosts and VirtualCenter. It 

also discusses encryption and delegate users.

 Service Console Security – Discusses the security features built into the service 

console and shows you how to configure these features.

 Security Deployments and Recommendations – Provides some sample 

deployments to give you an idea of the issues you must consider when setting up 

your own ESX Server deployment. This chapter also tells you about actions you 

can take to further secure virtual machines.

Viewing ESX Server Command Information

The Server Configuration Guide includes appendixes that provide specialized 

information you might find useful when configuring an ESX Server host:

 ESX Server Technical Support Commands – Covers the ESX Server configuration 

commands that can be issued through a command line shell such as SSH. While 

these commands are available for your use, you should not consider them an API 

upon which you can build scripts. These commands are subject to change and 

VMware does not support applications and scripts that rely on ESX Server 

configuration commands. This appendix provides you with VMware Virtual 

Infrastructure Client equivalents for these commands.

 Using vmkfstools – Covers the vmkfstools utility, which you can use to perform 

management and migration tasks for iSCSI disks.
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VirtualCenter Configuration
Sets of properties and settings dialog boxes make adjustments to the corresponding 

VirtualCenter environment. 

To view the VMware VirtualCenter Configuration

Select Administration > Server Settings. 

Changes to this setting apply to the current VirtualCenter Server only. If you log out 

and log on to another VirtualCenter Server, the settings are specific to that 

VirtualCenter Server.

The dialog box tabs display and allow you to configure:

 License Server – Specify the license server and whether a host license server is 

superseded when the host is added to the VirtualCenter inventory.

Refer to the Installation and Upgrade Guide.

 Statistics – Specify the collection intervals, statistics collection thread limit, and 

statistics collection level. Specifies the number of threads used for collecting 

performance statistics from managed hosts. 

Specifies the level of detail for performance statistics collection. Legal values are 

minimal, typical, and full. The default is full. 

Specifies how often, in seconds, VirtualCenter checks if any scheduled tasks are 

ready to be executed or alarms should be triggered. The default is 5 seconds.

Verifies that all users and groups known to VirtualCenter currently exist in 

Windows. For example, if user Smith is assigned permissions and in the domain 

the user’s name is subsequently changed to Smith2, VirtualCenter concludes that 

Smith no longer exists and removes permissions for that user.

Refer to “Setting the Statistics Collection Intervals” on page 274.

 Runtime Settings – View the unique runtime settings for the VirtualCenter 

installation. This includes the VirtualCenter unique ID number and the 

VirtualCenter TCP/IP port number. 

Generates unique MAC addresses and UUIDs for virtual machines. In some cases, 

it is possible to have more than one VirtualCenter running in the same company. 

Each of these VirtualCenter Servers must have its own unique identification. By 

default, an ID value is generated randomly. However, this value is editable. The 

only requirement is that it be a unique number from 0 to 63.

Specifies the port through which a VirtualCenter client sends data to the 

VirtualCenter Server. 
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Refer to “Configuring VirtualCenter Communication” on page 68.

 Active Directory – Specify the active directory timeout, maximum number of users 

and groups to display in the Add Permissions dialog box, and the frequency for 

performing a synchronization and validation of VirtualCenter’s known users and 

groups.

Specifies the maximum number of users and groups the VirtualCenter stores from 

the selected domain. To specify no maximum limit, enter zero (0).

Specifies, in seconds, the maximum time VirtualCenter allows the search to run on 

the selected domain. Searching very large domains can take a very long time. This 

value must be greater than zero (0). 

Refer to Chapter 15, “Managing Users, Groups, Permissions, and Roles,” on 

page 247.

 Mail – Specify the SMTP server and mail account. 

Refer to “Managing Events” on page 303.

 SNMP – Specify the SNMP receiver URLs, ports, and community strings.

Refer to “SNMP Configuration” on page 74.

 Web Service – Specify the HTTP and HTTPS ports for the Web Service to use.

Refer to “Configuring VirtualCenter Communication” on page 68.

 Timeout Settings – Specify the VI Client connection timeout values for normal 

operations and long operations. Timeout normal specifies how long, in seconds, 

the VirtualCenter client waits for a response from the VirtualCenter Server before 

timing out. The default is 30 seconds. Timeout long specifies how long, in seconds, 

the VirtualCenter client waits for a response from the VirtualCenter Server for long 

operations. The default is 120 seconds.

Refer to “Starting the VI Client and Logging On” on page 35.

 Logging Options – Specify the degree of detail and extent of logs collected during 

normal VirtualCenter operations. Specifies verbose logging when set to 1. Used for 

advanced debugging and troubleshooting. Use this field only when directed by 

VMware technical support.

Refer to “System Log Files” on page 81.

 Database – Specify the password required to access the VirtualCenter database 

and the maximum number of database connections to be created. 

Refer to “Using MIBs with Your SNMP Traps” on page 74.
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Configuring VirtualCenter Communication
The VirtualCenter Server and ESX Server receives data transmissions from the VI Client 

on port 902. Ensure this is properly configured prior to connecting your VI Client to 

your VirtualCenter Server or ESX Server.

If a firewall is preventing the VI Client from connecting to the VirtualCenter Server, you 

have three options for correcting this:

 Reconfigure your firewall to allow the VI Client to communicate through port 902 

on the VirtualCenter Server or ESX Server. Refer to the instructions for your 

firewall.

 Use some port other than 902 (and if necessary, configure your firewall to open this 

other port). The VI Client and the VirtualCenter Server must both be configured to 

use the same port.

Refer to “Configuring the Port That VirtualCenter Server Uses” on page 69 for 

information on changing this port number in your VirtualCenter Server.

 If neither of the preceding options is possible and your firewall allows Web traffic 

to pass to the server, you can connect the VI Client to the VirtualCenter Server 

using a standard Web connection.

Refer to “Configuring VirtualCenter Communication over a Web Connection” on 

page 69 for information on setting up the Web site port.

NOTE The procedures described here are not available for communication with an ESX Server. 

ESX Server only uses port 902. You cannot change the port number ESX Server uses to 

communicate with either a VI Client or the VirtualCenter Server. Refer to the Server 

Configuration Guide for complete information on security, communication, and port 

configuration with an ESX Server directly.

CAUTION If you use this option to open a communication channel between your 

VirtualCenter Server and VI Client, the VirtualCenter console does not 

work.
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Configuring the Port That VirtualCenter Server Uses
There is a default port number assigned, 902. This procedure applies only to 

communication between a VI Client and a VirtualCenter Server. Do not use this to 

attempt to change the port number for communication between a VI Client and an ESX 

Server.

To change the default port number

1 Start the VI Client and log on to the VirtualCenter Server.

Refer to “Using the VI Client” on page 41.

2 Choose Administration > Server Settings. 

3 Click the Runtime Settings option. 

4 Enter the port number your VI Client is using to communicate with the 

VirtualCenter Server. Click the Finish option. Click the Finish button.

The port must be less than 64000. 

5 To accept the changes, restart the VirtualCenter Server.

Refer to “VirtualCenter Server” on page 33.

Configuring VirtualCenter Communication over a Web 
Connection

One alternative to connecting the VirtualCenter Server and VI Client on opposite sides 

of a firewall is through a standard Web connection.

To enable your VI Client to connect with the VirtualCenter Server across a firewall 

using a Web tunnel, change the Web site port address on your VirtualCenter Server. 

To open a Web port between the VirtualCenter Server and the VI Client using IIS

1 On the VirtualCenter Server, install Internet Information Services (IIS) Manager. 

Typically, this is installed by default with the Microsoft Windows operating 

system. 

NOTE Changing the port number is a very rare operation.

CAUTION If you use this option to open a communication channel between your 

VirtualCenter Server and VI Client, the VirtualCenter console does not 

work.
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2 Enable IIS.

For example, choose Start > Control Panel > Administrative Tools > Internet 

Services Manager. Select Internet Information Services.

3 From the IIS manager, open the Windows dialog box.

4 Expand the <server_name>. Right‐click on Default Web Site. Choose Properties > 

Web Site tab.

5 Set the port value for the VirtualCenter service.

6 In the Web Site Description block, enter the value of the TCP Port or, if allowed, the 

SSL port. 

A value of 80 is the default nonsecure TCP Web site port. A value of 443 is the 

default secure SSL Web site port. 

7 Set the dll directory. 

a If needed, create the directory:

C:\inetpub\wwwroot\vpx\

b Set the permissions for this directory to allow execution.

c Copy the file VmdbHttpProxy.dll to this directory.

The file is in \Program Files\VMware\VMware VirtualCenter.

8 Verify that the change has been applied.

9 Stop and restart the default Web site.

10 Each time you update the VirtualCenter version, repeat this process.

When you start the VI Client, enter the VirtualCenter Server Web site address as 

listed in the Server field.

 If you are using the secure Web port or any other nondefault port, use the full 

name: http:<server name>:<port>.

For example, http:vcserver:443.

 If you are using the default nonsecure Web site port, any of the following 

combinations work: http:<server name>, <server name>80, or http:<server 
name>:80.
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Virtual Machine Configuration
Sets of properties and settings dialog boxes make adjustments to the corresponding 

virtual machine element. 

To view the resources of a virtual machine

Select a virtual machine. Click the Summary tab. Refer to the Resources section of the 

Summary tab. 

Listed are the current CPU and memory usage, in addition to the datastores and 

networks associated with the selected virtual machine.

Refer to the Resource Management Guide for complete information on configuring and 

using your virtual machine resources.

To view the virtual machines on a host

Select a host. Click the Virtual Machines tab.

This is a list of all the virtual machines running on the selected managed host and the 

percentage of resources allocated to the virtual machine. 

To view the configuration of a virtual machine

Refer to the chapters in “Virtual Machine Management” on page 111 for complete 

information about creating virtual machines and editing the configuration of virtual 

machines. 

Select a virtual machine and choose Edit Settings. 

This displays the Virtual Machine Properties dialog box. From this dialog box you can 

edit the following virtual machine configuration items:

 Hardware – Adds or removes the hardware elements to your virtual machine:

 Memory

 CPU

 Floppy drive

 CD/DVD drive

 Network adapter

 SCSI controller

 Hard disk 

 Serial port

 Parallel port

 Ethernet adapter
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 SCSI device

 Options – Lists some general virtual machine settings, actions to take during a 

power state change, and actions taken for debugging during a process.

 General – Contains virtual machine name, virtual machine configuration file 

path and name, virtual machine working location, guest operating system, 

and version of the guest operating system installed.

 VMware Tools – Contains power control settings for the virtual machine’s 

toolbar power icons and a run scripts option specifying if and when to run a 

VMware Tools script.

 Power Management – Allows you to specify the virtual machine’s response 

when the guest operating system is on standby.

 Advanced – Contains settings for logging, masking the CPU and mask usage, 

and additional configuration parameters, which are used only when indicated 

by VMware technical support.

 Resources – Modifies the resource shares on the managed host of a virtual 

machine.

 CPU – Allows you to specify the CPU resource allocation shares, reservation, 

and limit for the selected virtual machine.

 Memory – Allows you to specify the memory resource allocation shares, 

reservation, and limit for the selected virtual machine.

 Disk – Allows you to specify the disk resource allocation shares and shares 

value for the selected virtual machine.

 Advanced CPU – Allows you to specify the hyperthreading and scheduling 

affinity for the CPU running the selected virtual machine.
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Working with Active Sessions
When your VI Client is connected to a VirtualCenter Server, you can view the list of 

users logged on to the server. This is not available when your VI Client is connected to 

an ESX Server host.

To view the users that are currently logged on to a VirtualCenter Server

From the VI Client connected to a VirtualCenter Server, click the Admin button in the 

navigation bar. Then click the Sessions tab.

To terminate an active session

1 From the VI Client connected to a VirtualCenter Server, click the Admin button in 

the navigation bar. Then click the Sessions tab.

2 Right‐click the session to close. Choose Terminate.

3 To confirm the termination, click OK.

To send a message to all users logged on to an active session

1 From the VI Client connected to a VirtualCenter Server, click the Admin button in 

the navigation bar. Then click the Sessions tab.

2 Type into the Message of the day field.

3 Click the Change button. 
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The text is sent as a notice message to all active session users and to new users 

when they log in.

SNMP Configuration
The SNMP agent controls a database called the SNMP Management Information Base 

(MIB), a standard set of statistical and control values. 

The following sections discuss SNMP configuration:

 “Using MIBs with Your SNMP Traps” on page 74

 “Understanding SNMP Trap and Variable Definitions” on page 75

 “Using SNMP to Monitor the Computer Running ESX Server” on page 77

 “Setting Up ESX Server SNMP” on page 79

 “Configuring SNMP Trap Destinations” on page 80

 “Configuring SNMP Management Client Software” on page 80

 “Configuring SNMP Security” on page 81

 “Using SNMP with Guest Operating Systems” on page 81

Using MIBs with Your SNMP Traps
VirtualCenter allows you to configure SNMP version 1 traps for alarm notification of 

events occurring in VirtualCenter. However, continue to use your ESX Server MIBs for 

host‐related alarms. 

The traps defined here are sent typically to other management programs. These 

management programs must know how to interpret the SNMP traps sent by 

VirtualCenter. 

To configure your management program to interpret VirtualCenter SNMP traps

1 Download the management information base (MIB) definitions:

 VMWARE‐ROOT‐MIB.mib

 VMWARE‐TRAPS‐MIB.mib

The MIB definition files can be found at C:\Program Files\VMware\VMware 
VirtualCenter\MIBS when the default installation directory is used.

2 Modify your management program to include and interpret the VMware MIBs.

Refer to your management program documentation for information on adding 

MIB definitions to your program.
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A technical note describing the MIB definitions can be found at 

www.vmware.com/pdf/vc_dbviews_11.pdf.

Understanding SNMP Trap and Variable Definitions
You can download two groups of SNMP MIB definitions. The SNMP trap tree for VI 

Client is located at:

.iso.dod.org.internet.private.enterprise.vmware.vmwTraps.
(.1.3.6.1.4.1.6876.50.).

The SNMP trap type for VMware VirtualCenter is 201.

Table 5‐1 lists the identification mapping for each VirtualCenter MIB group.

The following tables describe the VMware SNMP MIB root and primary sub‐trees. 

Currently each sub‐tree has its own MIB file. The tables list the variables used in the 

SNMP Trap groups. 

Table 5‐2 lists the definition mapping from VMWARE‐ROOT‐MIB.mib.

Table 5-1.  Identification Mapping

Identification Map Label

1.3.6.1.4.1.6876.50.301  vpxdTrapType

1.3.6.1.4.1.6876.50.302  vpxdHostName

1.3.6.1.4.1.6876.50.303  vpxdVMName

1.3.6.1.4.1.6876.50.304  vpxdOldStatus

1.3.6.1.4.1.6876.50.305  vpxdNewStatus

1.3.6.1.4.1.6876.50.306  vpxObjValue

Table 5-2.  Definition Mapping

Label Identification Mapping

vmware               enterprises 6876

vmwSystem           vmware 1 

vmwVirtMachines      vmware 2 

vmwResources        vmware 3 

vmwProductSpecific   vmware 4 

vmwTraps             vmware 50 
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Table 5‐3 lists the trap types from VMWARE‐TRAPS‐MIB.mib. The first five traps are 

generated from the ESX Server, and the last one from the VirtualCenter Server.

Table 5‐4 describes the variables and parameters used in the VMware Virtual 

Infrastructure Client defined SNMP traps. All variables are read‐only. The data type 

field refers to the SNMP version 1 type described by the structure of management 

information (SMI). And all variables and parameters are mandatory.

vmwOID               vmware 60 

vmwExperimental      vmware 700 

Table 5-3.  Trap Types

Trap Label Description Variables

vmPoweredOn Sent when a virtual machine is 
powered on from a suspended or a 
powered off state.

vmID, vmConfigFile

vmPoweredOff Sent when a virtual machine is 
powered off. 

vmID, vmConfigFile

vmHBLost Sent when a virtual machine detects a 
loss in guest heartbeat.

vmID, vmConfigFile

vmHBDetected Sent when a virtual machine detects or 
regains the guest heartbeat. 

vmID, vmConfigFile

vmSuspended Sent when a virtual machine is 
suspended. 

vmID, vmConfigFile

vpxdTrap Sent when entity status changed. vpxdTrapType, vpxdHostName, 
vpxdVMName, vpxdOldStatus, 
vpxdNewStatus, vpxdObjValue

Table 5-4.  Variables and Parameters

Variable Description Syntax

vmID  The ID of the affected virtual machine generating the 
trap. If the virtual machine ID is non‐existent, (such as for 
a power‐off trap) ‐1 is returned.

INTEGER 

vmConfigFile  The configuration file of the affected virtual machine 
generating the trap.

DisplayString 

vpxdTrapType The trap type in the preceding traps. DisplayString 

vpxdHostName The name of the host in the preceding traps. DisplayString 

Table 5-2.  Definition Mapping

Label Identification Mapping
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Using SNMP to Monitor the Computer Running ESX Server
ESX Server ships with an SNMP agent that allows you to monitor the health of the 

physical machine where ESX Server is running and of virtual machines running on it. 

This agent is based on Net‐SNMP with enhancements to support data specific to ESX 

Server. Background information on Net‐SNMP is available at 

net‐snmp.sourceforge.net.

The ESX Server SNMP agent can be used with any management software that can load 

and compile a management information base (MIB) in SMIv1 format and can 

understand SNMPv1 trap messages.

The location of the VMware sub‐tree in the SNMP hierarchy is: 

.iso.org.dod.internet.private.enterprises.vmware (.1.3.6.1.4.1.6876).

You can choose to use SNMP with or without any ESX Server MIB items.

Information About the Physical Computer

SNMP get variables allow you to monitor a wide variety of items about the physical 

computer and how virtual machines are using its resources. Some of the key types of 

information available are:

 Number of CPUs on the physical computer

 CPU resources on the physical computer being used by particular virtual machines

 Amount of RAM installed on the physical computer

 Physical memory used by the service console

 Physical memory used by particular virtual machines

 Physical memory that is not being used

 Usage data for disks on the physical computer, including number of reads and 

writes and amount of data read and written

vpxdVMName The name of the virtual machine in the preceding traps. DisplayString

vpxdOldStatus The old status in the preceding traps. DisplayString 

vpxdNewStatus The new status in the preceding traps. DisplayString 

vpxdObjValue The current object value in the preceding traps. DisplayString

Table 5-4.  Variables and Parameters

Variable Description Syntax

http://net-snmp.sourceforge.net
http://net-snmp.sourceforge.net
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 Usage data on the physical computer’s network adapters, including packets sent 

and received and kilobytes sent and received

 State of the VMkernel (loaded or not loaded)

Information About the Virtual Machines

SNMP get variables allow you to monitor a number of items about particular virtual 

machines running on the computer. Some of the key types of information available are:

 Path to the virtual machine’s configuration file

 Guest operating system running on the virtual machine

 Amount of memory the virtual machine is configured to use

 State of the virtual machine’s power switch: on or off

 State of the guest operating system: on or off (running or not running)

 Disk adapters seen by the virtual machine

 Network adapters seen by the virtual machine

 Floppy disk drives seen by the virtual machine

 State of the floppy drive: connected or disconnected

 CD‐ROM drives seen by the virtual machine

 State of the CD‐ROM drive: connected or disconnected

SNMP Traps

Five SNMP traps notify you of critical events in particular virtual machines. The 

affected virtual machine is identified by ID number and configuration file path. The 

traps notify you:

 When a virtual machine is powered on or resumed from a suspended state.

 When a virtual machine is powered off.

 When the virtual machine detects a loss of heartbeat in the guest operating system.

 When a virtual machine is suspended.

 When the virtual machine detects that the guest operating system’s heartbeat has 

started or resumed.

NOTE If the variable showing whether the VMkernel is loaded says no, any values reported 

for any other variable should be regarded as invalid.
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Setting Up ESX Server SNMP
ESX Server SNMP support is a module you can load into a daemon based on the 

net‐snmp package. It is compiled for version 5.0.9.2.30E.19 of that package. That 
version of net‐snmp is installed in the VMware service console by default.

Installing the ESX Server SNMP Module

The VMware‐specific SNMP modules are automatically installed when you install 

ESX Server. By default on a fresh install, ESX Server components are enabled in SNMP, 

and VMware traps are always on.

Installing the ESX Server MIB Module

You must make manual changes after upgrading ESX Server because the MIB module 

is not present in upgrades, only fresh installs. You might also have to make changes 

after installing third‐party management agents because the state of the configuration is 

unknown.

Configuring the ESX Server Agent from the Service Console

The following procedures must be performed after installing or upgrading third‐party 

management applications.

To enable or disable ESX Server MIB

1 Log onto the service console as the root user.

2 Edit the /etc/snmp/snmpd.conf configuration file.

3 Add or remove the following line to enable or disable VMware MIB items:

dlmod SNMPESX /usr/lib/vmware/snmp/libSNMPESX.so

To start the SNMP agents automatically

You can set the SNMP daemon to start whenever ESX Server boots by logging on as the 

root user on the service console and running the chkconfig command:

chkconfig snmpd on

To start the SNMP agents manually

If you must start the SNMP agent manually, log on as root in the service console and 

run the following command:

NOTE VMware Tools must be installed in the guest operating system to support the traps that 

detect loss and resumption of the guest’s heartbeat.



Basic System Administration

80 VMware, Inc. 

/etc/rc.d/init.d/snmpd start

By default, the agent starts and runs as background processes.

To enable and disable traps

1 Edit the config.xml file.

The configuration parameter snmp/generateTraps in the
/etc/vmware/host/config.xml file determines whether to generate a trap. By 

default, a trap is generated.

2 Restart vmware_hostd to see the change take effect.

Configuring SNMP Trap Destinations
VMware traps are generated to the destinations specified in the configuration file.

To configure traps (SEE UPDATE)

1 Log on to the service console as the root user.

2 Modify the /etc/snmp/snmpd.conf file.

3 Using a text editor, add the following line, replacing mercury.solar.com with the 

name of the host on your network that will receive traps.

trapsink mercury.solar.com 

Repeat this line to specify more than one destination.

4 Add the following line, replacing public with a community name of your choice: 

trapcommunity public. 

Only one instance of this line is allowed.

5 Save your changes.

Configuring SNMP Management Client Software
To use your SNMP management software with the ESX Server agent, take the steps 

needed to accomplish the following:

 In your management software, specify the ESX Server machine as an SNMP‐based 

managed device.

 Set up appropriate community names in the management software. These must 

correspond to the values set in the master SNMP agent’s configuration file, for 

example, rocommunity, trapcommunity, and trapsink.
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 Load the ESX Server MIBs into the management software so you can view the 

symbolic names for the ESX Server variables. You can find the MIB files on 

ESX Server, in the /usr/lib/vmware/snmp/mibs directory.

Configuring SNMP Security
The ESX Server SNMP package takes the simplest approach to SNMP security in the 

default configuration. It sets up a single community with read‐only access. This is 

denoted by the rocommunity configuration parameter in the configuration file for the 

snmpd daemon, snmpd.conf. You should change this file.

Other enhancements to the SNMP security mechanism allow an administrator to set up 

a more elaborate permissions scheme. See the snmpd.conf(5) man page for details. 

Using SNMP with Guest Operating Systems
To use SNMP to monitor guest operating systems or applications running in virtual 

machines, install the SNMP agents you normally would use for that purpose in the 

guest operating systems. No special configuration is required on ESX Server.

The virtual machine uses its own virtual hardware devices. You should not install 

agents intended to monitor hardware on the physical computer in the virtual machine.

System Log Files
In addition to lists of events and alarms, Virtual Infrastructure Client generates 

assorted logs. These logs contain additional information about activities in your 

VMware Infrastructure environment. 

The following sections discuss system log files:

 “Viewing System Log Entries” on page 82

 “External System Logs” on page 83

 “Exporting Diagnostic Data” on page 86

 “Collecting Log Files” on page 87
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Viewing System Log Entries
The following two procedures describe how to access and view system logs.

To view system log entries

1 From the VI Client connected to either a VirtualCenter Server or an ESX Server, 

display the administration panel and view the system log tab.

2 Click the Admin button in the navigation bar. Click the System Logs tab.

3 From the drop‐down list, choose the log and entry you want to view.



VMware, Inc. 83

Chapter 5 System Configuration

 

To search and list selected items 

1 With the log you want to filter displayed, choose View > Filtering to refer to the 

filtering options.

2 Enter text into the data field. Click Clear to empty the data field.

External System Logs
VMware technical support might request several files to help resolve any issues you 

have with the product. The following table describes additional log files you might 

need

.

Table 5-5.  External System Logs

Component
Operating
System File Name Location

ESX Server 2.x 
Service log

ESX Server vmware-serverd.log /var/log/vmware/

ESX Server 3.x 
Service log

ESX Server hostd.log /var/log/vmware/

VI Client 
Agent log

ESX Server vpxa.log /var/log/vmware/vpx/

VI Client 
Installation log

Windows Virtual Infrastructure 
Client host.

VI Client 
Service log

Windows temp_dir\viclient-x.log

x(=0, 1, ... 9)

Temp directory
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Virtual 
Machine 
Console logs

Windows vmware-<username>-<PID>.log Temp directory

Example:

C:\Documents and 
Settings\<username>\Local 
Settings\Temp

The path to this file appears in the 
About dialog box. In a console, 
choose Help > About VMware 
Virtual Infrastructure Client, 
and look under Additional 
Information.

Linux ui-<PID>.log Temp directory

Example:

/tmp/vmware-<username>/

The path to this file appears in the 
terminal when you start the 
console.

If you encounter problems with the VMware Virtual Machine console on a remote VI 
Client, please submit a support request and this log file.

Virtual 
Machine 
Console 
Installation log

Windows VMInst.log Temp directory

Example:

C:\Documents and 
Settings\<username>\Local 
Settings\Temp. 

The Local Settings folder is 
hidden by default. To refer to its 
contents, open My Computer, 
choose Tools > Folder Options, 
click the View tab, and choose 
Show Hidden Files and Folders. 

Linux VMInst.log /etc/vmware/

Table 5-5.  External System Logs (Continued)

Component
Operating
System File Name Location
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Virtual 
Machine log

Windows vmware.log In the same directory as the 
configuration file (.vmx) of the 
virtual machine that had 
problems. 

The path to the log file of the 
active virtual machine appears in 
the About dialog box. In a 
console, choose Help > About 
VMware Virtual Infrastructure 
Client, and look under 
Additional information.

Linux vmware.log In the same directory as the 
configuration file (.vmx) of the 
virtual machine that had 
problems.

 Run the support script or save the log file before you launch the failed virtual machine 
again.

Virtual 
Machine’s 
Event log

Windows event-<path_to_ 
configuration_file>
.vmx.log

On the virtual machine managed 
host.

C:\Program 
Files\VMware\VMware 
Virtual Infrastructure\ 
vmserverdRoot\eventlog

Linux /var/log/vmware

Virtual 
Machine 
Kernel Core 
file

ESX Server vmkernel-core.<date> and 
vmkernel-log.<date>

/root directory after you reboot 
your machine.

Virtual 
Machine 
Configuration 
file

Windows 
and Linux

.vmx On the virtual machine managed 
host.

Service 
Console log

ESX Server /var/log/messages

Service 
Console 
Availability 
report

ESX Server

VMkernel 
Messages

ESX Server /var/log/vmkernel in the 
service console

Table 5-5.  External System Logs (Continued)

Component
Operating
System File Name Location
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Exporting Diagnostic Data
There is an option for exporting all or part of your log file data. 

To export diagnostic data

1 From the VI Client connected to a VirtualCenter Server or ESX Server, open the 

Save Diagnostic Data dialog box.

2 Click the Admin button, click the System Logs tab, choose the log to export from 

the pull‐down list, and click the Export Diagnostic Data button on the Admin task 

bar.

3 If the VI Client is connected to VirtualCenter Server, specify the host whose log you 

want to export and the location for storing the log files.

VMkernel 
Alerts and 
Availability 
report

ESX Server /var/log/vmkernel in the 
service console

VMkernel 
Warning

ESX Server /var/log/vmkwarning in the 
service console

Table 5-5.  External System Logs (Continued)

Component
Operating
System File Name Location
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4 If the VI Client is connected to an ESX Server, specify the location for the log files.

5 Click OK.

A file is created of the selected data and stored at the specified location, using the 

vm-support script. If no file extension is provided, the default is a text file. The file 
contains Type, Time, and Description.

Collecting Log Files
VMware technical support might request several files to help resolve your problem. 

The following describes script processes for generating and collecting some of these 

files. 

To set VirtualCenter verbose logging in the Virtual Infrastructure Client

1 Choose Administration. Click Server Settings > Logging Options.

2 Choose Verbose from the pop‐up menu.

3 Click OK.

To collect Virtual Infrastructure log files

Choose from the options:

 To view the viclient-*.log files, change to the directory, %temp%.

 If you are running the VI Client on the VirtualCenter Server machine, download 

the log bundle.
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To collect ESX Server VMkernel files

 If the VMkernel fails, normally an error message appears for a period of time and 

then the virtual machine reboots.

 If you specified a VMware core dump partition when you configured your virtual 

machine, the VMkernel also generates a core dump and error log.

More serious problems in the VMkernel can freeze the machine without an error 

message or core dump.

To collect ESX Server Service Console files

1 Run the following script on the service console: 

/usr/bin/vm-support

This script collects and packages all relevant ESX Server system and configuration 

information and ESX Server log files. This information can be used to analyze the 

problem you are encountering. 

2 Save the resulting file: 

esx-<date>-<unique-xnumber>.tgz

To collect ESX Server Service log files

1 In a text editor, open the following file:

 On a Windows host, edit config.ini, located in C:\Documents and 
Settings\All Users\Application Data\VMware\VMware Virtual 
Infrastructure\.

 On a Linux host, edit /etc/vmware/config.

2 Add the following lines to the file: 

vmauthd.logEnabled = TRUE
log.vmauthdFileName = "vmauthd.log"

This creates a file called vmauthd.log. On a Windows host, this file appears by 

default in C:\Windows\system32 or C:\WINNT\system32. On a Linux host, 
this file appears by default in /var/log/vmware.

3 Save and close the configuration file. 

The log is enabled on a Linux host.You can enable logging for the VMware 

Authorization Service (known as vmware-authd on Linux hosts) manually.
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4 On a Windows host, choose Start > Administrative Tools > Services. Right‐click 

VMware Authorization Service and choose Restart. 

This enables logging on the Windows host.
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This chapter describes how to manage the objects in your VMware Infrastructure 

environment. This includes folders, datacenters, clusters, resource pools, networks, 

and datastores. These objects are used to help manage or organize the monitored and 

managed hosts and virtual machines.

This chapter describes how to add or remove inventory objects. Included is a reference 

to the documentation that describes these items and related activities in detail. 

Each object in the Virtual Infrastructure Client has its place in the overall hierarchy. An 

object’s position is determined by the object’s functionality. 

This chapter presents the following topics:

 “Understanding VI Client Objects” on page 91

 “Adding an Inventory Object” on page 96

 “Moving Objects in the Inventory” on page 97

 “Removing an Inventory Object” on page 98

Understanding VI Client Objects
There are several ways to get insight into the relationships between different objects:

 Viewing through the Maps feature – shows the inventory object relationships in 

graphical form. 

Managing the VI Client 
Inventory 6

NOTE The views and capabilities displayed vary depending on whether the VI Client is 

connected to a VirtualCenter Server or an ESX Server. Unless indicated, the process, 

task, or description applies to both kinds of VI Client connections.
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 Clicking an object in the inventory – provides a list of tabbed content that lists 

related objects. 

For example, a datastore has a virtual machine tab that lists the virtual machines 

that use the datastore. There is also a host tab that list the hosts that can access the 

datastore. 

 Viewing Inventory > Hosts and Clusters – provides a view of the set of virtual 

machines that run on a particular host, cluster, or resource pool. Each object has a 

tab that displays all the virtual machines associated or contained within in. 

However, the Hosts and Clusters view is not a complete list of available virtual 

machines and templates. Only the Inventory > Virtual Machines and Templates 

option displays all the virtual machine and templates. Through this view you can 

organize virtual machines into arbitrary folder hierarchies. 

The Virtual Infrastructure Client is used to connect directly to an ESX Server or 

indirectly to an ESX Server through a VirtualCenter Server. The VI Client displays only 

those functions that are appropriate to the type of server connected to it. For example, 

if the VI Client is connected to an ESX Server, the clusters functionality is not displayed.

The figure below lists the objects of a VMware Infrastructure environment. The objects 

are in hierarchical order. Templates, networks, and datacenters are displayed on their 

own inventory panel. All other objects appear in the Hosts & Clusters inventory panel. 

All four panels are linked to the root folder. 
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Figure 6-1.  Virtual Infrastructure Client Hierarchy
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When the VI Client is connected to an ESX Server, the root is the host itself. Contained 

objects include the host root resource pool, child resource pools, and virtual machines. 

Clusters, folders, datacenters, networks, and datastores do not appear in the inventory 

when the VI Client is connected only to an ESX Server.

Some objects serve only as organizational structures. These provide a means for you to 

organize your objects by department, group, company function, location, and so on.

Other objects limit a group of contained objects. For example, a VMotion failover can 

occur only within a cluster, not between clusters. Similarly a VMotion failover can occur 

only within a datacenter, not between datacenters.

The Virtual Infrastructure Client objects are as follows:

 Root folder – In VirtualCenter Server only. Child objects are datacenters or 

subfolders. The root folder is set as a default for every VirtualCenter Server. You 

can change the name, but not add or remove it.

 Folders – In VirtualCenter Server only. Child objects are datacenters, hosts, 

clusters, virtual machines, or subfolders.

 Datacenters – In VirtualCenter Server only. Child objects are folders, clusters, or 

hosts.

A datacenter contains clusters, hosts, and virtual machines. All actions taken upon 

managed hosts and virtual machines are applied within their datacenter. Within a 

datacenter, you can monitor and manage virtual machines separately from their 

hosts and use VMotion. You cannot perform migration between datacenters.

 Clusters – In VirtualCenter Server only. Child objects are hosts, virtual machines, 

or resource pools. 

If your system is licensed, you can enable the following cluster features:

 VMware HA – Allows VirtualCenter to migrate and restart a virtual machine 

when a host fails. VMware HA is not listed as an inventory object itself, but it 

allows the cluster object to be seen.

 VMware DRS – Monitors the VirtualCenter environment, makes initial placement 

recommendations, makes virtual machine migration recommendations, and 

enables VirtualCenter to automatically place and migrate virtual machines on 

hosts to attain the best use of cluster resources. VMware DRS is not listed as an 

inventory object itself, but it allows the cluster object to be seen.

Refer to the Resource Management Guide for comprehensive information on using 

Virtual Infrastructure Client clusters.
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 Hosts – Child objects are virtual machines or resource pools. Hosts are ESX Server 

systems. The term host refers to the virtualization platform that is the host to the 

virtual machines. Host is the default top structure for a standalone ESX Server.

When the VirtualCenter Server is connected to the Virtual Infrastructure Client, all 

ESX Server systems registered with VirtualCenter are simply referred to as hosts. 

ESX Server systems directly connected to the Virtual Infrastructure Client are 

referred to as standalone hosts. 

Refer to the Server Configuration Guide for comprehensive information on 

configuring your ESX Server.

 Resource pools – Child objects are virtual machines or resource pools. They are 

available on ESX Server hosts as well as through VirtualCenter Servers. 

A Virtual Infrastructure Client resource pool is used to allocate host‐provided CPU 

and memory to the virtual machines resident to the host.

Refer to the Resource Management Guide for comprehensive information on using 

Virtual Infrastructure Client resource pools.

 Virtual machines – Located within a host, virtual disks on a datastore, associated 

within a cluster or resource pool. Can be listed as a child object to hosts, clusters, 

or resource pools. Can be moved between hosts or clusters. When adding to a 

cluster or resource pool, you must specify or have in the cluster or resource pool a 

designated target host.

 Networks – In VirtualCenter Server only. Child object to datacenters. Networks are 

discovered when hosts are added to the VMware Infrastructure environment. 

Refer to the Server Configuration Guide for comprehensive information on 

configuring your ESX Server.

 Datastores – In VirtualCenter Server only. Child object to datacenters. Datastores 

are discovered when hosts are added to the VMware Infrastructure environment. 

This includes the discovery of datastores that are local to the managed host as well 

as datastores on the SAN or NAS. 

Refer to the Server Configuration Guide for comprehensive information on 

configuring your ESX Server.
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Adding an Inventory Object
Each inventory object can be added only to its corresponding hierarchical parent. Only 

permissible objects are listed on the parent menus. These pairings are as follows:

To add an inventory object

1 From a VI Client, display the appropriate inventory view.

2 Select the appropriate parent icon in the inventory panel. From the pop‐up menu, 

choose New <Object> where <Object> is a folder, datacenter, cluster, resource 
pool, host, or virtual machine.

 If the new object is a folder or datacenter, a new icon is added to the inventory. 

For example, a new datacenter is added to the hierarchy. Type in a useful name.

 If the object is a cluster, resource pool, host, or virtual machine, a wizard appears. 

Answer the prompts and click Finish. 

For additional information, refer to the appropriate manual: 

 Cluster – Refer to the Resource Management Guide.

 Resource pool – Refer to the Resource Management Guide.

 Host – Refer to “Managing Hosts in VirtualCenter” on page 99.

 Virtual machine – Refer to “Managing Virtual Machines” on page 141.
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Moving Objects in the Inventory
Some objects can be manually moved between folders, datacenters, resource pools, and 

hosts. 

To move an object using drag-and-drop

1 From a VI Client, display the appropriate inventory view.

2 Select the object to be moved from the appropriate inventory view by clicking it. 

A box is displayed around it. This indicates the object is selected.

3 Drag the moving object to the target object. 

 If the moving object is allowed to move to the target, the target object is 

displayed with a box around it, indicating it is selected.

 If the moving object is not allowed to move to the target, a naught sign (zero 

with a slash) appears, and the object is not moved.

The inventory objects can be moved as follows:

 Root folder, root host (ESX Server), networks, and datastores — Cannot be 

moved. 

 Folders — Can be moved within a datacenter. 

 Datacenter — Can be moved to folders at a sibling or parent level.

 Cluster — Can be moved between folders and within datacenters at a sibling 

or parent level. 

 Host — When managed by a VirtualCenter Server, if a host is in a cluster, all 

virtual machines on the host must be shut down and the host must be placed 

into maintenance mode before it can be moved from the cluster. A host can be 

moved between clusters and datacenters. 

 Resource pools — Can be moved to other resource pools and folders.

 Virtual machines — Can be moved to other resource pools, clusters, folders, 

datacenters, or hosts. When adding to anything other than a host, you must 

specify a target host.

4 Correct the conditional situation, if needed.

When you release the mouse button after dragging the object moves to the new 

location or an error message indicates what needs to be done to permit the move. 
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Removing an Inventory Object
When you remove an object (such as a folder, datacenter, cluster, or resource pool), 

VirtualCenter removes all child inventory objects (such as datacenters, clusters, hosts, 

and virtual machines contained within the object). All the associated tasks and alarms 

are also removed. Assigned processor and migration licenses are returned to available 

status. Virtual machines that were on a managed host remain on the host, but are no 

longer managed by VirtualCenter. 

To remove an inventory object

1 From a VI Client, display the appropriate inventory view.

2 Select the object. From the pop‐up menu, choose Remove.

3 To confirm that you want to remove the object, click Yes and follow the prompts, 

as needed. 

Once confirmed, VirtualCenter removes all clusters, hosts, and virtual machines 

within the datacenter from the managed inventory. In addition, all the associated 

tasks, alarms, and events are also removed. Assigned processor and migration 

licenses are returned to available status. Virtual machines that were on the 

managed host remain on the host. The root folder cannot be removed.

NOTE The remove option does not delete virtual machines from its datastore.
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This chapter describes how to have hosts managed by VirtualCenter. For information 

on configuration management of hosts, refer to the Server Configuration Guide. 

This section contains the following:

 “Hosts Overview” on page 99

 “Understanding Host States” on page 101

 “Adding a Host” on page 101

 “Connecting or Disconnecting a Host” on page 104

 “Automatically Reconnecting a Host” on page 106

 “Removing a Host from a Cluster” on page 106

 “Removing a Host from VirtualCenter” on page 108

 “Host Advanced Configuration Options” on page 110

Hosts Overview
A host is a virtualization platform, an ESX Server, that supports virtual machines. A 

VirtualCenter managed host is an ESX Server host that is registered with VirtualCenter. 

The task of managing a host is accomplished through the Virtual Infrastructure Client. 

Managing Hosts in 
VirtualCenter 7

NOTE The views and capabilities displayed vary depending on whether the VI Client is 

connected to a VirtualCenter Server or an ESX Server. Unless indicated, the process, 

task, or description applies to both kinds of VI Client connections.
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This VI Client can be connected either directly to an ESX Server host or indirectly to ESX 

Server hosts through a connection to a VirtualCenter Server. 

When ESX Server hosts are connected to the VI Client directly, you manage them 

individually as standalone hosts. Most of the host configuration and virtual machine 

configuration features still apply. Features that require multiple hosts, such as 

migration with VMotion of a virtual machine from one host to another, are not available 

through the standalone host connection. 

When ESX Server hosts are managed by VirtualCenter, they are added to the VMware 

Infrastructure environment through a VI Client connected to a VirtualCenter Server. 

Managed hosts are hierarchically placed in datacenters, folders, or clusters under the 

root node folder. 

All virtual machines on managed hosts are automatically discovered and imported into 

VirtualCenter. When you add multiple managed hosts, the VirtualCenter Server 

identifies any naming conflicts that exist between virtual machines and alerts the 

system administrator, who can then rename virtual machines as necessary. Configure 

the virtual machine display names. The name can be up to 80 characters long and may 

contain alphanumeric characters and the underscore (_) and hyphen (‐) characters. The 

name must also be unique across all virtual machines within a virtual machine group. 

When the VirtualCenter Server connects to a managed host, it does so as a privileged 

user. The individual Virtual Infrastructure Client user does not necessarily need to be 

an administrative user on the managed host. Refer to “Assigning Access Permissions” 

on page 263 for information on setting up Virtual Infrastructure Client users.

NOTE ESX Server supports a maximum of five direct, concurrent VI Client connections.

CAUTION If an ESX Server host is connected with a VirtualCenter Server and you 

attached a VI Client to manage the ESX Server host directly, you receive an 

error message but are allowed to proceed. This might result in conflicts on 

the host, especially if the host is part of a cluster. This action is strongly 

discouraged.



VMware, Inc. 101

Chapter 7 Managing Hosts in VirtualCenter

 

Understanding Host States
Actions taken upon a managed host require that the managed host be in a specific state. 

Whenever an operation is performed on a managed host, the host state changes. While 

the state is in transition, the state field displays a term that describes the transition.

Adding a Host
Virtual machines exist on managed hosts within the network. Hosts are added to the 

VMware Infrastructure environment. The VirtualCenter Server discovers and adds all 

the virtual machines contained within that managed host to the VMware Infrastructure 

environment.

If you are connecting your VI Client to an ESX Server directly, the procedures in this 

section do not apply.

To add a host to the VirtualCenter Server

1 Ensure a communication channel through a firewall, if needed.

If any managed host in the VirtualCenter environment is behind a firewall, ensure 

that the managed host can communicate with the VirtualCenter Server and with 

all other hosts on port 902 or another configured port. Refer to Installation and 

Upgrade Guide and the Server Configuration Guide for additional information.

2 Click the Inventory button in the navigation bar. Expand the inventory as needed, 

and click the appropriate datacenter, folder, or cluster.

3 Select the appropriate datacenter or cluster, and choose New Host from the main 

or pop‐up menu.

NOTE Disconnecting a managed host differs from removing the managed host from the 

VirtualCenter Server. Disconnecting a managed host does not remove it from the 

VirtualCenter Server; it temporarily suspends all VirtualCenter Server monitoring 

activities. The managed host and its associated virtual machines remain in the 

VirtualCenter Server inventory. Removing a managed host removes the managed host 

and all its associated virtual machines from the VirtualCenter Server inventory.

NOTE When adding or removing hosts, make sure NFS mounts are active. If NFS mounts are 

unresponsive, the operation fails. 
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4 Enter the managed host connection settings.

a Type the name of the managed host in the Host name field. 

b Enter the Username and Password for a user account that has administrative 

privileges on the selected managed host. 

VirtualCenter uses the root account to log on to the system and then creates a 

special user account. VirtualCenter then uses this account for all future 

authentication. 

5 To confirm the Host Summary information, click Next.

6 If you are adding the host to a cluster:
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a Specify what should happen to the resource pools on the host.

The options are:

 Put all the host’s virtual machines into the cluster’s root resource pool.

 Create new resource pool for the host’s virtual machines. The default 

resource pool name is derived from the host’s name. Type over the text to 

supply your own name.

b Click Next. 

c Refer to the Resource Management Guide.

7 If you are adding the host to a datacenter:

a Identify the location of the host’s virtual machines.

b Select from the list of inventory objects displayed in the Selection box.

8 To confirm completing the Add Host wizard, click Finish.

When the dialog box is complete and you click Next, VirtualCenter does the 

following:

 Searches the network for the specified managed host and identifies all the 

virtual machines on the managed host. If you click Cancel, the host is removed 

from the VirtualCenter inventory.

 Connects to the managed host. If the wizard cannot connect to the managed 

host, the managed host is not added to the inventory.

 Verifies that the managed host is not already being managed. If it is already 

being managed by another VirtualCenter Server, VirtualCenter displays a 

message. If the wizard can connect to the managed host but for some reason 

cannot remain connected to the VirtualCenter Server, the host is added, but is 

in a disconnected state. This occurs, for example, if the host is already being 

managed by another VirtualCenter Server.

 Reads the number of processors on the managed host and allocates the 

appropriate number of licenses. The number of processors is stored in the 

VirtualCenter database and is verified upon each managed host reconnection 

and VirtualCenter startup. 

NOTE Newer processors have two CPU cores in each processor package. Systems 

with dual‐core processors must use ESX Server 2.5.2 or later. VirtualCenter 

licenses are issued by pairs of processor packages, not by processor cores. 

Therefore, if the system is using two dual‐core processors or two single‐core 

processors, the system requires a single 2‐processor VirtualCenter license. 
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 Verifies that the managed host version is supported. If it is not, and the 

managed host version can be upgraded, VirtualCenter prompts you to 

perform an upgrade.

 Imports existing virtual machines.

Connecting or Disconnecting a Host
You have the option to disconnect and reconnect a managed host that is being managed 

by a particular VirtualCenter Server. This section describes how to reconnect a 

managed host.

To connect or disconnect a managed host

1 From the VI Client connected to a VirtualCenter Server, click the Inventory button 

in the navigation bar. Expand the inventory as needed, and click the appropriate 

managed host.

2 Select the appropriate managed host icon in the inventory panel, and choose 

Connect or Disconnect from the pop‐up menu. 

3 When disconnecting, confirm the action. Click Yes.

When the managed host’s connection status to VirtualCenter is changed, the 

statuses of the virtual machines on that managed host are updated to reflect the 

change.

NOTE Disconnecting a managed host differs from removing the managed host from 

VirtualCenter. Disconnecting a managed host does not remove it from VirtualCenter; it 

temporarily suspends all VirtualCenter monitoring activities. The managed host and its 

associated virtual machines remain in the VirtualCenter inventory. Removing a 

managed host removes the managed host and all its associated virtual machines from 

the VirtualCenter inventory.
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If the managed host is disconnected, the word “disconnected” is appended to the 

object name in parentheses, and the object is dimmed. All associated virtual 

machines are similarly dimmed and labeled.

If the managed host is connected, the disconnected designation is removed and the 

object name is in full black print. All associated virtual machines are similarly 

labeled.
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Automatically Reconnecting a Host
The VirtualCenter Server tries to reconnect to a managed host if the connection is lost. 

You can define how long VirtualCenter tries to re‐establish the connection. This feature 

is not available when the VI Client is connected directly to an ESX Server. 

To configure automatic managed host reconnection

1 From the VI Client, display the inventory.

2 Choose Administration > Server Settings. When the wizard opens, choose the 

Connection Options list item.

3 Enter a value in minutes in the Host Reconnect Threshold box. 

4 To exit the wizard, click the Finish list item. Then click Finish again. 

Removing a Host from a Cluster
Hosts can be removed from a cluster by selecting them from either the inventory or list 

views and dragging them to a new location within the inventory (either to a folder as a 

standalone host or to another cluster). When a host is removed from a cluster, the 

resources it provides are deducted from the total cluster resources. The virtual 

machines deployed on the host are either migrated to other hosts within the cluster or 

remain with the host and are removed from the cluster, depending on their current 

state. Hosts can be removed from a cluster only if all of the virtual machines on it are 

powered off, and the host is placed into maintenance mode. 



VMware, Inc. 107

Chapter 7 Managing Hosts in VirtualCenter

 

Refer to the Resource Management Guide for complete cluster information.

To remove a host from a cluster

1 From the VI Client connected to a VirtualCenter Server, display the inventory.

2 To remove the VirtualCenter agent from the managed host, ensure that the 

managed host is in a connected state. 

3 Power off all virtual machines on the host.

4 Select the appropriate managed host icon in the inventory panel, and choose Enter 

Maintenance Mode from the pop‐up menu. Click Yes.

The host icon changes and the term “maintenance mode” is added to the name in 

parentheses.

5 Move the host:

a Select the host icon in the inventory panel, and drag it to the new location. 

The host can be moved to another cluster or another datacenter. When the new 

location is selected, a blue box surrounds the cluster or datacenter name. 

b Release the mouse button.

VirtualCenter moves the host to the new location.
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6 Select the host, and from the pop‐up menu choose Exit Maintenance Mode. 

7 Restart any virtual machines, as needed.

Removing a Host from VirtualCenter
Removing a managed host from VirtualCenter breaks the connection and stops all 

monitoring and managing functions of that managed host and of all the virtual 

machines on that managed host. The managed host and its associated virtual machines 

are removed from the inventory. Historical data remains in the VirtualCenter database. 

Removing a managed host differs from disconnecting the managed host from 

VirtualCenter. Disconnecting a managed host does not remove it from VirtualCenter; it 

temporarily suspends all VirtualCenter monitoring activities. The managed host and its 

associated virtual machines remain in the VirtualCenter inventory.

Removing a managed host from VirtualCenter does not remove the virtual machines 

from the managed host or datastore. It removes only VirtualCenter’s access to the 

managed host and virtual machines on that managed host.

The figure below illustrates the process for removing a managed host from 

VirtualCenter. In the example here, notice the lost link between the VirtualCenter 

Server and the removed managed host, while the managed host files remain on the 

datastore.

NOTE If at all possible, remove managed hosts while they are connected. Removing a 

disconnected managed host does not remove the VirtualCenter agent from the 

managed host.
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Figure 7-1.  Removing a Host

To remove a managed host

1 From the VI Client connected to a VirtualCenter Server, display the inventory. 

2 To remove the VirtualCenter agent from the managed host, ensure that the 

managed host is in a connected state. 

The managed host can be in a connected or disconnected state when you remove 

it. However, removing a managed host while it is disconnected does not remove 

the VirtualCenter agent from the managed host.

3 Power off all virtual machines on the host.

4 If the host is part of a cluster, select the appropriate managed host icon in the 

inventory panel and choose Enter Maintenance Mode from the pop‐up menu. 

Confirm placement. Click Yes.
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2. Remove host. Virtual machines stay on the host’s datastore.
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5 Select the appropriate managed host icon in the inventory panel, and choose 

Remove from the pop‐up menu.

6 Click Yes to remove the managed host. Click No to keep the managed host.

If you click Yes, VirtualCenter removes the managed host and associated virtual 

machines from the VirtualCenter environment. VirtualCenter then returns all 

associated processor and migration licenses to available status.

Host Advanced Configuration Options
Refer to the Resource Management Guide for complete information on configuring and 

using the resource allocation features, which include VMware HA and VMware DRS. 

Refer to the Server Configuration Guide for complete information on configuring hosts.
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The Virtual Infrastructure Client (VI Client) provides you with the ability to deploy and 

manage virtual machines as quickly and simply as possible. The VI Client provides a 

simple and flexible user interface from which you can create new virtual machines 

through manual configuration, from templates, or by cloning existing virtual machines. 

All virtual machines are created in place using a wizard that guides you through the 

steps to produce a complete and working virtual machine.

The process of creating a virtual machine includes selecting the specific type of virtual 

machine creation that you want from either the main or pop‐up menus. 

This chapter describes how to create virtual machines using the New Virtual Machine 

wizard and by cloning an existing virtual machine. The wizard walks you through the 

steps required to define a virtual machine. This chapter includes information on setting 

parameters based on the guest operating system used and the resources allocated. After 

you create the virtual machine, you must install the guest operating system and 

VMware Tools.

This chapter contains the following sections:

 “Using the New Virtual Machine Wizard” on page 114

 “Installing a Guest Operating System” on page 132

 “Installing and Upgrading VMware Tools” on page 133

To perform the activities described in this chapter, you must have appropriate 

privileges on the host machine.

Creating Virtual Machines 8
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Using the New Virtual Machine Wizard
There are a number of ways in which you can start the virtual machine creation process. 

From the File > New menu, you can choose to create a new virtual machine, deploy a 

virtual machine from a template, or clone a virtual machine from an existing virtual 

machine. In the inventory panel, you can select an object and use its pop‐up menu to 

complete the tasks listed in table Table 8‐1.

Depending on the selection, you see a slightly different set of screens tailored for the 

particular process you chose. Any choices that are not applicable are disabled. For 

example, Clone is disabled if there are no virtual machines in your inventory. In all 

cases, however, the widest range of choices is available for optimal flexibility.

.

Table 8-1.  Inventory Object Options

Inventory Object Item on Pop-Up menu

Virtual machine Clone This Virtual Machine

Virtual machine folder Create New Virtual Machine

Deploy Virtual Machine from Template

Clone an Existing Virtual Machine

Host Create New Virtual Machine

Deploy Virtual Machine from Template

Clone an Existing Virtual Machine

Cluster Create New Virtual Machine

Deploy Virtual Machine from Template

Clone an Existing Virtual Machine

Resource pool Create New Virtual Machine

Deploy Virtual Machine from Template

Clone an Existing Virtual Machine

Datastore Create New Virtual Machine

Deploy Virtual Machine

Clone an Existing Virtual Machine

Template Deploy Virtual Machine from this Template

NOTE Before you create the virtual machine, check the installation notes for the guest 

operating system you intend to install in it. You can find this information in the Guest 

Operating System Installation Guide, available from the Help menu or from the VMware 

Web site at: http://www.vmware.com/support/guestnotes/doc/index.html
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Creating Typical Virtual Machines
New virtual machines can be added to clusters or hosts using the New Virtual Machine 

Wizard. The typical path is abbreviated because some assumptions are made about the 

virtual machine configuration. If you want to fully customize your virtual machine, see 

“Creating Custom Virtual Machines” on page 121.

To create a new virtual machine through the typical path

1 From the VirtualCenter client, click Inventory in the navigation bar and expand the 

inventory as needed.

2 In the inventory list, select the managed host to which you want to add the new 

virtual machine.

The Summary tab for the host appears.

3 Choose File > New > Virtual Machine.

The New Virtual Machine wizard appears.

4 Select Typical, and click Next.

The Typical choice shortens the process by skipping some choices that rarely need 

changing from their defaults. The following steps guide you through the typical 

path. The next section guides you through the custom path.

5 Type a virtual machine name, and click Next.
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The name you enter in the Virtual Machine Name field is the name that is listed 

in the VirtualCenter client inventory. It is also used as the name of the virtual 

machine’s files. The name can be up to 80 characters long and may contain 

alphanumeric characters and the underscore ( _ ) and hyphen (‐) characters. This 

name should be unique across the entire datacenter and must be unique within the 

folder.

6 Select a folder or the root of a datacenter, and click Next.

7 If the resource pool option is available, select the resource pool in which you want 

to run the virtual machine, expand the tree until you locate the proper resource 

pool, highlight it, and click Next.

Resource pools allow you to manage your computing resources within a host or 

hosts by setting them up in a meaningful hierarchy. Virtual machines and child 

resource pools share the resources of the parent resource pool. For more 

information on resource pools, see the Resource Management Guide.

8 Select a datastore in which to store the virtual machine files, and click Next.
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You should choose a datastore large enough to hold the virtual machine and all of 

its virtual disk files. For ESX Server hosts, the Datastore is configured on that host, 

including VMFS, NAS, and iSCSI volumes.

9 Under Guest Operating System, select the operating system family (Microsoft 

Windows, Linux, Novell NetWare, Solaris, or Other), select the version from the 

pull‐down menu, and click Next.

This is the operating system for your virtual machine. Your choice should be based 

on your planned use of the virtual machine. 

Refer to the Guest Operating System Installation Guide for details.

NOTE If you are installing a Linux operating system, use the LSILogic adapter.
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The wizard does not install the guest operating system for you. The New Virtual 

Machine Wizard uses this information to select appropriate default values, such as 

the amount of memory needed. 

10 Select the number of virtual processors in the virtual machine from the pull‐down 

list, and click Next.

Licensing is required to power on SMP. See the Installation and Upgrade Guide for 

more information on licensing.

11 Configure the virtual machine’s memory size by selecting the number of 

megabytes.

NOTE The Virtual CPUs page does not appear if the host is single‐processor or the guest 

operating system does not support SMP (for example, NetWare and Windows NT 

4.0).
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The minimum, recommended, and maximum sizes are based on the guest 

operating system. Regardless of the guest operating system, the minimum 

memory size is 4MB. The maximum depends on the host, but for ESX Server 3.0 it 

is 16384MB (16GB). The memory size must be a multiple of 4MB.

The colored triangles along the slider represent these three amounts as indicated 

by the key on the wizard. You can also drag the slider or select the number using 

the up and down arrows.

12 Click Next.
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13 Choose the networks to connect to and their options by selecting how many 

network adapters (NICs) you want to connect to, the names of the networks, and 

whether you want to connect to them at power on.

If you do not want the virtual network adapter to connect when the virtual 

machine is powered on, deselect the Connect at Power On check box.

The Network pull‐down menu lists the port groups that are configured for virtual 

machine use on the host. If no virtual machine port groups are configured, a 

warning dialog box appears, and you are not allowed to configure any virtual 

network cards.

14 Click Next.

15 Specify the size of the virtual disk.
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Enter the disk size in megabytes (MB) or gigabytes (GB). The default is 4GB. The 

available space on the selected VMFS volume is listed. You can configure a disk 

from as small as 1MB to as large as 2TB (2048GB), using a whole number of MB or 

GB.

The virtual disk should be large enough to hold the guest operating system and all 

of the software that you intend to install with room for data and growth. 

You cannot change the virtual disk’s maximum capacity later, but you can install 

additional virtual disks later by using the Virtual Machine Properties dialog box.

For example, you need about 1GB of actual free space on the file system containing 

the virtual disk to install Windows Server 2003 and applications, such as Microsoft 

Office, inside the virtual machine.

16 Click Next.

17 On the Ready to Complete page, review your options, and click Finish.

Before you can use your new virtual machine, you must partition and format the 

virtual disk and then install a guest operating system and VMware Tools. The 

operating system’s installation program can handle the partitioning and 

formatting steps for you.

Creating Custom Virtual Machines
This section describes the steps taken when you select the custom path in the New 

Virtual Machine wizard. The custom path provides more flexibility and options.

To create a new virtual machine through the custom path

1 From the VirtualCenter client, click Inventory in the navigation bar, and expand 

the inventory as needed.

2 In the inventory list, select the managed host to which you want to add the new 

virtual machine. 

3 Choose File > New > Virtual Machine.

The New Virtual Machine wizard appears. The menu in the left panel differs from 

the menu offered in the typical virtual machine configuration wizard.

4 Select Custom, and click Next.

The following steps guide you through the custom path.
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5 Type a virtual machine name, and click Next.

The name you enter in the Virtual Machine Name field is the name that is listed 

in the VirtualCenter client inventory. It is also used as the name of the virtual 

machine’s files. The name can be up to 80 characters long and may contain 

alphanumeric characters and the underscore ( _ ) and hyphen (‐) characters. This 

name should be unique across the entire datacenter and must be unique within the 

folder.

6 Select a folder or the root of a datacenter, and click Next.

7 To select the resource pool in which you want to run the virtual machine, expand 

the tree until you locate the proper resource pool, highlight it, and click Next.
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Resource pools allow you to manage your computing resources within a host or 

host by setting them up in a meaningful hierarchy. Virtual machines and child 

resource pools share the resources of the parent resource pool.

8 Select a datastore in which to store the virtual machine files, and click Next.

Choose a datastore large enough to hold the virtual machine and all of its virtual 

disk files. For ESX Server hosts, the Datastore is configured on that host, including 

VMFS, NAS, and iSCSI volumes. 
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9 Under Guest operating system, select the operating system family (Microsoft 

Windows, Linux, Novell NetWare, Solaris, or Other).

10 Choose the version from the pull‐down menu.

The wizard does not install the guest operating system for you. The New Virtual 

Machine wizard uses this information to select appropriate default values, such as 

the amount of memory needed. 

11 Click Next.

12 Select the number of virtual processors in the virtual machine from the pull‐down 

list, and click Next.

13 Configure the virtual machine’s memory size by selecting the number of 

megabytes.

The minimum, recommended, and maximum sizes are based on the guest 

operating system. Regardless of the guest operating system, the minimum 

NOTE The Number of Virtual CPUs page does not appear if the host is single‐processor 

or the guest operating system does not support SMP (for example, Netware and 

Windows NT 4.0).
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memory size is 4MB. The maximum depends on the host, but for ESX Server 3.0 it 

is 16384MB (16GB). The memory size must be a multiple of 4MB.

14 Click Next.

15 Choose the networks to connect to and their options by selecting how many NICs 

you want to connect to, the names of the networks, and whether you want to 

connect to them at power on.
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If you do not want the virtual network adapter to connect when the virtual 

machine is powered on, deselect the Connect at Power On check box.

The Network pull‐down menu lists the port groups that are configured for virtual 

machine use on the host. If no virtual machine port groups are configured, a 

warning dialog box appears, and you are not allowed to configure any virtual 

network cards.

16 Click Next.

17 Choose the type of SCSI adapter you want to use with the virtual machine.

Two IDE adapters and a SCSI adapter are installed in the virtual machine. The IDE 

adapter is always ATAPI. For the SCSI adapter, you can choose between a BusLogic 

or LSI Logic SCSI adapter. 

In the Select I/O Adapter Types page, the default for your guest operating system 

is already selected. Older guest operating systems default to the BusLogic adapter. 

The LSI Logic adapter has improved performance, works better with non‐disk 

SCSI devices, and is included with Windows Server 2003.

You can download the driver from the LSI Logic Web site. See the Guest Operating 

Installation Guide for details about the driver and the guest operating system you 

plan to install in this virtual machine.

18 Select the type of disk, and click Next.

You can store virtual machine data in a new virtual disk, an existing virtual disk, 

or a mapped storage area network (SAN) logical unit number (LUN).

A virtual disk comprises one or more files on the file system that appear as a single 

hard disk to the guest operating system. These disks are portable among hosts.

Mapping a SAN LUN gives your virtual machine direct access to that SAN, 

allowing you to use existing SAN commands to manage storage for the disk.

NOTE If you create an LSI Logic virtual machine and add a virtual disk that uses BusLogic 

adapters, the virtual machine boots from the additional disk.

NOTE The choice of SCSI adapter does not affect whether your virtual disk is an IDE or 

SCSI disk. 
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See the SAN Configuration Guide for details about SAN LUN configuration. 

 If you choose to create a new virtual disk, go to Step 19.

 If you choose to use an existing virtual disk, go to Step 23.

 If you choose to create a mapped SAN LUN, go to “Mapping a SAN LUN” on 

page 130.

19 If you chose to create a new virtual disk, you must select the size of the virtual 

disk, specify a datastore location for the disk, and click Next. (SEE UPDATE)

Enter the disk size in megabytes (MB) or gigabytes (GB). The default is 4GB. The 

available space on the selected VMFS volume is listed. You can configure a disk 

from as small as 1MB to as large as 2TB (2048GB), using a whole number of MB or 

GB.

The virtual disk should be large enough to hold the guest operating system and all 

of the software that you intend to install with room for data and growth. 

You cannot change the virtual disk’s maximum capacity later, but you can install 

additional virtual disks later by using the Virtual Machine Properties dialog box.

For example, you need about 1GB of actual free space on the file system containing 

the virtual disk to install Windows Server 2003 and applications, such as Microsoft 

Office, inside the virtual machine.
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You can locate the virtual disk on the same datastore as the virtual machine or 

select a datastore in another location. Use the Browse button to locate a datastore. 

The Browse for Datastore dialog box appears.

20 Select the virtual device node and disk mode for the virtual disk.

21 If you select Independent disk mode, choose one of the following:

a Persistent — Changes are immediately and permanently written to the disk.

b Nonpersistent — Changes to the disk are discarded when you power off or 

revert to the snapshot.

22 Click Next, and click Finish.

You have finished creating a virtual machine that uses a new virtual disk.
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Before you can use your new virtual machine, you must partition and format the 

virtual disk and install a guest operating system and VMware Tools. The operating 

system’s installation program might handle the partitioning and formatting steps 

for you. See the Guest Operating System Installation Guide.

23 If you chose to use an existing virtual disk, click Browse and navigate to the 

virtual disk you want to use. Click Next.

24 Select which virtual device node should be used by your virtual disk.

25 If you select Independent mode, choose one of the following:

a Persistent – Changes are immediately and permanently written to the disk.

b Nonpersistent – Changes to the disk are discarded when you power off or 

revert to the snapshot.

26 Click Next.

The Ready to Complete New Virtual Machine window appears. 

27 Review the options for your new virtual machine and click Finish. 

You have finished creating a virtual machine that uses an existing virtual disk.
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Mapping a SAN LUN

Instead of storing virtual machine data in a virtual disk file, you can store the data 

directly on a SAN LUN. This is useful if you are running applications in your virtual 

machines that must know the physical characteristics of the storage device.

When you map a LUN to a VMFS volume, VirtualCenter creates a file that points to the 

raw LUN. Encapsulating disk information in a file allows VirtualCenter to lock the 

LUN so that only one virtual machine can write to it.

Using VirtualCenter, you cannot deploy a virtual machine from a template and store its 

data on a LUN. When you deploy a virtual machine from a template, you can store its 

data in a virtual disk file.

To map a SAN LUN

1 From the Select a Disk page, select Mapped SAN LUN.

2 Click Next.

3 Select a LUN for the raw disk.

4 Click Next.

NOTE This file has a .vmdk extension, but the file contains only disk information describing 

the mapping to the LUN on the ESX Server system. The actual data is stored on the 

LUN.
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5 Select a datastore onto which to map the LUN.

6 Click Next.

7 Select a compatibility mode, either physical or virtual.

 Physical compatibility mode allows the guest operating system to access the 

hardware directly. Physical compatibility is useful if you are using SAN‐aware 

applications in the virtual machine. However, a LUN configured for physical 

compatibility cannot be cloned, made into a template, or migrated if the 

migration involves copying the disk. 

 Virtual compatibility mode allows the virtual machine to use VMware 

snapshots and other advanced functionality. Virtual compatibility allows the 

LUN to behave as if it were a virtual disk, so you can use features like disk 

modes. When you clone the disk, make a template out of it, or migrate it (if the 

migration involves copying the disk), the contents of the LUN are copied into 

a virtual disk (.vmdk) file. 

Subsequent screens offer different options, depending on your choice.

8 On the Specify Advanced Options page, you can change the virtual device node 

and click Next.

The Ready to Complete New Virtual Machine page appears.

9 Review the options for your new virtual machine, and click Finish.

You have finished creating a virtual machine with a virtual disk that is mapped to 

a LUN.
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Installing a Guest Operating System
A new virtual machine is like a physical computer with a blank hard disk. Before you 

can use it, you must partition and format the virtual disk and install an operating 

system. The operating system’s installation program might handle the partitioning and 

formatting steps for you.

Installing a guest operating system inside your virtual machine is essentially the same 

as installing it on a physical computer. The basic steps for a typical operating system 

are:

1 Start VMware VirtualCenter.

2 Insert the installation CD‐ROM for your guest operating system, or create an ISO 

image file from the installation CD‐ROM. Use the Virtual Machine Settings editor 

to connect the virtual machine’s CD‐ROM drive to the ISO image file and power on 

the virtual machine. 

Using an ISO image is faster than using a CD‐ROM.

3 To power on your virtual machine, click the Power On button.

When a virtual machine is powered on, a green right arrow is displayed next to the 

virtual machine icon in the inventory list, and the options in the Commands panel 

change as shown in the following image:

4 Follow the instructions provided by the operating system vendor.

To customize a guest operating system, see “Customizing Guest Operating 

Systems” on page 189.

NOTE You might need to change the boot order in the virtual machine BIOS so that the 

virtual machine attempts to boot from the CD/DVD device before trying other boot 

devices. To do so, press F2 when prompted during virtual machine startup.
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Installing and Upgrading VMware Tools
VMware Tools is a suite of utilities that enhances the performance of the virtual 

machine’s guest operating system and improves management of the virtual machine. 

Installing VMware Tools in the guest operating system is vital. Although the guest 

operating system can run without VMware Tools, you lose important functionality and 

convenience. 

When you install VMware Tools, you install:

 The VMware Tools service (or vmware-guestd on Linux guests).

 A set of VMware device drivers, including an SVGA display driver, the vmxnet 
networking driver for some guest operating systems, the BusLogic SCSI driver for 

some guest operating systems, the memory control driver for efficient memory 

allocation between virtual machines, the sync driver to quiesce I/O for 

Consolidated Backup, and the VMware mouse driver.

 The VMware Tools control panel that lets you modify settings, shrink virtual disks, 

and connect and disconnect virtual devices.

 A set of scripts that helps you to automate guest operating system operations. The 

scripts run when the virtual machine’s power state changes.

 A component that supports copying and pasting text between the guest and 

managed host operating systems in Microsoft Windows guest operating systems. 

The copy and paste option is not supported in Linux guest operating systems.

Configure the guest operating system before installing or reinstalling VMware Tools. 

This enables VMware tools to determine the correct mouse configuration and module 

configuration.

Limitations

The following are VMware Tools limitations:

 Shrink disk is not supported.

 For Microsoft Windows NT, the default scripts for suspend and resume do not 

work.

The mouse driver installation fails in X windows versions earlier than 4.2.0.

NOTE If the guest operating system is installed but not correctly configured when you install 

VMware Tools, the VMware Tools installation does not work correctly. This can cause 

the guest operating system to crash.
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This section includes the following information:

 “VMware Tools Properties Dialog Box” on page 135

 “Automated VMware Tools Upgrades” on page 138

The installers for VMware Tools for Windows, Linux, and NetWare guest operating 

systems are built into ESX Server as ISO image files. An ISO image file looks like a 

CD‐ROM to your guest operating system and even appears as a CD‐ROM disc in 

Windows Explorer. You do not use an actual CD‐ROM disc to install VMware Tools, nor 

do you need to download the CD‐ROM image or burn a physical CD‐ROM of this 

image file.

When you choose Virtual Machine > Install VMware Tools from the VMware 

VirtualCenter menu, VMware VirtualCenter temporarily connects the virtual 

machine’s first virtual CD‐ROM disk drive to the ISO image file that contains the 

VMware Tools installer for your guest operating system. You are ready to begin the 

installation process. 

To install or upgrade VMware Tools (SEE UPDATE)

1 From VirtualCenter, power on the virtual machine.

2 When the guest operating system starts, choose Virtual Machines > Install 

VMware Tools.

3 From inside the virtual machine, click Yes to launch the InstallShield Wizard.

 If you have autorun enabled in your guest operating system (the default 

setting for Windows operating systems), a dialog box appears.

 If autorun is not enabled, run the VMware Tools installer. Click Start > Run 

and enter D:\setup.exe, where D: is your first virtual CD‐ROM drive.

4 Follow the onscreen instructions. 

 On Windows Server 2003, the SVGA driver is installed automatically, and the 

guest operating system uses it after it reboots. 

 After you install VMware Tools, Windows 2000 and Windows XP guest 

operating systems must be rebooted to use the new driver.

NOTE If you do not have VMware Tools installed in your virtual machine, you cannot use the 

shutdown or restart options. You can use only the Power options. If you want to shut 

down the guest operating system, shut it down from within the virtual machine console 

before you power off the virtual machine.
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VMware Tools Properties Dialog Box
When VMware Tools is installed in your virtual machine, a VMware Tools icon is 

displayed in the virtual machine’s system tray.

To display the VMware Tools Properties dialog box

Double‐click the VMware Tools icon in the system tray from inside the guest operating 

system.

The VMware Tools Properties dialog box appears with the Options tab displayed.

Options Tab

From this tab you can synchronize the time between the guest and service console and 

show VMware Tools in the taskbar.

To synchronize the time between the guest and service console

The guest service can synchronize the date and time in the guest operating system with 

the time in the service console once every minute. 

1 In the VMware Tools control panel, select the Other tab (Options in a Linux guest), 

and select Time synchronization between the virtual machine and the host 

operating system. 

In addition, the guest service can synchronize the date and time in the guest with 

the service console in response to various system events, (for example, when you 

resume from disk). You can disable this in the configuration file by setting:

time.synchronize.resume.disk = FALSE
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2 Click Apply.

3 To show VMware Tools in the taskbar, select the check box and click Apply.

4 Click OK to exit the Properties dialog box.

Devices Tab

On the Devices tab you can view a list of all removable devices (such as floppy and 

CD‐ROM drives) available to the virtual machine and whether they are connected or 

disconnected. You can also connect or disconnect any of the listed devices. 

To connect a device to the virtual machine

1 Select the Devices tab.

2 Select the check box by the device you want to connect. 

3 Click Apply.

4 Click OK to exit the Properties dialog box.

Scripts Tab

Through VMware Tools you can run scripts that execute when you change the power 

state of your virtual machine (that is, when you power on, power off, suspend, or 

resume the virtual machine).

A default script for each power state is included in VMware Tools. These scripts are 

located in the guest operating system in C:\Program Files\VMware



VMware, Inc. 137

Chapter 8 Creating Virtual Machines

 

.

To run a script event

1 Click the Scripts tab.

2 Choose a power operation from the Script Event pull‐down menu.

3 Select a script to associate with this event. To select a script other than the default, 

click Custom Script, click Browse, and select the new script. 

Once you have selected a script, you can edit it or run it to test it.

4 To edit a script, click Edit.

The script opens in your default editor. Make your changes there.

5 To test the script, click Run Now.

6 To disable the running of a script, clear the Use Script check box.

7 Click Apply to save your settings.

8 Click OK to exit the properties dialog box.

Table 8-2.  VMware Tools Scripts

Task Default Script

Suspend the guest operating system suspend-vm-default.bat

Resume the guest operating system resume-vm-default.bat

Shut down the guest operating system poweroff-vm-default.bat

Power on the guest operating system poweron-vm-default.bat
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About Tab

The About tab contains information about VMware Tools, such as the build number.

Automated VMware Tools Upgrades
In ESX Server 3, VMware Tools and virtual hardware can be upgraded simultaneously 

for multiple virtual machines without interacting with the virtual machine from the 

virtual machine console. This new feature allows you to upgrade VMware Tools and 

virtual hardware for one or more virtual machine from earlier releases. The user 

performing the upgrade must have permission to do so. 

The following are limitations on VMware Tools mass upgrades:

 Only virtual machines managed by VirtualCenter 2 can be upgraded. 

 Mass upgrades are available only for Linux and Microsoft Windows 2000 and later.

 FreeBSD, NetWare, and Windows NT are not supported.

 The virtual disk must be on a VMFS‐3 volume.

 Virtual machines must be powered off.

 Because the mass upgrades command‐line tool is installed as part of the 

VirtualCenter 2 server installation and runs on VirtualCenter Server, the upgrader 

runs on Microsoft Windows only.

To mass upgrade tools and virtual hardware on multiple virtual machines

This tool, available from the VirtualCenter installation directory, can be used only from 

the command line with the following options:

vmware-vmupgrade.exe -u user [-p password] [-n vmname] [-h host] 
[-m maxpowerons] [-s] [-q]

Table 8-3.  Command-Line Options

Option Description

-u user Specifies a user with sufficient privileges on the target virtual machine, 
including VirtualMachine.Config.*, VirtualMachine.Interact.*, and 
VirtualMachine.Provisioning.*

-p password Specifies a password on the command line. If this is omitted, the tool 
immediately prompts for a password.

-n vmname The name of the virtual machine to upgrade. This name corresponds 
to the display name of a virtual machine. Specify multiple virtual 
machines using multiple ‐n parameters. The ‐n option is ignored if ‐h 
is specified.
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-h host Attempts to upgrade all the virtual machines on a particular host. Fails 
if the specified host if not version ESX 3.0 or greater.

-m maxpowerons On a particular host, power‐on only this number of virtual machines 
at a time.

-o port Specifies the VirtualCenter Server port, if one other than the default 
port 902 has been configured.

-t maxpowerontime After the tools upgrade is scheduled on a virtual machine, the virtual 
machine is powered on and allowed to run through the tools 
installation process. In most cases, the guest powers down the machine 
automatically when the process completes. This parameter allows a 
user to set the maximum amount of time for a virtual machine to be 
powered on in case the guest is unable to shut down the machine itself.

-s Skips the tools and only does the virtual hardware upgrade.

-q Works quietly. Doesn’t produce status or completion messages on 
shutdown.

Table 8-3.  Command-Line Options (Continued)

Option Description
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This chapter describes virtual machine tasks, including adding and removing virtual 

machines and powering virtual machines on and off.

This chapter contains the following sections:

 “Changing Virtual Machine Power States” on page 141

 “Adding and Removing Virtual Machines” on page 150

 “Starting and Shutting Down Virtual Machines” on page 155

Changing Virtual Machine Power States
The power state of a virtual machine indicates whether the virtual machine is active and 

functional. There are three basic states: on, off, and suspend. To achieve the on state, 

you can power on the machine, reset the machine, or resume activity from a suspended 

state. To achieve the off state, you can power off the machine or suspend all virtual 

machine activity. Each virtual machine power state change has a different effect on the 

guest operating system in the virtual machine.

There are also several access points for making changes to these power states. You can 

change a power state change by: 

 Selecting the virtual machine and the power option from the Inventory > Virtual 

Machine menu.

Managing Virtual Machines 9

NOTE The views and capabilities displayed vary depending on whether the VI Client is 

connected to a VirtualCenter Server or an ESX Server. Unless indicated, the process, 

task, or description applies to both kinds of VI Client connections.
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 Selecting Power on from the Commands area.

 Selecting the power option from the pop‐up menu. 

 Scheduling a power state change through the Scheduled Tasks button in the 

navigation bar.

The power state topics are covered in the following sections:

 “Understanding Virtual Machine Power States” on page 142

 “Understanding Transitional Power States” on page 144

 “Manually Powering a Virtual Machine On and Off” on page 144

 “Using Suspend and Resume” on page 145

 “Scheduling a Power State Change for a Virtual Machine” on page 146

Understanding Virtual Machine Power States
The basic power state options include:

 Power on – Powers on the virtual machine and boots the guest operating system if 

the guest operating system is installed. 

 Power off – Powers off the virtual machine. The virtual machine does not attempt 

to shut down the guest operating system gracefully.

 Suspend – Pauses the virtual machine activity. All transactions are frozen until you 

issue a resume command.

 Resume – Allows virtual machine activity to continue and releases the Suspended 

state.

 Reset – Shuts down the guest operating system and restarts it. This operation 

depends on the operating system being shut down. If shutdown is not automatic 

for that operating system, VMware Tools must be installed. 

The following power options perform extra functions in addition to the basic virtual 

machine power operations. VMware Tools must be installed in the virtual machine to 

perform these functions:

 Shut down guest – Shuts down the guest operating system gracefully.

 Standby guest – Suspends the guest operating system and run VMware tools 

suspend scripts. 

 Restart guest – Shuts down and restarts the guest operating system without 

powering off the virtual machine.
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Toolbar power buttons perform as follows:

 Power off – Powers off the virtual machine. A power off operation displays a 

confirmation dialog box indicating that the guest operating system might not shut 

down properly.

 Power on – Powers on a virtual machine when a virtual machine is stopped, or 

resumes the virtual machine and runs a script when it is suspended and VMware 

Tools is installed and available. Resumes the virtual machine and does not run a 

script when VMware Tools is not installed.

 Suspend – Suspends the virtual machine without running a script when VMware 

Tools is not installed, or runs a script, and suspends the virtual machine when 

VMware Tools is installed and available. 

 Reset – Resets the virtual machine when VMware Tools is not installed, and 

restarts the guest operating system when VMware Tools is installed and available. 

A reset operation displays a confirmation dialog box indicating that the guest 

operating system is not shut down properly.

NOTE The specific form of the power state action can be modified to include guest 

operating system shutdowns or not and to include running scripts or not. To 

configure power operation settings choose host > Configuration > Virtual 

Machine startup/shutdown. 
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Understanding Transitional Power States
Actions taken on a virtual machine require that the virtual machine be in specific power 

states. Whenever a power operation is performed on a virtual machine, the virtual 

machine power state changes and all other commands are locked out until the first 

command is completed.

The figure below illustrates states, transitions, and state‐changing commands for 

virtual machines. 

Figure 9-1.  Virtual Machine Power State Changes

Manually Powering a Virtual Machine On and Off
Before changing any power state on a virtual machine, you must have added the virtual 

machine to your Virtual Infrastructure environment. Refer to “Adding and Removing 

Virtual Machines” on page 150.

To manually change the power state of a virtual machine

1 Click the Inventory button in the navigation bar.

2 Expand the inventory as needed, and click the appropriate virtual machine.

3 Choose from the following options:

 Click the power option from the toolbar.

suspendresume

powered off

powered on
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power on power off

remove

state

command
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 Right‐click the virtual machine and choose a power option.

If an option is not currently available, it is dimmed and unselectable.

After the power option is selected, Virtual Infrastructure Client displays messages 

in Recent Tasks indicating the transition modes.

Using Suspend and Resume
The suspend and resume feature is most useful when you want to save the current state 

of your virtual machine and pick up work later with the virtual machine in the same 

state. 

Once you resume and do additional work in the virtual machine, you cannot return to 

the state the virtual machine was in at the time you suspended. To preserve the state of 

the virtual machine so you can return to the same state repeatedly, take a snapshot. 

Refer to “Using Snapshots” on page 221 for more information.

The speed of the suspend and resume operations depends on how much data changed 

while the virtual machine was running. In general, the first suspend operation takes a 

bit longer than later suspend operations do.

When you suspend a virtual machine, a file with a .vmss extension is created. This file 
contains the entire state of the virtual machine. When you resume the virtual machine, 

its state is restored from the .vmss file.

NOTE The Power Off button on the toolbar, by default, performs a “hard” power off. 

To perform a graceful shutdown of a guest operating system, use the 

right‐click option or shut down the operating system directly from inside the 

guest. Alternatively, the behavior of the power button can be changed on a 

per‐virtual machine.

NOTE The pop‐up menu on a virtual machine displays two options: Power Off and 

Shut Down. Power Off, sometimes called “hard” power off, is analogous to 

pulling the power cable on a physical machine, and always works. Shut 

Down, or “soft” power off, leverages VMware tools to perform a graceful 

shutdown of a guest operating system. In certain situations, such as when 

VMware Tools is not installed or the guest operating system is hung, 

shutdown might not succeed. 
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To suspend a virtual machine

1 If your virtual machine is running in full screen mode, return to window mode by 

pressing the Ctrl‐Alt key combination.

2 Click Suspend on the VMware Virtual Infrastructure Client toolbar.

When VMware Virtual Infrastructure Client completes the suspend operation, it is 

safe to exit VMware Virtual Infrastructure Client.

3 Choose File > Exit.

To resume a virtual machine that you have suspended 

1 Start VMware Virtual Infrastructure Client, and select a virtual machine that you 

have suspended.

2 Click the Power On button on the VMware Virtual Infrastructure Client toolbar, or 

choose the Power On option from the pop‐up menu or the Commands window.

Scheduling a Power State Change for a Virtual Machine
Depending upon your permissions, you can create a scheduled task to change the 

power state of the virtual machine in the VI Client.

To create a scheduled task that changes the power state

1 Click the Scheduled Tasks button in the navigation bar.

The list of scheduled tasks appears.

2 Right‐click and choose New Scheduled Task, or choose File > New > Scheduled 

Task.

The Select a Task to Schedule window appears.

3 Select Change the power state of a virtual machine, and click OK.

NOTE Applications you were running at the time you suspended the virtual machine are 

running, and the content is the same as it was when you suspended the virtual 

machine.
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The Change a Virtual Machine’s Power State wizard appears and displays the 

Select an Entity page.

4 Select the virtual machine whose state you want to change.

The Select a Power Operation screen appears.

5 Click a Power Operation option.
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6 Click Next.

7 Select the virtual machine whose power state changes.

8 Click Next.

The Schedule the Task screen appears.

9 Name the task, give a description, and specify the timing of the task.
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To refer to the calendar, click Later, and click the drop‐down arrow to choose a date 

from the displayed calendar. A red circle indicates today’s date and a dark circle 

indicates the scheduled date.

10 Click Next.

11 Click Finish. (SEE UPDATE)

Virtual Infrastructure Client adds the new task to the scheduled task list and 

completes it at the designated time. When it is time to perform the task, Virtual 

Infrastructure Client first verifies that the user who created the task still has 

permission to complete the task. If the permission levels are not acceptable, a 

message is generated and the task is not performed.
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Adding and Removing Virtual Machines
Virtual machines can be added to Virtual Infrastructure Client through their managed 

hosts. They can be removed from Virtual Infrastructure Client control and optionally 

from their managed host’s storage. 

The following sections discuss adding and removing virtual machines:

 “Adding Existing Virtual Machines to VirtualCenter” on page 150

 “Removing and Returning Virtual Machines from VirtualCenter” on page 151

 “Returning a Virtual Machine to VirtualCenter” on page 152

Adding Existing Virtual Machines to VirtualCenter
When you add a managed host to Virtual Infrastructure Client, Virtual Infrastructure 

Client discovers all the virtual machines on that managed host and adds them to the 

Virtual Infrastructure Client inventory. If a managed host is disconnected, the already 

discovered virtual machines continue to be listed as part of Virtual Infrastructure 

Client.

If a managed host is disconnected and reconnected, any changes to the virtual 

machines on that managed host are identified, and Virtual Infrastructure Client 

updates the list of virtual machines. For example, if node3 is removed and node4 is 

added, the new list of virtual machines adds node4 and shows node3 as orphaned. 

Figure 9-2.  An Orphaned Virtual Machine
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Removing and Returning Virtual Machines from VirtualCenter
Removing Virtual Machines from inventory unregisters them from the host and 

VirtualCenter. Virtual machine files remain at the same storage location and the virtual 

machine can be reregistered using the datastore browser.

Removing Virtual Machines from disk, on the other hand, deletes them completely.

To remove a virtual machine from VirtualCenter but not the datastore

1 From the Virtual Infrastructure Client, click the Inventory button in the navigation 

bar.

2 Expand the inventory as needed, and click the appropriate virtual machine.

3 Make sure that the virtual machine is powered off.

4 Select the virtual machine in the inventory panel.

5 Choose Inventory > Virtual Machine > Remove from Inventory.

6 To confirm that you want to remove the virtual machine from Virtual 

Infrastructure Client, click OK.

Virtual Infrastructure Client removes references to the virtual machine and no 

longer tracks its condition. 

CAUTION The Edit > Remove menu command removes your virtual machine 

from the disk.

NOTE The Remove from Inventory command removes the virtual machine only from 

Virtual Infrastructure Client. It does not remove the virtual machine from its 

datastore. 
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Returning a Virtual Machine to VirtualCenter
If you have removed a virtual machine from a Virtual Infrastructure Client server but 

did not remove it from the managed host’s datastore and you want to return it to Virtual 

Infrastructure Client, use the New Virtual Machine Wizard.

To return a virtual machine to VirtualCenter

1 Click the Inventory button.

2 Click the Summary tab.

3 Select a host, and start the New Virtual Machine wizard.

4 Choose Custom, and click Next.

5 Proceed through the wizard as though you are creating a new virtual machine.

6 When the Select a Disk page appears, click the Use an existing virtual disk radio 

button, and click Next.
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7 Browse to the existing virtual disk, and click Next.

8 Browse for a datastore.

9 When you have located a compatible virtual disk, select it and click Open.

CAUTION Use care when attaching virtual disks to virtual machines. Attaching 

the wrong virtual disk to a virtual machine yields unpredictable 

results. The first virtual disk should be a system disk that the virtual 

machine can boot from.
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10 Proceed through the rest of the wizard as though you were creating a new virtual 

machine.

11 Click Finish to exit the wizard.

To remove a virtual machine from Virtual Infrastructure Client and the datastore

1 From the Virtual Infrastructure Client, click the Inventory button in the navigation 

bar.

2 Expand the inventory as needed, and click the appropriate virtual machine.

3 Make sure that the virtual machine is powered off.

4 Choose Delete From Disk from the virtual machine’s pop‐up menu.

5 To confirm removing the virtual machine from Virtual Infrastructure Client and 

the datastore, click OK.

Virtual Infrastructure Client removes the virtual machine from its datastore 

entirely.

NOTE This removes all the files for the selected virtual machine, including the 

configuration file and the virtual disk files.
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Starting and Shutting Down Virtual Machines
You can configure your virtual machine to start up and shut down automatically, or you 

can disable this function. You can also set the default timing as well as the startup order 

for specified virtual machines when the system host starts.

To configure virtual machine startup and shutdown

1 Select the Inventory button.

2 Select a host machine.

3 Click the Configuration tab.

Configuration information for the host appears.

4 Click the Virtual Machine Startup/Shutdown link.
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The virtual machine startup and shutdown information appears.

5 Click Properties.

The Virtual Machine Startup and Shutdown dialog box appears. 
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6 If you want to allow virtual machines to start and stop automatically, click the 

check box at the top of the dialog box and enter a time in seconds for the default 

startup delay and the default shutdown delay.

7 If you want the operating system to start after a brief delay, specify a delay time in 

the Default Startup Delay box. 

This allows time for VMware Tools or the booting system to run scripts. 

8 Click the check box if you want the operating system to boot immediately after 

VMware Tools starts.

9 Next, specify the order in which the virtual machines start when the system starts. 

Use the Move Up, Move Down, and Edit buttons to rearrange the virtual 

machines in the display. (SEE UPDATE)

The virtual machines are stopped in reverse order. 

10 Click OK to exit the dialog box when you are through changing the system 

settings.
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This chapter describes the Virtual Machine Properties editor and the Add Hardware 

wizard. These allow you to edit and configure your existing virtual machines. It also 

discusses advanced virtual machine configuration options. These activities are 

performed after you create the virtual machine and install the guest operating system. 

You must have sufficient permission to perform the activities described in this chapter. 

This chapter contains the following topics:

 “Virtual Machine Properties Editor” on page 159

 “Adding New Hardware” on page 181

Virtual Machine Properties Editor
The Virtual Machine Properties Editor allows you to change nearly every characteristic 

that you choose when you created the virtual machine. This section describes how to 

use this powerful editor.

To edit an existing virtual machine configuration

1 From the VI Client, click Inventory in the navigation bar.

2 Expand the inventory as needed, and select the virtual machine you want to edit.

3 (Optional) Power off the virtual machine.

Changing most of the properties of a virtual machine is possible while it is 

powered off, but you can open the properties editor regardless of the power state. 

Many of the controls are read‐only if the virtual machine is not powered off. 

4 To display the Virtual Machine Properties dialog box, click the Edit Settings link in 

the Commands panel.

Configuring Virtual 
Machines 10
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The Virtual Machine Properties dialog box is displayed. There are three tabs: 

Hardware, Options, and Resources.

5 Select a tab and proceed to one of the following sections:

 “Changing the Hardware Configuration of a Virtual Machine” on page 160

 “Changing Virtual Machine Options” on page 170

 “Changing Virtual Machine Resource Settings” on page 175

 “Changing the Audio Configuration” on page 180

Changing the Hardware Configuration of a Virtual Machine
This section describes how to change the configuration of existing virtual hardware 

devices in a virtual machine.

You can add, edit, or remove hardware from your virtual machine using this wizard. 

The status of the device, such as edited or adding, is displayed in parentheses next to 

the hardware listing. The devices that can be added are:

 Serial port

 Parallel port

 Floppy drive

 DVD/CD‐ROM drive
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 Ethernet adapter

 Hard disk

 SCSI device

To change the DVD/CD-ROM drive configuration

1 Click the Hardware tab.

2 Click the DVD/CD‐ROM drive in the Hardware list.

3 Make changes as needed to the device status, connection, or virtual device node for 

the virtual machine to use.

4 If you do not want the CD‐ROM drive connected when the virtual machine starts, 

deselect Connect at power on.

5 Select the Use physical drive radio button to connect the virtual machine’s drive to 

a physical drive on the host computer. 

You can access a client CD‐ROM device or host CD‐ROM device. There are two 

types of DVD/CD‐ROM access:

a Use Pass‐through (raw) mode only for remote client device access.

b Use ATAPI emulation to access a host CD‐ROM device.
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The local or host CD‐ROM device is accessed through emulation mode. 

Pass‐through mode is not functional for local host CD‐ROM access. You can 

write or burn a remote CD only through pass‐through mode access, but in 

emulation mode you can only read a CD‐ROM from a host CD‐ROM device.

6 If you elected to use a physical drive, choose the drive to use from the drop‐down 

list.

7 Alternatively, select Use ISO Image to connect the virtual machine’s drive to an 

ISO image file.

8 If you selected Use ISO Image, click Browse to navigate to the file.

9 Under Virtual device node, use the pull‐down menu to choose the device node the 

drive uses in the virtual machine. 

10 Click OK to save your changes.

The Virtual Machine Properties dialog box closes.

To change the floppy drive configuration

1 Click the Hardware tab.

2 Click the floppy drive in the Device list.



VMware, Inc. 163

Chapter 10 Configuring Virtual Machines

 

3 Under Device Status, select Connect at power on to connect this virtual machine 

to the floppy drive when the virtual machine is powered on.

4 Under Connection, select Use physical drive to use a physical drive, choose Client 

or Host, and choose the drive from the list. 

5 To use a floppy image, select Use existing floppy Image or Create a new floppy 

image, and browse to the desired floppy image.

6 Click OK to save your changes.

The Virtual Machine Properties dialog box closes.

To change the SCSI device configuration

1 Click the Hardware tab.

2 Select the SCSI device in the hardware list.

3 To connect this virtual machine to the server’s SCSI device when the virtual 

machine is powered on, select Connect at power on.

4 Under Connection, select the physical device you want to use.

Under Virtual device node, select the virtual device node where you want this 

device to appear in the virtual machine.

5 Click OK to save your changes.

The Virtual Machine Properties dialog box closes.
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To change the virtual disk configuration

1 Click the Hardware tab.

2 Click the appropriate Hard Disk in the Hardware list.

3 Use the pull‐down menu to change the virtual device node.

4 For independent mode, which is unaffected by snapshots, select the check box. 

Then choose Persistent or Nonpersistent mode to determine the persistence of 

changes.

5 Click OK to save your changes.

The Virtual Machine Properties dialog box closes.
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To change the memory configuration

1 Click the Hardware tab.

2 Click Memory in the Hardware list.

3 Adjust the amount of memory allocated to the virtual machine. 

The range of memory supported is 128MB to 16384MB and is not limited to the 

physical memory of the host where the virtual machine resides. 

4 Click OK to save your changes.

The Virtual Machine Properties dialog box closes.

To change the virtual Ethernet adapter (NIC) configuration

1 Click the Hardware tab.

2 Click the appropriate NIC in the Hardware list.

3 To connect the virtual NIC when the virtual machine is powered on, select Connect 

at power on.

4 Under Network connection, use the pull‐down menu to choose the network label 

you want the virtual machine to use. 
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5 Click OK to save your changes.

The Virtual Machine Properties dialog box closes.

To change the parallel port configuration

1 Click the Hardware tab.

2 Click the appropriate Parallel port in the Hardware list.

3 Deselect the Connect at power on check box if you do not want the parallel port 

device to be connected when the virtual machine powers on.

The default setting is Connect at power on. 

4 Under Connection, select a radio button to indicate a physical parallel port or to 

connect the virtual parallel port to a file.

a If you select Use physical parallel port, choose the port from the pull‐down 

menu. 

b If you select Use output file, browse to the file location.

5 Click OK to save your changes.

The Virtual Machine Properties dialog box closes.

To change the SCSI controller configuration

You can change the SCSI controller configuration for a virtual machine on an ESX 

Server host only.

CAUTION Changing the SCSI controller type might result in a virtual machine boot 

failure.
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You can also specify whether the SCSI bus is shared. Depending on the type of sharing, 

virtual machines can access the same virtual disk simultaneously on the same server or 

any server. 

1 Click the Hardware tab.

2 Click the appropriate SCSI Controller in the Device list.

3 Select the SCSI controller type in the list.

4 Select the type of sharing in the SCSI Bus Sharing list:

 None – Virtual disks cannot be shared by other virtual machines.

 Virtual – Virtual disks can be shared by virtual machines on same server.

 Physical – Virtual disks can be shared by virtual machines on any server.

5 Click OK to save your changes.

The Virtual Machine Properties dialog box closes.

CAUTION Changing the SCSI controller type might result in a virtual machine 

boot failure.
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To change the serial port configuration

1 Click the Hardware tab.

2 Click the appropriate Serial port in the Hardware list.

3 If you selected Use physical serial port, use the pull‐down menu to choose the port 

on the host computer that you want to use for this serial connection.

4 If you selected Use output file, browse to the location of the file on the host that 

you want to use to store the output of the virtual serial port.

5 If you selected Use named pipe, use the default pipe name or enter another pipe 

name of your choice in the Pipe Name list. 

For a serial pipe for a virtual machine on an ESX Server host for Linux host, enter 

/tmp/<socket> or another UNIX socket name of your choice.

Then decide whether you are connecting two virtual machines or connecting a 

virtual machine to an application on the host.

6 If you are connecting two virtual machines, you must configure a serial port as a 

named pipe in two virtual machines: a server virtual machine and a client virtual 

machine.

a For the server virtual machine, select Server in the Near end list. 

b For the client virtual machine, select Client in the Near end list.
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c Select A virtual machine in the Far end list.

7 If you are connecting to an application on the host, select Server or Client in the 

Near end list. In general, select Server if you plan to start this end of the connection 

first.

a Select An application in the Far end list.

By default, the serial port is connected when you power on the virtual machine. 

You might deselect the Connect at power on check box (optional).

8 Under I/O Mode, decide whether to configure this serial port to use interrupt 

mode or polled mode. 

Polled mode is of interest primarily to developers who are using debugging tools 

that communicate over a serial connection.

Polled mode causes the virtual machine to consume a disproportionate share of 

processor (or CPU) time. This makes the host and other guests run sluggishly. To 

maintain best performance for applications on the host, select the Yield CPU on 

poll check box. This forces the affected virtual machine to use interrupt mode, 

which yields processor (or CPU) time if the only task it is trying to do is poll the 

virtual serial port.

9 Click OK to save your changes.

The Virtual Machine Properties dialog box closes.

To change the virtual processor or CPU configuration

If the virtual machine is on an ESX Server host and you have VMware Virtual SMP for 

ESX Server, which supports symetric multiprocessors (SMP), you can configure a 

virtual machine to have up to four virtual processors or CPUs. Virtual SMP can use 

two‐way or four‐way SMP. 

CAUTION Not all guest operating systems support SMP, and most that do require 

reinstallation if the number of processors or CPUs changes.
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1 Click the Hardware tab.

2 Click Virtual Processor or CPU in the Hardware list.

3 Select the number of virtual processors for the virtual machine.

You must have VMware Virtual SMP for ESX Server if you want more than one 

virtual processor or CPU for the virtual machine. If you do not have VMware 

Virtual SMP for ESX Server, the virtual machine can have only one virtual 

processor or CPU.

4 Click OK to save your changes.

The Virtual Machine Properties dialog box closes.

Changing Virtual Machine Options
On the Options tab, you can change the General, Power, Power Management, and 

Advanced settings. The virtual machine settings allow you to define actions that occur 

in various virtual machine power states. 

To change general settings

1 Click the Options tab.

2 To view the general options, click General in the Settings list.

The virtual machine name is displayed in the Virtual machine name field.

Changing the name does not change the name of any virtual machine files or the 

associated directory.

3 Select the virtual machine’s working location.

4 Select the operating system from the Guest operating system list. Use the 

pull‐down menu to choose the version.

5 Click OK to save your changes.

The Virtual Machine Properties dialog box closes.
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To change power state options

1 Click the Options tab.

2 View the power options.

3 Click Power in the Settings list.

The stop button on the toolbar can be configured to power off the virtual machine 

or shut down the guest operating system. The reset button on the toolbar can be 

configured to reset the virtual machine or restart the guest operating system.

4 Choose the desired actions in the lists under Power Controls.

5 (Optional) Configure VMware Tools scripts to run automatically when you change 

the virtual machine’s power state by checking the appropriate options under Run 

VMware Tools scripts.

6 Click OK to save your changes.

The Virtual Machine Properties dialog box closes.

NOTE For ESX Server virtual machines, there are no scripts for resuming and suspending 

virtual machines.
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To change power management options

1 Click the Options tab. 

2 View the power management options.

3 Click Power Management in the Settings list.

Guest Power Management allows you to determine how the virtual machine 

responds when the guest operating system (OS) is placed on standby.

4 Under Guest Power Management, select either Suspend the Virtual Machine or 

Standby the guest OS, and leave the virtual machine powered on.

5 (Optional) If you elected to leave the virtual machine on, select Wake on LAN for 

virtual machine traffic on your virtual machine network by selecting the check box.

6 Click OK to save your changes.

The Virtual Machine Properties dialog box closes.

To change advanced virtual machine settings

1 Click the Options tab. 

2 View the advanced options.

3 Click Advanced in the Settings list.



VMware, Inc. 173

Chapter 10 Configuring Virtual Machines

 

The Advanced pane appears with the following options:

a To enable debugging mode, select the Enable debugging information check 

box.

You can run a virtual machine so it collects additional debugging information 

that is helpful to VMware technical support in resolving issues. 

b To disable acceleration, select the Disable acceleration check box.

You can enable and disable acceleration while the virtual machine is running.

In rare instances, you might find that when you install or run software inside 

a virtual machine, the virtual machine appears to hang. Generally, the 

problem occurs early in the program’s execution. In many cases, you can get 

past the problem by temporarily disabling acceleration in the virtual machine. 

This setting slows down virtual machine performance, so use it only for 

getting past the problem with running the program. After the program stops 

encountering problems, deselect Disable acceleration. You might then be able 

to run the program with acceleration.
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c To enable logging, select the Enable logging check box.

This option starts logs to collect data.

4 Click the Advanced to view the mask, which specifies the CPU capabilities that 

this virtual machine requires.

This mask and the guest OS mask are used by VirtualCenter to determine whether 

a destination host is viable for migration or migration with VMotion.

Refer to “Migration with VMotion” on page 233 for more information on VMotion 

compatibility and CPU masks.

5 Click the Legend button to view the legend for the dialog box.

6 Click the close button to exit the legend.
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7 To modify or add configuration parameters as needed for experimental features or 

as instructed by technical support, click the Configuration Parameters button.

The Configuration Parameters dialog box appears.

8 When you are through, click OK to exit the dialog box.

9 Click OK to save your changes.

The Virtual Machine Properties dialog box closes.

Changing Virtual Machine Resource Settings
In the Virtual Machine Properties dialog box, you can adjust the host resource 

allocation for the selected virtual machine. You can change CPU, memory, disk, and 

advanced CPU resources from this tab.

For more information on resources, refer to the Resource Management Guide. 

CPU Resources

The CPU Resources panel lets you allocate processor resources for a virtual machine, 

specifying reservations, limits, and shares. You can edit some of the same information 

on the Resource Pools tab of the main VI Client window, which you might do to edit 

resource settings at the same time you edited other virtual machine settings.
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To change CPU settings

1 Click the Resources tab.

2 Select CPU in the Settings list.

3 Select a shares value, which represents a relative metric for allocating CPU 

capacity. 

 Shares – The values Low, Normal, High, and Custom are compared to the 

sum of all shares of all virtual machines on the server and the service console. 

Share allocation symbolic values can be used to configure their conversion 

into numeric values. 

 Reservation – Guaranteed CPU allocation for this virtual machine. 

 Limit – Upper limit for this virtual machine’s CPU allocation. Select 

Unlimited to specify no upper limit.

For more information on share values, refer to the Resource Management Guide. 

4 Click OK to save your changes.

The Virtual Machine Properties dialog box closes.

Advanced CPU Settings

The Advanced CPU Resources panel lets you set low‐level options that involve 

scheduling the virtual machine processing to physical processor cores and 

hyperthreads. This panel does not appear for virtual machines in a DRS cluster or when 

the host has only one processor core and no hyperthreading. 
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VMware ESX Server generally manages processor scheduling well, even when 

hyperthreading is enabled. The settings on this page are useful only for fine‐grained 

tweaking of critical virtual machines. 

The Hyperthreading Sharing option provides detailed control over whether a virtual 

machine should be scheduled to share a physical processor core (assuming 

hyperthreading is enabled on the host at all).

The Scheduling Affinity option allows fine‐grained control over how virtual machine 

CPUs are distributed across the hostʹs physical cores (and hyperthreads if 

hyperthreading is enabled). 

To change Advanced CPU settings

1 Click the Resources tab.

2 Select Advanced CPU in the Settings list.

NOTE Hyperthreading technology allows a single physical processor to behave like two 

logical processors. The processor can run two independent applications at the same 

time. While hyperthreading does not double the performance of a system, it can 

increase performance by better utilizing idle resources. For detailed information about 

hyperthreading and its use in VMware Infrastructure, see the Resource Management 

Guide (choose Help > Manuals). 
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3 Choose Hyperthreading Sharing Mode from the pull‐down menu. The options are: 

 Any – (default) The virtual CPUs of this virtual machine can freely share cores 

with other virtual CPUs of this or other virtual machines. 

 None – The virtual CPUs of this virtual machine have exclusive use of a 

processor core whenever they are scheduled to it. The other hyperthread of 

the core is halted while this virtual machine is using the core. 

 Internal – On a virtual machine with exactly two virtual processors, the two 

virtual processors are allowed to share one physical core (at the discretion of 

the ESX Server scheduler), but this virtual machine never shares a core with 

any other virtual machine. If this virtual machine has any other number of 

processors other than two, this setting is the same as the None setting. 

4 Choose to schedule affinity by selecting the Run on processor(s) radio button. 

The check boxes for the individual processors represent physical cores if 

hyperthreading is disabled or logical cores (two per physical core) if 

hyperthreading is enabled. Checking all the boxes is the same as not applying any 

affinity. You must provide at least as many processor affinities as the number of 

virtual CPUs in the virtual machine. 

5 Click OK to save your changes.

The Virtual Machine Properties dialog box closes.

Memory Resources

The Memory Resources panel lets you allocate memory resources for a virtual machine 

and specify reservations, limits, and shares. You can edit some of the same information 

on the Resource Pools tab of the main VI Client window, which you might do to edit 

resource settings at the same time as other virtual machine settings. 

NOTE This option is not allowed when the virtual machine resides on a DRS cluster, and 

its values are cleared when a virtual machine is migrated to a new host. The value 

of the option is only in tuning the performance of a precise set of virtual machines 

on the same host. 
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To change memory settings

1 Click the Resources tab.

2 Select Memory in the Settings list.

3 From the pull‐down menu in the Resource allocation panel, choose a relative 

metric for allocating memory to all virtual machines. 

Symbolic values Low, Normal, High, and Custom are compared to the sum of all 

shares of all virtual machines on the server and the service console. Share 

allocation symbolic values can be used to configure their conversion into numeric 

values. 

4 In the Resource allocation panel, use the slider to select the amount of reserved 

memory and the memory limit, or use the up and down arrows to enter the 

number of MBs allocated.

For more information on memory values, refer to the mem man page.

5 Click OK to save your changes.

The Virtual Machine Properties dialog box closes.

Disk Resources

The Disk Resources panel lets you allocate host disk I/O bandwidth to the virtual hard 

disks of this virtual machine. Disk I/O is a host‐centric resource and cannot be pooled 

across a cluster. However, CPU and memory resources are much more likely to 

constrain virtual machine performance than disk resources. 
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To change disk settings

1 Click the Resources tab. 

2 Select Disk in the Settings list. 

On this dialog box, you can adjust the host disk allocation for this virtual machine.

3 In the Resource Allocation panel, select the virtual hard disk from the list. 

4 Click in the Shares field. Use the pull‐down menu to change the value to allocate 

a number of shares of its disk bandwidth to the virtual machine.

Shares is a value that represents the relative metric for controlling disk bandwidth 

to all virtual machines. The values Low, Normal, High, and Custom are compared 

to the sum of all shares of all virtual machines on the server and the service console. 

Share allocation symbolic values can be used to configure their conversion into 

numeric values. 

5 Click OK to save your changes.

The Virtual Machine Properties dialog box closes.

Changing the Audio Configuration
(SEE UPDATE) Whether you have sound on your virtual machine depends on your guest 

operating system (guest OS). If the virtual machine is located on ESX Server and you 

are using Windows XP, sound is available. However, if your guest OS is Windows 2000 

or 2003, sound is not available to you.

To change the audio configuration

1 From the VirtualCenter client, click Inventory in the navigation bar. 

2 Expand the inventory as needed, and click the appropriate virtual machine.
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3 To display the Virtual Machine Properties dialog box, in the Summary tab, click 

Edit Properties or choose Edit > Properties.

4 Click the Hardware tab.

5 Click Audio in the Device list.

Under Device status, the default setting is Connect at power on.

6 Deselect the check box if you do not want the sound adapter to be connected when 

the virtual machine powers on.

7 Select Use default host sound adapter to use the default host sound adapter, or 

select Specify host sound adapter and select a specific adapter from the list. 

8 Click OK to save your changes.

The Virtual Machine Properties dialog box closes.

Adding New Hardware
You can add virtual hardware to a virtual machine using the Add Hardware wizard. 

The virtual hardware that you add appears in the hardware list displayed in the Virtual 

Machine Properties wizard.

To start the wizard

1 From the VirtualCenter client, click Inventory in the navigation bar. Expand the 

inventory as needed, and click the appropriate virtual machine.

2 To display the Virtual Machine Properties dialog box, click the Edit Settings link in 

the Commands panel.

3 Click the Hardware tab. 
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4 Click Add to start the Add Hardware wizard.

Follow the steps in the following sections to add various types of virtual hardware 

to your virtual machine.

To add a serial port

1 Start the Add Hardware wizard.

2 Select Serial Port, and click Next.

3 Select the type of media you want the virtual port to access: use a physical serial 

port on the host, output to a file, or connect to a named pipe.

4 Click Next.

5 If you selected Use physical serial port on the host, use the pull‐down list to 

choose the port on the host computer that you want to use for this serial 

connection.

6 If you selected Output to file, browse to the file on the host that you want to use to 

store the output of the virtual serial port.

7 If you selected Connect to named pipe, enter a pipe name in the Pipe Name field 

and use the pull‐down menus to choose the near and far ends of the pipe. 
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The options for the near end are client or server. The options for the far end are a 

process or a virtual machine.

By default, the serial port is connected when you power on the virtual machine. 

8 (Optional) You may deselect the Connect at power on check box. 

9 (Optional) Deselect the I/O mode Yield CPU on poll check box if you want to 

configure this serial port to use interrupt mode as opposed to polled mode. 

Polled mode is of interest primarily to developers who are using debugging tools 

that communicate over a serial connection. Polled mode causes the virtual machine 

to consume a disproportionate share of CPU time. This makes the host and other 

guests run sluggishly.

10 (Optional) To maintain best performance for applications on the host, select the 

Yield CPU on poll check box. 

This forces the affected virtual machine to use interrupt mode, which yields CPU 

time if the only task it is trying to do is poll the virtual serial port.

11 Review the information on the Ready to Complete window, and click Finish.

To add a parallel port

1 Start the Add Hardware wizard.

2 Select Parallel Port, and click Next.

3 Select physical parallel port on the host or Output to file.

4 Click Next.

5 If you selected Use physical parallel port on the host, choose the port from the 

pull‐down list. If you selected Output to file, browse to the location of the file.

6 Under Device status, deselect the Connect at power on check box if you do not 

want the parallel port device to be connected when the virtual machine powers on.

7 Click Next.

8 Review the information on the Ready to Complete window, and click Finish.

Adding DVD/CD-ROM or Floppy Devices

Using the VI Client, you can give a virtual machine access to a CD or floppy device from 

the clientʹs machine. This means, for example, that you could install a program in a 

virtual machine running on a remote ESX Server by putting a CD in a drive on a 

desktop or laptop machine. 
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To add a DVD/CD-ROM drive

1 Start the Add Hardware wizard.

2 Select DVD/CD‐ROM Drive, and click Next.

3 Select either Use physical drive or Use ISO image.

a If you selected Use physical drive, select either client or host as the device 

location. Choose the drive you want to use from the pull‐down list.

Select pass through and use the check box to indicate whether to connect 

exclusively to the virtual machine, or select ATAPI emulation.

b If you selected Use ISO Image, enter the path and filename for the image file, 

or click Browse to navigate to the file.

4 If you do not want the CD‐ROM drive connected when the virtual machine starts, 

deselect Connect at power on.

5 Click Next.

6 Specify the virtual device node the drive uses in the virtual machine, and click 

Next.

7 Review the information on the Ready to Complete window, and click Finish or 

Back if you want to change any information.
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To add a floppy drive

1 Start the Add Hardware wizard.

2 Select Floppy Drive, and click Next.

3 Select the type of floppy media to use: 

 A physical floppy drive to give the guest access to the floppy on the host.

 A floppy image, which is a file on the host that stores data in the same format 

as a physical floppy disk.

 A blank floppy image to create and use a blank floppy image.

4 Click Next.

5 If you selected Use a physical floppy drive, select either client or host as the device 

location and choose the drive from the pull‐down list. 

a If you selected Use a floppy image, browse to the floppy image. 

b If you selected Create a blank floppy image, browse to the floppy image.

6 To have the floppy drive connected to the virtual machine when you power it on, 

select Connect at power on.

7 Click Next.

8 Review the information on the Ready to Complete window, and click Finish.
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To add an Ethernet adapter (NIC)

1 Start the Add Hardware wizard.

2 Select Ethernet Adapter, and click Next.

3 In the Network connection panel, choose either a named network with a specified 

label or a legacy network.

4 To connect the virtual NIC when the virtual machine is powered on, select Connect 

at power on.

5 To complete the wizard, click Finish.

To add a hard disk

1 Start the Add Hardware wizard.

2 Select Hard Disk, and click Next.

3 Select the type of storage for the virtual machine’s disk, and click Next.

You can store virtual machine data in a new virtual disk, an existing virtual disk, 

or a Mapped SAN LUN. A virtual disk, which appears as a single hard disk to the 

guest operating system, is composed of one or more files on the host file system. 

Virtual disks can easily be copied or moved on the same host or between hosts.
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4 If you selected Create a new virtual disk, enter the disk capacity and select the 

location as either Store with the virtual machine or Specify a datastore.

5 Browse for the datastore location, and click Next.

6 If you selected an existing disk, browse for the disk file path and click Next.

7 If you chose Mapped SAN LUN:

a Select the LUN that you want to use for the raw disk, and click Next.

b Select a datastore and click Next.

c Select the compatibility mode: physical to allow the guest operating system to 

access the hardware directly or virtual to allow the virtual machine to use 

VMware snapshots and other advanced functions.

8 Click Next.

9 Specify the virtual device node, and click Next.

10 Review the information, and click Finish.

To add a SCSI device

1 Start the Add Hardware wizard.

2 Select SCSI Device, and click Next.

3 Under Connection, use the pull‐down menu to choose the physical device you 

want to use.

4 To connect this virtual machine to the server’s SCSI device when the virtual 

machine is powered on, select Connect at power on.

5 Under Virtual device node, select the virtual device node where you want this 

device to appear in the virtual machine.

You can also select the check box to indicate that the virtual device is set up in the 

same way as the physical unit.

6 Review the information on the Ready to Complete window, and click Finish.
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Now that you have created and configured a virtual machine, you have the option to 

customize the identity and network settings of your virtual machine’s guest operating 

system so that it is ready to begin work immediately in your target environment.

You can save your virtual machine settings in a specification that you can recall later 

and reuse. You do this using the customization wizard. There are two ways to access 

the customization wizard: using the customization specification manager, which lets 

you create specifications and store them in the database for later use, and using the 

wizard when you’re cloning a new virtual machine.

This chapter describes how to use the Customization Specification Manager to 

customize your guest operating systems. 

This chapter contains the following sections:

 “Preparing for Guest Customization (SEE UPDATE)” on page 190

 “Customizing a Windows Guest Operating System” on page 190

 “Using the Customization Specification Wizard” on page 196

 “Using the Clone Virtual Machine Wizard” on page 199

 “Completing a Guest Operating System Customization” on page 200

(SEE UPDATE)

For more details on installing a guest operating system, see the Guest Operating System 

Installation Guide.

Customizing Guest 
Operating Systems 11

NOTE Customizing the guest operating system is an optional step in the cloning process. 
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Preparing for Guest Customization (SEE UPDATE)
When you deploy a new virtual machine from a template or clone an existing virtual 

machine, you have the opportunity to customize the new guest operating system. The 

Guest Customization wizard guides you through the configuration options. 

Before you run the Guest Customization wizard, if you intend to perform a guest 

customization, do the following:

 Verify that your system meets the guest customization requirements. If you plan to 

customize a Windows guest operating system, you must install the components 

required to support a Windows guest operating system customization. This is 

described in Appendix B, “Installing the Microsoft Sysprep Tools,” on page 345. 

 Install the required components on the Windows machine where the VirtualCenter 

server is installed. 

Customizing a Windows Guest Operating System
The customizing process varies, depending upon the guest operating system to be used 

in the new virtual machine. To customize a Windows 2000, Windows XP Professional, 

or Windows Server 2003 guest operating system while deploying a template or cloning 

a virtual machine, perform the following steps.

To customize a Windows guest operating system

You cannot start the Guest Customization wizard from a menu or toolbar option. The 

Guest Customization wizard starts indirectly from the Deploy Template Wizard or 

Clone Virtual Machine Wizard. 

1 Start the Guest Customization wizard.

NOTE After deploying and customizing non‐volume‐licensed versions of Windows XP or 

Windows 2003, you might need to reactivate your Microsoft operating system on 

the new virtual machine.
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2 On the Registration Information page, enter the virtual machine owner’s name 

and organization. Click Next.

This information is for reference purposes. It does not affect how the virtual 

machine functions. In the Name field, you can enter the name of a person, user, or 

group.

3 On the Computer Name page, specify the Computer Name for the virtual 

machine. Click Next. 

The computer name is the name given to the particular instance of a guest 

operating system. The operating system uses this name to identify itself on the 
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network. On Windows systems, it is called the computer name. On most other 

operating systems, it is called the host name. This is not the same as the virtual 

machine name that was declared earlier in the Deploy Template Wizard or Clone 

Virtual Machine Wizard. You can specify the computer name in these ways:

 By assigning a specific name – The name can contain alphanumeric 

characters and the underscore ( _ ) and hyphen (‐) characters. It cannot contain 

periods (.) or blank spaces and cannot be made up of digits only. If you want 

to ensure that the name is unique so that you do not incur conflicts, select 

Append a numeric value to ensure uniqueness.

 By using the virtual machine’s name – The computer name that 

VirtualCenter creates is identical to the name of the virtual machine on which 

the guest operating system is running.

 By responding to prompts for a name – The VI Client populates the Deploy 

Virtual Machine Wizard with a prompt for the computer name after you 

complete all the steps in the wizard.

 By using a custom application to generate a name – The VI Client calls a 

custom application stored on the VirtualCenter Server to generate a name. If 

you select this option, enter the absolute path to the custom application in the 

associated text field.

4 On the Windows License page, specify the Windows license key for the new guest 

operating system. Click Next. 
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If you are customizing a Windows Server operating system, select the appropriate 

license mode, Per seat or Per server. If you select Per server, specify the maximum 

number of simultaneous connections you want the server to accept.

5 On the Administrator Password page, type and confirm the administrator 

password for the virtual machine. Click Next. 

If you leave the password blank, the VI Client asks you to confirm that 

Administrator users aren’t required to provide a password.

If you want to automatically log on as administrator when the virtual machine 

boots, select Automatically log on as the administrator and specify how many 

times automatic logon is to be performed. This is useful if you know you will have 

a series of reboots before the virtual machine is ready for normal logon users.

6 On the Time Zone page, choose the time zone for the virtual machine. Click Next. 

7 On the Run Once page, type any commands you want to run as part of the first 

startup for the new virtual machine. After you type each command, click Add. Use 

the Delete and Move options to create the run order for the commands. When you 

are done with the command list, click Next.

8 If you want VirtualCenter to automatically configure all network interfaces from a 

DHCP server, select Typical settings on the Network page. Click Next.

NOTE If you specify a new administrator password and the source Windows virtual 

machine or template already has one, you must select Delete all user accounts in 

Step 11. Otherwise, the old administrator password does not change.
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9 If VirtualCenter configuration is not appropriate for your environment, select 

Custom settings, select the network interface card (NIC) to customize and click 

Customize to make additional specifications. 

The Network Properties dialog box opens.

Use the Network Properties dialog box to perform these steps:

a On the General tab, select whether you want to use DHCP to obtain an IP 

address automatically or enter the IP addresses manually. Also select whether 

you want to use DHCP to obtain an DNS server address automatically or enter 

the DNS server addresses manually.

b On the DNS tab, specify the DNS connections by entering DNS suffixes. For 

each DNS suffix you enter, click Add. If you are adding multiple DNS 

connections, use Move Up and Move Down to specify the order in which a 

virtual machine is to use the connections. 

c On the WINS tab, specify the primary and secondary WINS addresses by 

typing the IP addresses in the entry boxes. 

d Click OK to return to the previous dialog box. Click Next on the Network 

Guest Customizations dialog box.

10 On the Workgroup or Domain page, complete one of these steps:

 To join a workgroup, select Workgroup, type the workgroup name, and click 

Next.
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 To join a domain, select Windows Server Domain, specify the user name of a 

user who can add computers to the Windows domain, and specify the user’s 

password. Click Next.

11 On the Operating System Options page, select the guest operating system options 

as follows:

 Generate New Security ID (SID) – Generates a new security ID for the virtual 

machine.

 Delete all user accounts – Deletes any old user accounts found on the system. 

If you specified a new administrator password in Step 5 and the source 

Windows virtual machine or template already has one, then you must select 

the Delete all user accounts option here. Otherwise, the old administrator 

password does not changed.

Click Next.

12 (Optional) On the Save Specification page, save the customized options as an 

.xml file by completing these steps:

a Select Save this customization specification for later use.

b Specify the path and filename for the specification, and click Next.

VirtualCenter saves the customized configuration parameters in an .xml file. 
Later, you can import these predefined customized parameters when deploying a 

template or cloning an existing virtual machine. If the customization settings are 

saved to a file, the administrator password of the Windows virtual machine and 

the domain administratorʹs password, as applicable, are stored in encrypted 

format in the .xml file. Saved customization files are unique to each VirtualCenter 

Server and to each version of VirtualCenter due to encryption. You must recreate 

the customization files for each VirtualCenter Server. Encryption is preserved 

between upgrade versions on the same VirtualCenter Server. This means you can 

use the same files between upgrades of VirtualCenter. 

13 Click Finish. 

VirtualCenter closes the Guest Customization wizard and returns you to the 

Deploy Template Wizard or Clone Virtual Machine Wizard. 

14 Click Finish to deploy the virtual machine from the template or create the clone.
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Using the Customization Specification Wizard
The following procedure helps you set up a customization specification that can be 

used later to customize a guest operating system.

To start the Guest Customization wizard

1 Choose Edit > Customization Specifications.

The Customization Specification Manager window appears. From here, you can 

view the properties of a specification and create, edit, copy, delete, import, or 

export specifications. Use the Refresh button to refresh the display.

2 To create a new specification, click the New icon.

The Guest Customization wizard appears.

3 Choose the target virtual machine operating system from the pull‐down menu.

4 Select the check box if you want to use a custom Sysprep answer file.

5 Type a name for the new customization specification and an optional description. 

Click Next.

6 Type the owner’s name and organization to register this copy of the guest 

operating system. Click Next.

The Computer Name page appears. In this page you specify a computer name to 

identify this virtual machine on a network.

7 To specify a name for the computer, select the radio button for one of the following:

 Use a specific name
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With this option, you must type a name in the text field. Select the check box 

if you want to append a numeric value to the specific computer name to 

ensure uniqueness of name.

 Use the Virtual Machine Name

 Prompt the user for a name in the Deploy wizard

 Use a custom application configured with the VirtualCenter server to 

generate a name

With this selection, you supply an argument.

8 Click Next.

The operating system License page appears.

9 In the License page, type the product ID if the virtual machine requires licensing 

information. 

Some virtual machines might not require licensing information. In that case, leave 

these fields blank.

10 Select the check box for Include Server License Information if you are 

customizing a server guest operating system.

11 Select either per seat or per server operating system, enter the maximum 

connections for server license mode, and click Next.

12 On the Administrator Password panel, type a password and confirm it for the 

administrator account.

If you do not enter a password, a warning dialog box appears.

13 Select the check box if you want to automatically log on as the administrator, and 

choose the number of times to log on.

14 Click Next.

15 Use the pull‐down menu to choose a time zone, and click Next.

16 In the Run Once page, specify commands to be run the first time a user logs on. 

Use the navigation buttons to add, delete, and move commands up or down.

17 Click Next.

18 Specify the network interface settings if you want to customize the software 

settings for each network interface. Select the radio button for typical settings to 

enable DHCP for all network interfaces or the radio button for custom settings to 

manually configure each network interface.
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19 Click Next.

20 In the Workgroup or Domain page, select the way in which the virtual machine 

participates in the network, select the radio button for workgroup and enter a 

workgroup name, or select the radio button for Windows server domain and enter 

the domain.

In the latter case, you must also enter a user name and password for a user account 

that has permission to add a computer to the specified domain.

21 Click Next.

22 In the Operating System Options page, select Generate New Security ID (SID) to 

generate a new security identifier or you can delete all user accounts to remove all 

user accounts, including Administrator.

Select the second option if you are changing the Administrator password and the 

template virtual machine has a nonempty Administrator password.

23 Click Next.

24 Review the information you have entered, and click Finish.

The specification appears in the Customization Specification Manager page and 

can be used to customize a guest operating system.

Saved customization files are unique to each VirtualCenter Server and to each 

version of VirtualCenter due to encryption. You have to recreate the customization 

files for each VirtualCenter Server. Encryption is preserved between upgrade 

versions on the same VirtualCenter Server. This means you can use the same files 

between upgrades of VirtualCenter. However, if you uninstall VirtualCenter and 

later do a fresh installation, the ability to decrypt passwords from the earlier 

installation is lost.

25 To view the properties of a specification, click the Properties icon.
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The Customization Specification Properties dialog box appears.

26 Click OK to close the dialog box.

27 Click the Edit icon to redisplay the Guest Customization wizard, and change the 

information for the specification.

28 Click the Copy icon to create a copy of the specification labeled Copy of <spec 

name>, which is displayed in the specification manager.

29 To delete a specification, select it and click the Delete icon.

The specification is deleted from the specification manager.

30 To import an existing specification into the manager, click the Import icon and 

select the specification in the Browse dialog box.

31 To export a specification, click the Export icon and choose a Save As location.

32 Use the maximize, minimize, and close buttons to maximize, minimize, or exit the 

specification manager.

Using the Clone Virtual Machine Wizard
You have a second opportunity to access the Guest Customization wizard at the end of 

the deployment wizard. Here, you have the ability to load a saved customization 

specification. You can choose to get the specification from the local disk or from the 

server. If you choose not to load a saved specification, the wizard opens with blank 

fields.

Use the following procedure when you are setting up your new virtual machine. You 

use the specification that you set up in the previous section as you set up a virtual 

machine in the following procedure.
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For more information on using the customization wizard, see “Customizing a 

Windows Guest Operating System” on page 190.

To load a saved customization specification using the Clone Virtual Machine 
wizard

1 Choose Inventory > Virtual Machine > Clone.

The Clone Virtual Machine wizard appears.

2 Move through the wizard until you reach the Select Guest Customization Option 

page from which you can customize using the Customization wizard or customize 

using an existing customization specification selected from the specification 

manager’s list.

Completing a Guest Operating System Customization
The final customization steps occur when the new virtual machine boots for the first 

time. As part of this process, the machine might reboot a number of times. The 

customization process does not complete until the guest operating system boots, runs 

the finalization scripts, and reaches the logon page. 

If the new virtual machine encounters customization errors while it is booting, the 

errors are reported using the guest’s system logging mechanism. In Linux, these errors 

are logged to /var/log/vmware/customization.log. In Windows, they are written 

to the application event log. 

The steps required to finalize guest operating system customization are covered in the 

following sections:

 “Completing Linux Guest Operating System Customization” on page 200

 “Completing Windows Guest Operating System Customization” on page 201

Completing Linux Guest Operating System Customization
A customized Linux virtual machine does not need any additional rebooting and is 

operational as soon as the logon page appears after the first boot. If configuration errors 

occur, they are displayed on the virtual machine’s console window while the guest 

operating system is booting.
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Completing Windows Guest Operating System Customization
When a customized virtual machine is powered on for the first time, its guest operating 

system runs a set of scripts that finalizes the customization and configuration process. 

Depending on the guest operating system type, this process might require additional 

rebooting, which is automatically performed by the scripts.

The customization process installs scripts that run once in the target virtual machine 

when it powers on or boots for the first time after being created or cloned. Those scripts 

complete the customization process by performing final configuration operations on 

the guest operating system.

After powering on for the first time, a customized Windows virtual machine 

automatically reboots twice to finalize the configuration process. It becomes 

operational when the logon page appears after the second reboot. This process can take 

several minutes, depending on the speed and load of the host. If any errors occur 

during the final configuration process, events are logged to the guest operating 

system’s event database. To view these errors, choose Start > Program > Administrative 

Tools > Event Viewer from the Windows Start menu.

If any of the information required in the configuration finalization process is not 

correct, the guest operating system pauses when the new virtual machine boots and 

waits for you to enter the correct information. Incorrect information might include:

 The computer name is not unique. The computer name must be unique for the 

network on which the machine is deployed. 

 The product key is incorrect.

 The user specified to join a domain that does not exist.

 The DHCP server for the network is not functioning properly.

To determine if the system is waiting for information

Open the virtual machine’s console to see if the system is waiting for information. 
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This chapter describes creating templates and cloning virtual machines. 

This chapter contains the following sections:

 “Understanding Templates” on page 203

 “Creating Templates” on page 204

 “Editing a Template” on page 208

 “Deploying Virtual Machines from Templates” on page 209

 “Deleting a Template” on page 212

 “Regaining Templates” on page 213

 “Creating a Scheduled Task to Clone a Virtual Machine” on page 218

Understanding Templates
A template is a golden image of a virtual machine that can be used as a master copy to 

create and provision new virtual machines. This image typically includes a specified 

operating system and configuration that provides virtual counterparts to hardware 

components. Typically, a template includes an installed guest operating system and a 

set of applications. 

Templates coexist with virtual machines at any level within the template and virtual 

machine domain. You can order collections of virtual machines and templates into 

arbitrary folders and apply a variety of permissions to both virtual machines and 

templates. Virtual machines can be transformed into templates without requiring a full 

copy of the virtual machine files and the creation of a new object.

Working with Templates and 
Clones 12
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You can use templates to create new virtual machines by deploying the template as a 

virtual machine. When complete, the deployed virtual machine is added to the folder 

chosen by the user when the template was created.

To view templates, select the datacenter and select the Virtual Machines tab. All virtual 

machines and templates for the datacenter are visible from here. Virtual machines and 

templates have different icons.

Creating Templates
There are three ways to create a template: 

 Using an existing virtual machine in place. This process converts the original 

virtual machine.

 Cloning a virtual machine to a template.

 Cloning an existing template.

To create a template in place from a virtual machine

1 Start the VI Client and log on to the VirtualCenter Server.

2 Click the Inventory button in the navigation bar. 

virtual machine icon template icon
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The inventory panel and the information panel display information about 

managed datacenters, hosts, resource pools, and virtual machines. The inventory 

toolbar appears.

3 Expand the inventory as needed, and select a virtual machine. 

4 Power off the virtual machine.

5 From the Commands area or the pop‐up menu, click Convert to Template.

VirtualCenter marks that virtual machine as a template and displays the task in the 

Recent Tasks pane.

To clone a virtual machine to a template

1 Start the VI client, and log on to the VirtualCenter Server.

2 Click Inventory in the navigation bar to display the inventory panel.

3 If the virtual machine you want to clone is powered on, right‐click it and click 

Power Off.

4 Right‐click the virtual machine and click Clone to Template.
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The Clone Virtual Machine to Template wizard appears.

5 Give the new template a name and description, and click Next.

Enter a useful name that describes the template. Description information can 

include, for example, the operating system, applications, versions, and intended 

uses for the template. The name can be up to 80 characters long and can contain 

alphanumeric characters and the underscore ( _ ) and hyphen (‐) characters. It 

should also be unique across all templates and virtual machines in the datacenter.

6 Pass through the target location page. Click Next.

7 Click Finish.

VirtualCenter displays the Tasks inventory panel for reference and adds the cloned 

template to the list in the information panel. 

To clone an existing template

1 Start the VI client, and log on to the VirtualCenter Server.

2 Click the Inventory button in the navigation bar. 

3 Select the datacenter that contains the template.

The virtual machines and templates associated with the datacenter appear in the 

datacenter panel.

4 Right‐click the template and choose Clone.
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The Clone Template wizard appears.

5 Give the new template a name and description, and click Next.

Enter a useful name and a brief description of the template. Description 

information can include, for example, the operating system, applications, versions, 

and intended uses for the template. The name can be up to 80 characters long, and 

can contain alphanumeric characters and the underscore 

( _ ) and hyphen (‐) characters. It should also be unique across all templates and 

virtual machines in the datacenter. 

6 Select the host or cluster, and click Next.

7 Choose a datastore for the template. Click Next.
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8 Select a radio button to either leave the virtual disks in their Normal virtual 

machine format or to Compact the virtual disks to minimize storage. Click Next.

9 On the Ready to Complete window, review the information for your new virtual 

machine, and click Finish.

You cannot use the new template until the cloning task completes. VirtualCenter 

adds the cloned template to the list in the Virtual Machines tab. 

Editing a Template
You might want to edit your template (to upgrade an application, for example). 

However, templates cannot be edited as templates. You must convert the template to a 

virtual machine, edit it, and convert the edited virtual machine to a template.

To edit the template

1 If you want to edit the properties of a template, convert the template to a virtual 

machine.

2 Edit the virtual machine.

3 Convert the virtual machine to a template.

You can directly change the name of a template using the procedure below.
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To change the name of a template

1 From the VirtualCenter client, click the Inventory button.

2 Select the datacenter that contains the template.

3 Select the Virtual Machines tab.

4 Click on the template. Click the template again. 

5 The name of the virtual machine is now an editable field. 

6 Change the name, and click outside the field.

Deploying Virtual Machines from Templates
This procedure deploys a virtual machine from an existing template. 

To deploy a virtual machine from a template

1 Start the VI Client, and log on to the VirtualCenter Server.

2 Click the Inventory button in the navigation bar. 

The inventory panel and the information panel display information about 

managed datacenters, hosts, resource pools, and virtual machines. The inventory 

toolbar appears.

3 Select the datacenter that contains the template, and click the Virtual Machines 

tab.

The virtual machines and templates associated with the datacenter appear in the 

datacenter panel.

4 Right‐click the template, and choose Deploy Virtual Machine from this 

Template.
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The Deploy Template wizard appears.

5 Give the new virtual machine a name, select a location, and click Next.

The name can be up to 80 characters long and can contain alphanumeric characters 

and the underscore ( _ ) and hyphen (‐) characters. It should also be unique across 

all templates and virtual machines in the datacenter. 

6 On the Host / Cluster page, select the host on which you want to store the template 

and click Next.

7 Select a resource pool (if applicable) in which you want to run the virtual machine, 

and click Next.

Resource pools allow hierarchical management of resources within a host or 

cluster. Virtual machines and child pools share the resources of their parent pool.

8 Choose a datastore for the virtual machine, and click Next.

You are choosing the datastore in which to store the files for the virtual machine. 

You should choose one that is large enough to accommodate the virtual machine 

and all of its virtual disk files so that they can all reside in the same place.

The Advanced button allows you to store individual files in separate locations. To 

return to the datastore selection page, click the Basic button.

9 On the Select Guest Customization Option page, perform one of these actions:

 If you do not want to customize your guest operating system, select Do not 

customize and click Next.

 If you want to customize your guest operating system, click one of the other 

selections as appropriate. You customize guest operating systems through the 

Guest Customization Wizard or by using an existing customization 
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specification that you create. For instructions, see “Customizing Guest 

Operating Systems” on page 189.

The VI Client might display error messages on this page of the wizard if the guest 

is not customizable.

10 On the Ready to Complete window, review the information for your new virtual 

machine, select the Power on the new Virtual Machine after creation check box if 

you want to power on the virtual machine immediately, and click Finish.

After you click Finish, you cannot use or edit the virtual machine until the task 

completes. This might take several minutes. The virtual machine is added to the 

datastore. 

To convert a template to a virtual machine

1 Start VirtualCenter client, and log on to the VirtualCenter Server.

2 Click the Inventory button in the navigation bar. 

The inventory panel and the information panel display information about 

managed datacenters, hosts, resource pools, and virtual machines. The inventory 

toolbar appears.

3 Select the datacenter that contains the template.

The virtual machines and templates associated with the datacenter appear in the 

datacenter panel.

4 Click the Virtual Machines tab.
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5 From the pop‐up menu, choose Convert to Virtual Machine.

The template is converted to a virtual machine.

Deleting a Template
This procedure unregisters and deletes the template. 

To delete an existing template

1 Click the Inventory button.

2 Select the appropriate template.

3 Right‐click the template, and choose Remove from Inventory.

4 Confirm removing the template from the VirtualCenter database. Click OK.
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All non‐datastore template files are removed from the VirtualCenter inventory.

To delete a template from disk

1 Start VirtualCenter client, and log on to the VirtualCenter Server.

2 Click the Inventory button in the navigation bar, and select the host that contains 

the template.

3 Right‐click the datastore that contains the template and select Browse Datastore. 

4 Browse through the datastore folders to find the .vmtx file.

5 Right‐click the .vmtx file and select Delete from Disk.

The template is deleted from the disk and cannot be recovered. 

Regaining Templates
Templates are associated with hosts, and the only way to regain or register templates 

after removing and adding a host is to use the datastore browser to locate the template. 

Then use the inventory wizard to name and register the .vmtx file as a template back 

into VirtualCenter. 

To regain a template:

1 Start VirtualCenter client, and log on to the VirtualCenter Server.

2 Click the Inventory button in the navigation bar, and select the host that contains 

the template.

3 Right‐click the datastore that contains the template and select Browse Datastore. 

4 Browse through the datastore folders to find the .vmtx file.

CAUTION After a template is deleted from a host, there is no way to recover it. 



Basic System Administration

214 VMware, Inc. 

5 Right‐click the .vmtx file and select Add to Inventory.

The Add to Inventory wizard appears.

6 Enter a template machine name, select a location, and click Next.

Select a host or cluster on which to store the template, and click Next.

7 Review your selections, and click Finish.
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8 The template is registered to the host and can be viewed from the host’s Virtual 

Machine tab.

Cloning an Existing Virtual Machine
A clone is a copy plus customization of a virtual machine. When you create a clone, 

VirtualCenter provides an option to customize the guest operating system of that 

virtual machine. You can place the new clone on any host within the same datacenter 

as the original virtual machine. 

To clone a virtual machine

1 Start VirtualCenter and log on to the VirtualCenter Server.

2 From the inventory panel, click the Inventory button in the navigation bar. 

The inventory panel and the information panel display the datastores, resource 

pools, hosts, and virtual machine information. The inventory toolbar appears.

3 Expand the inventory as needed, and click the source virtual machine.

4 Power off the virtual machine.

5 To start the Clone a Virtual Machine wizard, click the Clone to New Virtual 

Machine link in the Commands area, or choose Clone from the pop‐up menu.
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The Clone Virtual Machine wizard appears.

6 Enter a virtual machine name, select a location, and click Next.

7 Select a host or cluster on which to run the clone, and click Next.
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8 If you choose a cluster, you must choose a specific host within the cluster, and click 

Next.

9 Select a resource pool in which to run the clone, and click Next.

10 Select the datastore location where you want to store the virtual machine files, and 

click Next.
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11 Click the Advanced button for more options, and click Next.

The Select Guest Customization Option page appears. You can choose to 

customize the guest operating system using the wizard or using an existing 

customization specification. You can also choose not to customize.

For more information, see “Customizing Guest Operating Systems” on page 189.

12 Select the appropriate radio button, and click Next.

13 Review your selections, and click Finish.

On the Ready to Complete New Virtual Machine page, you can select the checkbox 

to power on the new virtual machine after creation. After you click Finish, you 

cannot use or edit the virtual machine until the task completes. If the task involves 

the creation of a virtual disk, it could take several minutes to complete.

Creating a Scheduled Task to Clone a Virtual Machine
This procedure creates a scheduled task to clone a virtual machine. 

To create a scheduled task to clone a virtual machine

1 Click the Scheduled Tasks button in the navigation bar.

The list of scheduled tasks appears.

2 Choose File > New > Scheduled Task, or click the New button.

The Select a Task to Schedule dialog box appears.

3 Use the pull‐down menu to choose Clone a virtual machine, and click OK.

The Clone Virtual Machine wizard appears.
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4 Select the virtual machine to clone, and click Next.

5 Follow the wizard through the same steps as those in the previous task in which 

you cloned a virtual machine. The page after Guest Customization is the Schedule 

the Task page.

6 Enter a name and a task description in the text box.

7 Select the radio button for the frequency of the task.

8 Select the radio button for Now or Later. If later, enter the time and date when you 

want the virtual machine to be deployed, and click Next.

To see the calendar, click Later, and click the drop‐down arrow to select a date from 

the displayed calendar. A red circle indicates today’s date, and a dark circle 

indicates the scheduled date. 

9 Review the information on the Ready to Complete New Virtual Machine page, 

and click Finish. 

Optionally, you can select the check box to power on the new virtual machine after 

it is created.

VirtualCenter adds the new task to the scheduled task list and completes it at the 

designated time. When it is time to perform the task, VirtualCenter first verifies 

that the user who created the task still has permission to complete the task. If the 

permission levels are not acceptable, VirtualCenter sends a message to the log and 

the task is not performed.
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VMware VirtualCenter snapshots allow you to preserve the state of the virtual machine 

so you can return to the same state repeatedly. Snapshots are a new feature for ESX 

Server 3.

The following sections are included in this chapter:

 “Understanding Snapshots” on page 221

 “Using the Snapshot Manager” on page 226

 “Restoring a Snapshot” on page 227

Understanding Snapshots 
A snapshot captures the entire state of the virtual machine at the time you take the 

snapshot. This includes:

 Memory state – The contents of the virtual machine’s memory.

 Settings state – The virtual machine settings.

 Disk state – The state of all the virtual machine’s virtual disks.

Snapshots operate on individual virtual machines. In a team of virtual machines, taking 

a snapshot preserves the state of only the active virtual machine. 

When you revert to a snapshot, you return all these items to the state they were in at the 

time you took that snapshot. If you want the virtual machine to be suspended, powered 

on, or powered off when you launch it, be sure it is in the desired state when you take 

that snapshot.

Using Snapshots 13
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Snapshots are useful when you need to revert repeatedly to the same state but you don’t 

want to create multiple virtual machines. With snapshots, you create backup and 

restore positions in a linear process. You can also preserve a baseline before diverging 

a virtual machine in a process tree.

Snapshots can be used as restoration points during a linear or iterative process, such as 

installing update packages, or during a branching process, such as installing different 

versions of a program. Taking snapshots ensures that each installation begins from an 

identical baseline.

Multiple snapshots refers to the ability to create more than one snapshot of the same 

virtual machine. To take snapshots of multiple virtual machines, (for example, 

snapshots for all members of a team) requires that you take a separate snapshot of each 

team member.

Multiple snapshots are not simply a new way of saving your virtual machines. With 

multiple snapshots, you can save many positions to accommodate many kinds of work 

processes.

Although you can take snapshots up to 32 levels, the amount of time it takes to commit 

or delete those snapshots increases as the levels get deeper. The required time is directly 

proportional to the amount of data (committed or deleted) and the virtual machine’s 

RAM size.

Relationship Between Snapshots
The relationship between snapshots is like that of a parent to a child:

 In the linear process, each snapshot has one parent and one child, except for the 

last snapshot, which has no children.

 In the process tree, each snapshot has one parent, but one snapshot may have 

more than one child. Many snapshots have no children.

You can revert to a parent or a child.

NOTE Snapshots of raw disks, RDM physical mode disks, or independent disks are not 

supported.
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Snapshots and Other Activity in the Virtual Machine
When you take a snapshot, be aware of other activity going on in the virtual machine 

and the likely effect of reverting to that snapshot. In general, it is best to take a snapshot 

when no applications in the virtual machine are communicating with other computers. 

The potential for problems is greatest if the virtual machine is communicating with 

another computer, especially in a production environment.

For example, if you take a snapshot while the virtual machine is downloading a file 

from a server on the network, the virtual machine continues downloading the file, 

communicating its progress to the server. If you revert to the snapshot, communications 

between the virtual machine and the server are confused and the file transfer fails. 

Another example is taking a snapshot while an application in the virtual machine is 

sending a transaction to a database on a separate machine. If you revert to that 

snapshot—especially if you revert after the transaction starts but before it has been 

committed—the database is likely to be confused.

Taking a Snapshot
Taking a snapshot is a synchronous operation. All user operations to the virtual 

machine during this period are blocked for snapshot and data consistency. The time 

taken to develop a snapshot depends on the amount of data and the load on the server. 

On average, the time ranges from 30 to 40 seconds for minimal snapshot creation.

You can take a snapshot while a virtual machine is powered on, powered off, or 

suspended. If you are suspending a virtual machine, wait until the suspend operation 

has finished before taking a snapshot.

You must power off the virtual machine before taking a snapshot if the virtual machine 

has multiple disks in different disk modes. For example, if you have a special purpose 

configuration that requires you to use an independent disk, you must power off the 

virtual machine before taking a snapshot.

To take a snapshot

1 Choose Inventory > Virtual Machine > Snapshot > Take Snapshot.

You can also click the Take a snapshot of this virtual machine button, or right‐click 

the virtual machine and choose Snapshot > Take Snapshot.
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The Take Virtual Machine Snapshot window appears.

2 Type a name for your snapshot.

3 (Optional) Type a description for your snapshot.

Descriptions are useful to identify differences between similarly named snapshots. 

Descriptions appear in the Snapshot Manager.

4 Click OK.

A progress pop‐up menu box appears. When the snapshot has been successfully 

taken, it is listed in the Recent Tasks field at the bottom of VirtualCenter.

5 Click the target virtual machine to display tasks and events for this machine or, 

while the virtual machine is still selected, click the Tasks & Events tab.
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Changing Disk Mode to Exclude Virtual Disks from Snapshots
You must power off and delete any existing snapshots before you attempt to change the 

disk mode. Deleting a snapshot involves committing the existing data on the snapshot 

disk to the parent disk.

To exclude a disk from a snapshot

1 Choose Inventory > Virtual Machine > Edit Settings.

2 Click the Hardware tab, and select the hard disk you want to exclude.

3 Under Mode, select Independent. Independent disks are not affected by 

snapshots.

You have the following persistence options for an independent disk:

 Persistent – Changes are immediately and permanently written to the disk. 

All changes to an independent disk in persistent mode remain, even when you 

revert to that snapshot.

 Nonpersistent – Changes to the disk are discarded when you power off or 

revert to that snapshot.

4 Click OK.
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Using the Snapshot Manager
The Snapshot Manager lets you review all snapshots for the active virtual machine and 

act on them directly. 

The Snapshot Manager window contains the following areas: Snapshot tree, Details 

region, Command buttons, Navigation region, and a You are here icon.

Figure 13-1.  Snapshot Manager

 Snapshot tree – Displays all snapshots for the virtual machine.

 You are here icon – Represents the current operational state of the virtual machine. 

The You are here icon is always selected and visible when you open the Snapshot 

Manager. 

The You are here icon represents a state that is never a snapshot itself but rather 

the virtual machine state after the parent snapshot. A snapshot is always a static 

record of a virtual machine state. The You are here state can be operational and 

changing. Even when you create a snapshot of a powered off or suspended virtual 

machine, the You are here state is not identical to the snapshot.

You cannot go to or select the You are here state. You are here always represents 

the current and active state.

 Command Buttons – The Snapshot Manager has three command buttons in the left 

pane: Go to, Delete, and Delete All.
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 Details – Displays the name and description of the selected snapshot. These fields 

are blank if you have not selected a snapshot.

 Navigation Region – Contains buttons for navigating out of the dialog box:

 Close – Closes the Snapshot Manager.

 Help – Opens the help system.

To use the Snapshot Manager

1 Choose Inventory > Virtual Machine > Snapshot > Snapshot Manager. 

2 In the Snapshot Manager, select a snapshot by clicking it. 

3 To go to a snapshot, click the Go to button to restore the virtual machine to any 

arbitrary snapshot.

The Go to command allows you to restore the state of any snapshot.

4 Click Yes in the confirmation dialog box.

5 To delete a snapshot, click the Delete button to permanently remove a snapshot 

from VirtualCenter use. 

6 Click Yes in the confirmation dialog box.

7 To delete all snapshots, click the Delete All button to permanently remove all 

snapshots from VirtualCenter use.

8 Click Yes in the confirmation dialog box.

9 Click Close to exit the Snapshot Manager.

Restoring a Snapshot
VMware VirtualCenter includes the following snapshot methods to allow you to return 

to the original virtual machine:

 The Inventory > Virtual Machine > Snapshot menu contains the command Revert 

to Snapshot.

 The Snapshot Manager has a Go to button.

NOTE Delete commits the snapshot data to the parent and then removes the selected 

snapshot. Delete All commits all the immediate snapshots before the You are here 

current state to the base disk and removes all existing snapshots for that virtual 

machine.
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Parent Snapshot
To discern between the Revert to Snapshot and Go to commands, you must 

understand what is meant by the parent snapshot.

The parent snapshot is the most recently saved version of the current state of the virtual 

machine. If you have just taken a snapshot, that stored state is the parent snapshot of 

the current state. If you revert or go to a snapshot, that snapshot becomes the parent of 

the current state.

The parent snapshot is always the snapshot appearing immediately above the You are 

here icon in the Snapshot Manager.

Figure 13-2.  Parent Snapshot

Parent Snapshot

NOTE The parent snapshot is not always the snapshot you took most recently. For example, if 

you take a snapshot today and then Go to a snapshot you took yesterday, the snapshot 

you took today is no longer the parent of the current state of the virtual machine. The 

parent snapshot has become the snapshot you took yesterday.
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Revert to Snapshot Command

Revert to Snapshot is essentially a shortcut to the parent snapshot of You are here. This 

command immediately activates the parent snapshot of the current state of the virtual 

machine. 

The current disk and memory states are discarded and restored as they were when you 

took that snapshot. If your parent snapshot was taken when the virtual machine was 

powered off, choosing Snapshot > Revert to Snapshot moves the powered‐on virtual 

machine to that parent state, that is, to a powered‐off state.

Figure 13-3.  Revert to Snapshot

take a 
snapshot

Virtual machine with no snapshots.

take a 
snapshot

go to
snapshot_a

The new snapshot (snapshot_a)
is now the parent of the
You are here state. The parent
snapshot of the You are here state
is the parent snapshot of the 
virtual machine.

When you take a snapshot from
the snapshot_a state, snapshot_a
becomes the parent of the new
shapshot (snapshot_b) and 
snapshot_b is the parent shapshot
of the You are here state.
If you take a snapshot now, the 
new snapshot will be based on 
the snapshot_b state.

When you revert a virtual machine, the virtual machine returns to the parent snapshot
of the virtual machine (that is, the parent of the current You are here state).

When you go to snapshot_a,
snapshot_a becomes the parent
of the You are here state.
If you take a snapshot now, the
new snapshot will be based on
the snapshot_a state.
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There are three ways to revert to the parent snapshot:

 Choose Inventory > Virtual Machine > Snapshot > Revert to Snapshot.

 Click the Revert to snapshot button on the toolbar.

 Right‐click the virtual machine, and choose Snapshot > Revert to Snapshot.
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This chapter describes the process of migrating—moving a virtual machine from one 

host to another. This chapter contains the following sections:

 “Overview” on page 231

 “Migration” on page 233

 “Migration with VMotion” on page 233

 “Migration Wizard” on page 239

The user initiating the migration must have appropriate permission to perform 

migration with VMotion on both machines.

Refer to “Managing Users, Groups, Permissions, and Roles” on page 247 for 

information on permissions.

Overview
In this release, you can migrate a virtual machine on an ESX Server host in a suspended 

state using the migration API. Migrating a powered‐off virtual machine is called 

migration. Migrating a powered‐on virtual machine is called migration with VMotion. 

Migration with VMotion, designed to be used between compatible systems, allows you 

to migrate virtual machines with no downtime but requires VMotion licensing and 

specific configuration. 

In VirtualCenter 2, you have two migration options:

Migrating Virtual Machines 14

NOTE Copying a virtual machine is creating a new virtual machine. It is not a form of 

migration.
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 Migration – Moving a powered‐off or suspended virtual machine (configuration 

files but no disk movement). Optionally, during migration, you can relocate 

configuration and disk files.

 Migration with VMotion – Moving a virtual machine that is powered on.

Virtual machines can be moved between hosts within the same datacenter. Virtual 

machines cannot be moved between datacenters. 

The following table lists the VMotion capabilities for 32‐ and 64‐bit guest virtual 

machines.

NOTE Migrating suspended virtual machines is supported in ESX Server 3.0 only. Virtual 

machines created using ESX Server 2.x must be powered off before migration.

NOTE Virtual machines do not need to be available on shared storage.

NOTE Virtual machines must be available any from any form of shared storage, such as 

SAN, iSCSI, or NAS.

Table 14-1.  VMotion Support

32-bit Guest Virtual Machines 64-bit Guest Virtual Machines 

VMotion 
(powered on) 

Fully supported within 
VMotion‐compatible 32‐bit CPUs 
AND 64‐bit CPUs (Intel‐to‐Intel or 
AMD‐to‐AMD).

Fully supported within 
VMotion‐compatible 64‐bit CPUs 
(Intel‐to‐Intel or AMD‐to‐AMD). 

Cold 
Migration 
(powered off)

Fully supported within supported 
32‐bit CPUs and 64‐bit CPUs and 
able to power on irrespective of any 
CPU incompatibilities 
(Intel‐to‐AMD OK).

Fully supported within 
VMotion‐compatible 64‐bit CPUs 
(Intel‐to‐AMD OK). 

NOTE Migration with VMotion cannot be used to migrate virtual machines using raw disks 

for clustering purposes. 
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Migration
The virtual machine you want to migrate must be powered off or suspended prior to 

beginning the migration process. With a migration, you also have the option of moving 

the associated disks from one host to another. A migration consists of the following 

steps:

1 The configuration files, including the NVRAM file (BIOS settings), log files, and 

the suspend file for suspended virtual machines as well as the disks of the virtual 

machine are moved from the source host to the destination host’s associated 

storage area.

2 The virtual machine is associated (registered) with the new host.

3 After the migration is completed, the old version of the virtual machine is deleted 

from the source host.

If any error occurs during migration, the virtual machines revert to their original states 

and locations.

You can move virtual machines manually or set up a scheduled task to perform the 

migration. Refer to “Managing Tasks, Events, and Alarms” on page 289 for information 

on scheduling tasks.

Migration with VMotion
VMotion allows working processes to continue throughout a migration with VMotion. 

The entire state of the virtual machine as well as its configuration file, if necessary, are 

moved to the new host even while the data storage remains in the same location on the 

SAN. The associated virtual disk remains in the same location on the SAN storage that 

is shared between the two hosts. Once the configuration file is migrated to the alternate 

host, the virtual machine runs on the new host.

The state information includes the current memory content and all the information that 

defines and identifies the virtual machine. The memory content includes transaction 

data and whatever bits of the operating system and applications are in the memory. The 

defining and identification information stored in the state includes all the data that 

maps to the virtual machine hardware elements, such as BIOS, devices, CPU, MAC 

addresses for the Ethernet cards, chip set states, registers, and so forth.

Migration with VMotion happens in three stages:

1 When the migration with VMotion is requested, VirtualCenter verifies that the 

existing virtual machine is in a stable state with its current host. 

2 The virtual machine state information (that is, memory, registers, and network 

connections) is copied to the target host.
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3 The virtual machine resumes its activities on the new host.

If any error occurs during migration, the virtual machines revert to their original states 

and locations.

VMotion Requirements
To be configured for VMotion, each host in the cluster must meet the following 

requirements.

Shared Storage

Ensure that the managed hosts use shared storage. Shared storage is typically on a 

storage area network (SAN), but can also be implemented using iSCSI and NAS shared 

storage. See the VMware SAN Configuration Guide for additional information on SAN 

and the Server Configuration Guide for information on other shared storage.

Shared VMFS Volume or NAS Storage

Configure all managed hosts to use shared VMFS volumes or to be located on NAS 

storage. If using shared VMFS volumes:

 Place the disks of all virtual machines on VMFS volumes that are accessible by both 

source and target hosts. 

 Ensure that the VMFS volume is sufficiently large to store all virtual disks for your 

virtual machines. 

CPU Compatibility

Make sure that the source and destination hosts have a compatible set of processors.

VMotion transfers the running architectural state of a virtual machine between 

underlying VMware ESX Server systems. VMotion compatibility requires that the 

processors of the target host be able to resume execution using the equivalent 

instructions that the processors of the source host were using when suspended. 

Processor clock speeds and cache sizes, and the number of processor cores may vary, 

but processors must come from the same vendor class (Intel or AMD) and same 

processor family (P3, P4, or Intel core) to be compatible for migration with VMotion.

Processor families such as Intel Xeon and AMD Opteron are defined by the processor 

vendors.

You can distinguish different processor versions within the same family by comparing 

the processors’ model, stepping level, and extended features:

 In most cases, different processor versions within the same family are similar 

enough to maintain compatibility.



VMware, Inc. 235

Chapter 14 Migrating Virtual Machines

 

 In some cases, processor vendors have introduced significant architectural 

changes within the same processor family, such as the SSE3 and SSE4 instructions, 

and Nx/XD CPU security features. By default, VMware identifies mismatches on 

SSE3, SSE4, and Nx/XD as incompatible to guarantee the stability of virtual 

machines after migrations with VMotion.

Server hardware’s CPU specifications will usually indicate whether or not the CPUs 

contain the SSE3, SSE4, and Nx/XD features that affect VMotion compatibility. If the 

specifications of a server or its CPU features are unknown, VMware’s bootable CPU 

identification utility (available for download with ESX Server) can be used to boot a 

server and determine whether it’s CPUs contain features such as SSE3, SSE4, and 

NX/XD.

Nx/XD Considerations

 AMD’s No eXecute (NX) and Intel’s eXecute Disable (XD) technology serve the 

same security purpose: to mark memory pages as data only to prevent malicious 

software exploits and buffer overflow attacks.

 The following operating systems support NX and XD: 

Windows Server 2003 (SP1), Windows* XP (SP2), Windows Vista, RHEL4, RHEL 3 

(Update 3), SUSE 10, SUSE Linux 9.2, Solaris 10, Linux kernels 2.6.6 or later (or 2.4 

kernels with a patch).

 In ESX Server 3.0, NX and XD technology is exposed by default for all guest 

operating systems that can use it (trading off some compatibility for security by 

default). Hosts previously compatible in ESX Server 2.x may become incompatible 

after upgrading to ESX Server 3.0 if NX mismatched, but per‐VM CPU 

compatibility masks specified in the VMotion CPU Compatibility Matrix can be 

used to restore compatibility.

SSE3 Considerations

 Within the Intel P4 and AMD Opteron processor families, VMware places a 

restriction between processors that do support the SSE3 instructions and 

processors that do not support the SSE3 instructions because they are application 

level instructions that bypass the virtualization layer, and could cause application 

instability if mismatched after a migration with VMotion.

NOTE VMware, in partnership with CPU and hardware vendors, is working to maintain 

VMotion compatibility across the widest range of processors. For additional 

information, check the VMware Knowledge Base.
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SSE4 Considerations

 Within the Intel P4 and Intel Core processor families, VMware places a restriction 

between processors that do support the SSE4 instructions and processors that do 

not support the SSE4 instructions because they are application level instructions 

that bypass the virtualization layer, and could cause application instability if 

mismatched after a migration with VMotion.

Networking Requirements

1 VMotion requires a Gigabit Ethernet network to ensure rapid migration:

 A dedicated network is recommended to keep virtual machine memory state 

secure.

 VMotion requires a private Gigabit Ethernet migration network between all of 

the VMotion‐enabled managed hosts. When VMotion is enabled on a 

managed host, configure a unique network identity object for the managed 

host and connect it to the private migration network.

 Two hosts with cross‐connected GigE cards can be used for demo purposes.

2 Virtual machines must have access to the same subnets on the source and 

destination ESX Server hosts.

3 Network labels for each virtual NIC must be created through the ESX Server 

configuration settings:

 Network labels are global across datacenters.

 VMotion automatically maps virtual machines to appropriate virtual NICs 

based on network labels.

 For ESX Server 2.x hosts, network labels can be configured through the 

Web‐based VMware Management Interface.

Minimum Network Requirements

 Two NICs with at least one GigE NIC dedicated to VMotion.

 For best security, dedicate the GigE NIC to VMotion and use VLANs to divide the 

Virtual machine and management traffic on the other NIC.

NOTE VMware is working on maintaining VMotion compatibility across the widest range of 

processors through partnerships with processor and hardware vendors. For additional 

information, check the VMware Knowledge Base.
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 For best availability, combine both NICs into a bond, and use VLANS to divide 

traffic into at least three networks (One or more for virtual machines, one for the 

service console, and one for VMotion).

Network Best Practices

 One dedicated NIC for the service console (10/100 or GigE).

 One dedicated NIC for VMotion (GigE).

 One or more NICs for virtual machines (10/100 or GigE).

VMotion Compatibility
VMotion compatibility requires that both source and destination hosts match in certain 

criteria. Possible destination hosts include hosts and fully automated DRS clusters. A 

nonautomated cluster can also be selected as a destination.

When you select a host, the Compatibility panel at the bottom of the Migration wizard 

displays information about the compatibility of the selected host or cluster with the 

virtual machine’s configuration. 

If the virtual machine is compatible, the panel is blank. If the virtual machine is not 

compatible with either the host’s or cluster’s configured networks or datastores, the 

compatibility window can display both warnings and errors:

 Warning messages do not disable migration. Often the migration is justified and 

you can continue with the migration despite the warnings.

Warning messagesCompatibility panel
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 Errors can disable migration if there are no error‐free destination hosts among the 

selected destination hosts. In this case, the Next button is disabled. 

For clusters, the network and datastore configurations are taken into account when 

checking compatibility issues. For hosts, the individual host’s configuration is used. A 

possible problem might be that VMotion is not enabled on one or both hosts. 

A specific host feature’s effects on compatibility are dependent on whether or not ESX 

Server exposes or hides them from virtual machines:

 Features that are exposed to virtual machines are not compatible when they are 

mismatched.

 Features that are not exposed to virtual machines are compatible regardless of 

mismatches.

CPU Compatibility Masks
VirtualCenter compares the CPU features of two hosts to determine whether to allow 

or disallow migrations with VMotion. A new capability in VirtualCenter 2.0 called CPU 

compatibility masks allows per‐virtual machine, advanced customization of the CPU 

features that a virtual machine should require for CPU compatibility during a 

migration with VMotion.

 Default values for the CPU compatibility masks are set by VMware to guarantee 

the stability of virtual machines after a migration with VMotion. Changes to these 

default masks are made very conservatively by VMware, and only when new CPU 

Error message

NOTE Editing a virtual machine’s CPU compatibility mask is supported in ESX Server 3.0 only. 
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features are introduced and versions of ESX Server are updated to expose or hide 

them from virtual machines.

 In some cases, where a choice between CPU compatibility or guest operating 

system features (such as NX/XD) exists, VMware provides check‐box options to 

configure individual virtual machines through the virtual machine’s Advanced 

Settings option. Advanced virtual machine virtual host modifications can be used 

by developers.

 For other cases, and advanced purposes (intended to be used using specific 

instructions from VMware or by CPU and operating system developers who may 

need to control the characteristics of virtual CPUs). VMware also provides a 

mechanism to manually edit the CPU compatibility masks used by a virtual 

machine. Manual edit of the CPU compatibility masks without the appropriate 

documentation and testing is NOT recommended and may lead to an unsupported 

configuration.

Migration Wizard
The Migration wizard takes you through the process of migrating a virtual machine 

from one host to another. Both source and destination hosts must have VMotion 

enabled on them. If the destination is a cluster, there must be at least one valid 

destination host in the cluster, so at least one host in the cluster must have VMotion 

enabled. Preferably all hosts in a cluster will have VMotion enabled, especially for DRS 

clusters.

The menu options differ slightly, depending on whether you are performing migration 

or migration with VMotion.

To migrate a powered-off or suspended virtual machine

1 From the VirtualCenter client, click the Inventory button in the navigation bar.

2 Choose Migrate from the pop‐up menu.

Choose between Nx/xD 
Security features or Broadest 
VMotion Compatibility

For future CPU features, edit 
mask at the bit level



Basic System Administration

240 VMware, Inc. 

The Migrate Virtual Machine wizard starts.

3 Select the destination host or cluster for this virtual machine migration.

Any compatibility problem is displayed in the Compatibility panel. Fix the 

problem, or choose another host or cluster. 

Possible targets include hosts and DRS clusters with any level of automation. If a 

cluster has no DRS enabled, select a specific host in the cluster rather than selecting 

the cluster itself.

If the wizard is invoked through drag‐ and‐drop, the Select Destination host or 

cluster window is skipped if the drag‐and‐drop target is a standalone host or a 

pool assigned to a standalone host. If a cluster or a cluster’s pool is the 

drag‐and‐drop target, the Select Destination host or cluster window appears. 

4 Click Next.

5 Select the destination resource pool for the virtual machine migration, and click 

Next.

NOTE Moving a virtual machine from the host where its snapshots are located might 

render those snapshots inaccessible.

NOTE The resource pool selection pane of the wizard performs a compatibility check that 

can display warnings or errors. 
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The Resource Pool Selection page does not appear if a virtual machine was 

dropped on a resource pool.

6 Select the destination datastore.

The datastores that are accessible from the new destination are listed.

7 Select the radio button to keep the virtual machine configuration files and virtual 

disks in their current locations or the radio button to move the virtual machine 

configuration files and their virtual disks.

VirtualCenter moves the virtual machine, including the virtual disks, to the new 

host. Event messages appear in the Events tab. The data displayed on the Summary 

tab shows the status and state throughout the migration.

8 Click Next.

9 Review the summary, and click Finish.

NOTE You can relocate only powered off and suspended virtual machines. You cannot 

relocate virtual machines that are being migrated with VMotion.
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To migrate a powered-on virtual machine

1 From the VI Client, click the Inventory button in the navigation bar. Expand the 

inventory as needed, and click the appropriate virtual machine.

2 Make sure that both the source and target hosts are VMotion‐enabled and using 

the same shared datastore. 

3 Select each host.

4 Select the Summary tab.

5 Check the VMotion Enabled field and the Datastore section.

The VMotion Enabled field should say Yes. Datastores on both hosts should list the 

same name. 

In migration with VMotion, a host must have VMotion enabled on it to migrate a 

powered‐on virtual machine to or from the host. VMotion interfaces are 

configured and enabled using the network configuration options for the host.

NOTE Before you begin, disconnect any peripheral devices connected to the virtual machine. 

If the virtual machine is using a physical device on the source host, that device will not 

be accessible on the destination host. This is an incompatibility that will prevent use of 

VMotion. For example, if the virtual machine is reading from a CD‐ROM drive on the 

source host, it cannot access that drive from the destination host.
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6 Display the inventory panel, and select the appropriate datacenter.

7 Click the Inventory option in the navigation bar. Expand the inventory, as needed, 

and click the appropriate virtual machine.

8 Start the Migrate Virtual Machine wizard.

In the inventory panel, select the desired virtual machine. Then do one of the 

following:

 From the pop‐up menu, choose the Migrate option. 

 From the information panel Summary tab, click the Migrate to New Host 

button. 

 Drag the virtual machine onto the target standalone host, cluster, or resource 

pool.

The migration with VMotion wizard starts.

Virtual machines can also be dropped into resource pools for any host or cluster, 

in which case the wizard skips the Resource Pool Selection page.

In the event that the virtual machines are dropped onto a resource pool on the 

same host or cluster, the Migration wizard is not invoked. Instead, the virtual 

machines are reassigned to the new resource pool, pending admission control to 

the new pool.

9 Click Next.

10 Select a destination host or cluster for the virtual machine.

Possible targets include hosts and fully automated DRS clusters. A nonautomated 

cluster can also be selected as a target. You are prompted to select a host within the 

nonautomated cluster.

When you select a host, the Compatibility section at the bottom of the wizard 

displays information about the compatibility of the selected host or cluster with the 

virtual machine’s configuration. If the virtual machine is compatible, the panel is 

blank. If the virtual machine is not compatible with either the host’s or cluster’s 

NOTE If multiple virtual machines are selected and the wizard is invoked through 

drag‐and‐drop, the virtual machines must all be in the same power state. 

Otherwise, an error message is displayed, and the wizard stops.

NOTE If the wizard is invoked through drag‐and‐drop, the Select destination host or 

cluster window is skipped unless the drop target is a nonautomated cluster.
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configured networks or datastores, a warning message appears. A possible 

problem might be that VMotion is not enabled on one or both hosts.

11 Select a resource pool, and click Next.

The Resource Pool Selection page does not appear if a virtual machine was 

dropped on a resource pool.

12 Select the migration priority level. 

13 Set the priority of the migration to ensure that sufficient CPU resources are 

available on both the source and target hosts to perform the migration. 

14 Click the appropriate button, and click Next.

Once all options have been selected, a Ready to Complete page appears that shows 

a summary of the selected choices. 

15 Review the page, and click the Finish button.

When you click the Finish button, a task is created that begins the virtual machine 

migration process. While the virtual machine is in the process of being migrated, 

you have only limited access to its functions.

If you want to change any options, click the Back button to step back through the 

wizard or click any of the links in the left pane to go back to a specific page. If you 

click a link, the subsequent links that follow it revert to unseen page entries, and 

you must move sequentially through the wizard using the Next button.
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This chapter describes users, groups, permissions and roles. VirtualCenter and ESX 

Server hosts determine the level of access for the user based on the permissions 

assigned to the user. The combination of user name, password, and permissions is the 

mechanism by which VirtualCenter and ESX Server hosts authenticate a user for access 

and authorize the user to perform activities. The VirtualCenter and ESX Server host 

maintain lists of authorized users and the permissions assigned to each user.

Privileges define basic individual rights required to perform actions and read 

properties. ESX Server and VirtualCenter use sets of privileges, or roles, to control 

which individual users or groups can access particular Vmware Infrastructure objects. 

ESX Server and VirtualCenter provide a set of pre‐established roles. You can also create 

new roles.

The privileges and roles assigned on an ESX Server are separate from the privileges and 

roles assigned on a VirtualCenter Server. If you have privileges and roles assigned on 

an ESX Server and then add that ESX Server to the VirtualCenter Server inventory, only 

the privileges and roles assigned through the VirtualCenter Server are recognized. If 

you then remove the ESX Server from the VirtualCenter Server inventory, the 

previously set ESX Server privileges and roles are used.

For a complete list of privileges available, refer to Appendix A, “Defined Privileges,” 

on page 325.

This chapter contains the following topics:

 “Access Elements” on page 248

 “Access Rules” on page 248

 “Users” on page 251

Managing Users, Groups, 
Permissions, and Roles 15
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 “Groups” on page 253

 “Permissions” on page 254

 “Roles” on page 254

 “Access Permissions” on page 262

Access Elements
Access to VMware Infrastructure objects and activities is established through the 

combination of:

 Logon information – User name and password.

 Groups – A method for grouping individual users.

You can manage users more easily by assigning them to groups. If you create 

groups, you can apply a role to the group, and this role is inherited by all the users 

in the group.

 Roles – A defined collection of privileges.

Roles are a collection of defined privileges that control individual user or group 

access to particular VMware Infrastructure objects. ESX Server and VirtualCenter 

Server provide a set of default roles. You can also create new roles.

 Privileges – A particular right corresponding to a set of operations or methods on 

a class of objects. 

 Permissions – The combination of the role plus user or group name assigned to a 

VMware Infrastructure inventory object.

The role and a user or group name make a pair. This pair is assigned to a VMware 

Infrastructure object. Typically, this role and user pairing is propagated to the 

children in the inventory hierarchy. The pair is called a permission.

Access Rules
The following is a list of general rules to consider when configuring your user’s and 

group’s permissions.

Users do not need to log off and log on for changes to take effect. All changes take effect 

immediately. 

NOTE You must be in Admin view for the Admin > Roles menu item to be enabled.
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Hierarchical Inheritance
Propagation is set per permission rule, not universally applied. Permissions defined for 

a sub‐object always override those propagated from parent objects.

With respect to permissions, there are three types of elements in the hierarchy. They are:

 Managed entity – These can have permissions defined on them.

 Virtual machines

 Folders

 Datacenters

 Clusters

 Hosts

 Resource Pools

 Templates

 Related to a managed entity – These cannot have permissions defined on them, 

but inherit access from the object they are related to. Examples include:

 Networks

 Datastores

 Global entity – These always get their permissions from the root node. Examples 

include: 

 Custom fields

 Licenses

 Statistics intervals

 Roles

 Sessions

Multiple Permission Settings
Objects might have multiple permissions, but at most one for each user or group.

If you apply permissions, they override each other down the hierarchy. If permissions 

are defined on the same entity, a couple of situations are possible:

 If a user is a member of multiple groups with different permissions. For each 

object the group has permissions on, the same permissions apply as if granted to 

the user directly.

 If multiple group permissions are defined on the same object and the user 

belongs to two or more of those groups:
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 If there is no permission defined explicitly for the user on that object, the user 

is assigned the union of privileges assigned to the groups for that object. 

 If there is a permission defined explicitly for the user on that object, that 

permission takes precedence over all group permissions.

Example 1: Expanding a user’s permissions

 Role 1 can power on virtual machines. 

 Role 2 can take snapshots of virtual machines. 

 Group A is granted Role 1 on virtual machine. 

 Group B is granted Role 2 on virtual machine. 

User 1 is not assigned specific permission:

 User 1, who belongs to groups A and B, logs on. 

 User 1 can both power on and take snapshots of virtual machine.

Example 2: Limiting a user’s permissions

 Role 1 can power on virtual machines. 

 Role 2 can take snapshots of virtual machines. 

 Group A is granted Role 1 on virtual machine parent folder. 

 Group B is granted Role 2 on virtual machine. 

User 1 Read Only permission is removed on virtual machine:

 User 1 can take snapshots but not power on. 

Tasks Requiring Settings on Multiple Objects
When setting permissions, verify that all the object types are set with appropriate 

privileges for each particular action. Some operations require access permission at the 

root folder in addition to access permissions on the object being manipulated. Some 

operations require access or performance permission at a parent folder and a related 

object. 

Refer to Appendix A, “Defined Privileges,” on page 325 for a list of predefined roles 

and associated privileges. Use these predefined roles to help determine the role + object 

pairing required to perform your chosen task.

Example 3: Adding a virtual machine

 Role 3 can add virtual machines.
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 Role 4 is read only.

 Group C is granted Role 3 on Host 1.

 Group C is also granted Role 4 on the parent folder or datacenter for Host 1’s 

associated datastores and networks. 

These objects inherit their permissions from their parent folder or datacenter. 

Setting both permissions allows Group C users to add a virtual machine to the 

host.

Example 4: Delegating resources

 Using default roles for Resource Pool Administrator, Virtual Machine User, 

and Read Only

 Grant User 1 the role of Resource Pool Administrator on ResourcePoolA.

 Grant User 1 the role of Virtual Machine User on all the virtual machines in 

ResourcePoolA.

 Grant User 1 the role, Read Only on the folder or datacenter containing the 

datastores and networks associated with ResourcePoolA.

Because resource pools affect multiple inventory objects you must assign various 

privileges on selected objects to effectively perform tasks (in this case, delegating 

resources within a resource pool on to the virtual machines in that resource pool).

Users
A user is an individual authorized to log on to either an ESX Server host or to 

VirtualCenter. ESX Server users fall into two categories: those who can access the ESX 

Server host through VirtualCenter and those who can access the ESX Server host by 

directly logging on to the host from VI Client, VI Web Access, a third‐party client, or a 

command shell. These two categories draw users from different sources:

 VirtualCenter users – Authorized users for VirtualCenter are those included in the 

Windows domain list referenced by VirtualCenter or local Windows users on the 

VirtualCenter host. 

You cannot use VirtualCenter to manually create, remove, or otherwise change 

users. If you need to manipulate the user list or change user passwords, you must 

do so through the tools you normally use to manage your Windows domain.

Any changes you make to the Windows domain are reflected in VirtualCenter. 

Because you cannot directly manage users in VirtualCenter, the user interface 

doesn’t provide a user list for you to review. You see these changes only when you 

select users to configure permissions.
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 Direct access users – Users authorized to work directly on an ESX Server host are 

those added to the internal user list by default when ESX Server is installed or by 

a system administrator after installation. 

If you log on to the host as root, you can perform a variety of management activities 

for these users, such as changing passwords, group memberships, permissions, 

and so forth. You can also add and remove users. 

Even if the lists maintained by an ESX Server host and VirtualCenter appear to have 

common users (for instance, a user called devuser), these users should be treated as 

separate users who have the same name. The attributes of devuser in VirtualCenter, 

including permissions, passwords, and so forth, are separate from the attributes of 

devuser on the ESX Server host. If you log on to VirtualCenter as devuser, you might have 

permission to view and delete files from a datastore. If you log on to an ESX Server host 

as devuser, you might not.

Users and groups in the VMware Infrastructure environment are created using two 

methods:

 When the VI Client is connected to a VirtualCenter Server, users and groups are 

defined through the standard methods for Windows domains or Active Directory. 

You do not create users and groups for access to the VirtualCenter Server through 

the VI Client. 

 When the VI Client is connected to an ESX Server, users and groups are defined 

through the Users and Groups tab. 

Users and groups defined when connected to an ESX Server are applicable to that ESX 

Server only. They are not in the list of available users for a VirtualCenter Server 

connection even if the ESX Server is registered with the VirtualCenter Server.

Each ESX Server has two default users:

 The root user has full administrative privileges. Administrators use this logon and 

its associated password to log on to an ESX Server through the VI Client. Root 

users have a complete range of control activities on the specific ESX Server host 

that they are logged on to, including manipulating permissions, creating groups 

and users, working with events, and so forth. 

 The vpxuser user is a VirtualCenter entity with root rights on the ESX Server host, 

allowing it to manage activities for that host. The vpxuser is created at the time that 

WARNING Refer to the Authentication and User Management chapter of the Server 

Configuration Guide for information about root users and your ESX Server 

before you make any changes to the root user. Mistakes here can have serious 

access consequences. 
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an ESX Server host is attached to VirtualCenter. It is not present on the ESX Server 

host unless the host is being managed through VirtualCenter.

For information on creating users and groups for use with your VirtualCenter Server, 

refer to your Microsoft documentation.

For information about creating users and group for use with your ESX Server, refer to 

the Security section of the Server Configuration Guide.

Groups
You can efficiently manage some user attributes by creating groups. A group is a set of 

users that you want to manage through a common set of rules and permissions. When 

you assign permissions to a group, they are inherited by all users in the group. Using 

groups can significantly reduce the time it takes to set up your permissions model.

The group lists in VirtualCenter and an ESX Server host are drawn from the same 

sources as the user lists. If you are working through VirtualCenter, the group list is 

called from the Windows domain. If you are logged on to an ESX Server host directly, 

the group list is called from a table maintained by the host.

The VirtualCenter Server grants access to each inventory object by assigning a role with 

defined privileges and a user or group to each object. Roles are a defined set of access 

privileges.

Individual permissions are assigned through the VirtualCenter Server or the ESX 

Server by pairing a user and a role and assigning this pair to an inventory object:

 Users and groups are created for the VirtualCenter Server through the Windows 

domain or Active Directory database. 

 Users and groups are created for the ESX Server through the Users and Groups tab 

when connected directly to the ESX Server. VirtualCenter Server cannot view any 

users and groups that are created for and on the ESX Server. Refer to the Server 

Configuration Guide.

CAUTION Do not change vpxuser and do not change its permissions. If you do so, you 

might experience problems working with the ESX Server host through 

VirtualCenter.
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Permissions
For ESX Server and VirtualCenter, a permission is defined as an access role that consists 

of a user and the user’s assigned role for an object, such as a virtual machine or ESX 

Server host. Permissions grant users the right to perform specific activities and manage 

specific objects on an ESX Server host or, if users are working from VirtualCenter, all 

VirtualCenter‐managed objects. For example, to configure memory for an ESX Server 

host, you must have host configuration permissions.

Most VirtualCenter and ESX Server users have limited ability to manipulate the objects 

associated with the host. However, ESX Server provides full access rights and 

permissions on all virtual objects, such as datastores, hosts, virtual machines, and 

resource pools, to two users: root and vpxuser.

 As root, you can grant permissions on an ESX Server host to individual users or 

groups. These users and groups are added to the ESX Server user list and group 

list in two ways. They can be added by default when ESX Server is installed. They 

can also be manually added to the host after installation. 

 Through VirtualCenter, you can grant permissions to any user or group included 

in the Windows domain list referenced by VirtualCenter.

The method you use to configure permissions directly on an ESX Server host is identical 

to the method you use to configure permissions in VirtualCenter. The list of privileges 

is the same for both ESX Server and VirtualCenter. 

The table in Appendix A lists the access permissions.

Roles
VirtualCenter and ESX Server grant access to objects only to users who have been 

assigned permissions for the object. When you assign a user or group permissions for 

the object, you do so by pairing the user or group with a role. A role is a predefined set 

of privileges.

VirtualCenter and ESX Server hosts provide default roles:

NOTE VirtualCenter registers any selected Windows domain user or group through the 

process of assigning permissions. By default, all users who are members of the 

Windows Administrators group on the VirtualCenter Server are granted the same 

access rights as any user assigned to the Administrator role. Users who are 

members of the Administrators group can log on as individuals and have full 

access.
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 System roles – System roles are permanent and the privileges associated with 

these roles cannot be changed. 

 Sample roles – Sample roles are provided for convenience as guidelines and 

suggestions. These roles can be modified or removed.

You can also create completely new roles. Table 15‐1 lists the default roles that can be 

paired with a user and assigned to an object. 

Table 15-1.  Default Roles

Role Role Type Description User Capabilities

No Access User system Cannot view or change the assigned object. 

VI Client tabs associated with an object display 
without content. 

This is the default role for all users except those users 
in the Administrators group. 

Read Only User  system View the state and details about the object. 

View all the tab panels in the VI Client except the 
console tab. Cannot perform any actions through the 
menus and toolbars. 

Administrator system All privileges for all objects. 

Add, remove, and set access rights and privileges for 
all the VirtualCenter users and all the virtual objects in 
the VMware Infrastructure environment.

This is the default role for all members of the 
Administrators group. 

Virtual Machine 
User

sample Perform actions on virtual machines only. 

Interact with virtual machines, but not change the 
virtual machine configuration. This includes:

 All privileges for the scheduled tasks privileges 
group.

 Selected privileges for the global items and virtual 
machine privileges groups.

 No privileges for the folder, datacenter, datastore, 
network, host, resource, alarms, sessions, 
performance, and permissions privileges groups.
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All roles permit the user to schedule tasks by default. Users can schedule only tasks 

they have permission to perform at the time the tasks are created. Use the role‐editing 

Virtual Machine 
Power User

sample Perform actions on the virtual machine and resource 
objects. 

Interact and change most virtual machine 
configuration settings, take snapshots, and schedule 
tasks. This includes:

 All privileges for scheduled task privileges group.

 Selected privileges for global items, datastore, and 
virtual machine privileges groups.

 No privileges for folder, datacenter, network, host, 
resource, alarms, sessions, performance, and 
permissions privileges groups.

Resource Pool 
Administrator

sample Perform actions on datastores, hosts, virtual machines, 
resources, and alarms. 

Provides resource delegation and is assigned to 
resource pool inventory objects. This includes:

 All privileges for folder, virtual machine, alarms, 
and scheduled task privileges groups. 

 Selected privileges for global items, datastore, 
resource, and permissions privileges groups. 

 No privileges for datacenter, network, host, 
sessions, or performance privileges groups.

Datacenter 
Administrator

sample Perform actions on global items, folders, datacenters, 
datastores, hosts, virtual machines, resources, and 
alarms. 

Set up datacenters, but with limited ability to interact 
with virtual machines. This includes:

 All privileges for folder, datacenter, datastore, 
network, resource, alarms, and scheduled task 
privileges groups. 

 Selected privileges for global items, host, and 
virtual machine privileges groups. 

 No privileges for session, performance, and 
permission privileges groups.

Virtual Machine 
Administrator

sample Perform actions on global items, folders, datacenters, 
datastores, hosts, virtual machines, resources, alarms, 
and sessions. This includes:

 All privileges for all privilege groups, except 
permissions. 

Table 15-1.  Default Roles (Continued)

Role Role Type Description User Capabilities
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facilities in the VI Client to create privilege sets that match your user needs. If you use 

the VI Client connected to VirtualCenter to manage your ESX Server hosts, you have 

additional roles to choose from VirtualCenter. The roles you create directly on an ESX 

Server host are not accessible within VirtualCenter. You can work with these roles only 

if you log on to the host directly from the VI Client. 

There are several activities you can perform with roles. 

The activity options with roles are described in the following sections:

 “Creating Roles” on page 257

 “Cloning Roles” on page 259

 “Editing Roles” on page 260

 “Removing Roles” on page 261

 “Renaming Roles” on page 262

Creating Roles
Some of the default roles are preconfigured and cannot be changed. If you have 

situations that require a different combination of access privileges, create an additional 

role or modify the provided sample roles to suit your needs.

To create a role

1 Log on to the VI Client connected to either a VirtualCenter Server or an ESX Server 

as a user with Administrator privileges.

2 From the VI Client, click the Admin button in the navigation bar. Click the Roles 

tab.

NOTE Changes to permissions and roles are implemented immediately, even if the users 

involved are logged on. 
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3 Right‐click in the Roles tab information panel. Choose Add.

The Add Role dialog box appears.

4 Type a name for the new role.
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5 Select the privileges you want the new role to have, and click the items desired. 

Click the plus (+) signs to expand the lists, as needed. Click OK to complete the 

process.

Cloning Roles
You can make a copy of an existing role, rename it, and later edit it. When you make a 

copy, the new role is not automatically applied to the same user or groups and objects. 

To clone a role

1 From the VI Client, click the Admin button in the navigation bar. Click the Roles 

tab.

2 To select the role to duplicate, click the object in the list of Roles.

3 To clone the selected role, choose Administration > Role > Clone. 

A duplicate of the role is added to the list of roles. The name is Copy of 
<rolename>. 
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Editing Roles
When you edit a role, you have the option to change any or all of the privileges selected 

for that role. Once completed, these new privileges are applied to any user or group 

assigned the edited role. 

To edit a permissions role

1 From the VI Client, click the Admin button in the navigation bar. Click the Roles 

tab.

2 To select the role to edit, click the object in the list of Roles.

3 Choose Administration > Role > Edit Role. 

4 Select the privileges you want the new role to have. Click the plus (+) signs to 

expand the lists, as needed. 

5 Click OK to complete the process.
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Removing Roles
When you remove a role, if it is not assigned to any users or groups, the definition is 

removed from the list of possible roles. When you remove a role that is assigned to a 

user or group you can remove all assignments or replace them with an assignment to 

another role. 

To remove an existing role

1 From the VI Client, click the Admin button in the navigation bar. Click the Roles 

tab.

2 To select the role to remove, click the object in the list of roles.

You can select multiple roles using the Ctrl or Shift keys.

3 Choose Administration > Role > Remove. 

4 To confirm that you want to delete the selected role, click OK. 

The role is removed from the list and is no longer available for assigning to users 

or groups.

If the role is assigned to a user or group, a warning message appears. 

5 Select one of the radio button options and click OK.

The options are:

CAUTION Be sure that you understand how users will be affected before removing all 

assignments or replacing them.
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 Remove Role Assignments — This option removes any configured user or 

group + role pairings on the server. If a user or group does not have any other 

permissions assigned, they lose all privileges. 

 Reassign affected users to — This option reassigns any configured user or 

group + role pairings to the selected new role.

Renaming Roles
Roles, like most other VMware Infrastructure objects, can be renamed. 

To rename an existing role

1 From the VI Client, click the Admin button in the navigation bar. Click the Roles 

tab.

2 To select the role to rename, click the object in the list of roles.

3 Choose Administration > Role > Rename.

4 Type the new name. Press Return or click another object. 

Access Permissions
For each object in the VMware Infrastructure hierarchy, determine the permissions for 

each VirtualCenter user and group. 

If you remove users from the ESX Server, refer to the Security chapter in the Server 

Configuration Guide for process and consequences.

If you remove users from the VirtualCenter domain, they lose permissions to all objects 

in the VMware Infrastructure and will not be able to log on again. Users who are 

currently logged on and are removed from the domain retain their VMware 

Infrastructure permissions only until the next validation period (the default is every 24 

hours). Individual permissions, or those granted as part of inclusion in another group, 

are not affected.

If you change a userʹs name in the domain, the existing user name becomes invalid in 

the VMware Infrastructure system. The same methodology applies to groups, but this 

applies to a group only after VirtualCenter Server has been restarted.

NOTE Several users can access the VirtualCenter Server from different Virtual Infrastructure 

Clients at the same time. VMware Infrastructure does not explicitly restrict users with 

the same log‐in and password from accessing and taking action within the VMware 

Infrastructure environment. 
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Assigning Access Permissions
After any additional roles are defined and users and groups are created, you must 

assign the users and groups their roles, with associated permissions, to the relevant 

inventory objects.

For information on creating users and groups for use with your VirtualCenter Server, 

refer to your Microsoft documentation.

For information on creating users and group for use with your ESX Server, refer to the 

Security section of the Server Configuration Guide.

To assign a user or group permission

1 Log on to the VI Client as a user with the Administrator privileges.

2 From the VI Client, click the Inventory button in the navigation bar. Expand the 

inventory as needed, and click the appropriate object. 

The objects that can have permissions assigned to them are:

 In VirtualCenter – Folders, datacenters, clusters, resource pools, hosts, virtual 

machines

 In ESX Server – Resource pools, the host, virtual machines.

3 With the appropriate object selected, click the Permissions tab.



Basic System Administration

264 VMware, Inc. 

4 Choose Inventory menu > New > Add Permission.

5 Choose a role from the Assigned Role pull‐down menu. 

This menu displays all the roles that have been assigned to that host. When the role 

is displayed, the privileges granted on the role are listed in the section below the 

role title for reference purposes.

6 (Optional) Select the Propagate to Child Objects check box.

If this check box is selected, the role is also applied to all child objects of the selected 

inventory object. Most of the time selecting this box is appropriate.
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7 Open the Select Users or Groups dialog box. Click the Add button.

Refer to “Adjusting the Search List in Large Domains” on page 266 for information 

on adjusting the list of users and groups you select from.

8 Identify the user or group that is being assigned this role:

a Choose the domain where the user or group is located from the Domain 

pull‐down menu.

b Type a name in the Search box or select a name from the Name list. 

c Click Add. 

The name is added to either the Users or Groups list. 

d Repeat step a through Step c to add additional users or groups. 

e Click OK when finished. 

If you know the user or group name, you can type it in the Name field manually.

9 Verify the users and groups are assigned to the appropriate permissions, and click 

OK.

10 To finish the task, click OK.

The server adds the permission to the list of permissions for the object. 
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The list of permissions references all users and groups that have roles assigned to 

the object, and indicates where in the VirtualCenter hierarchy the role is assigned.

Adjusting the Search List in Large Domains
If you have domains with thousands of users or groups in them, adjust the search 

settings for use in the Select Users or Groups dialog box.

To adjust users and groups search parameters

1 From the VI Client connected to a VirtualCenter Server, choose Administration > 

VirtualCenter Management Server Configuration. 

The VirtualCenter Configuration wizard appears.

2 When the wizard is displayed, click the Active Directory list item.

3 Change the values as needed:

NOTE This procedure applies only to VirtualCenter user lists. ESX Server user lists cannot be 

searched in the same way.
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 Active Directory Timeout – Specifies in seconds the maximum amount of 

time VirtualCenter allows the search to run on the selected domain. Searching 

very large domains can take a very long time. 

 Enable Query Limit and Users & Groups value – Specifies the maximum 

number of users and groups VirtualCenter displays from the selected domain 

in the Select Users or Groups dialog box. To specify no maximum limit, 

deselect the check box. 

 Enable Validation and Validation Period – Specifies the time in minutes 

between permissions checks. VirtualCenter verifies that all users and groups 

known to VirtualCenter currently exist in Windows. 

For example, if user Smith was assigned permissions and in the domain the 

user’s name was changed to Smith2, VirtualCenter concludes that Smith no 

longer exists and removes permissions for that user. 

Similarly, if user Smith is removed from the domain, all permissions are 

irrelevant. That is until a new user Smith is added to the domain. The new user 

Smith receives all the permissions the old user Smith was assigned, unless you 

use this option to delete old user Smith from the system.

To deactivate the validation functions, deselect the check box.

4 Click the Finish list item. Then click Finish. 

Changing Access Permissions
After a user or group + role pair is set for an inventory object, the only change you can 

make is to the role paired with the user or group and the Propagate check box. You do 

have the option to remove the permission setting. Refer to “Removing Access 

Permissions” on page 268 for information.

To change the permission role for a user or group

1 From the VI Client, click the Inventory button in the navigation bar. Expand the 

inventory as needed, and click the appropriate object.

2 With the object selected, click the Permissions tab.

3 To select the user or group + role pair that you want to change, click the appropriate 

line item. 

4 Choose Inventory > Permissions > Properties.

NOTE Permissions are always validated when the server starts. Even if the server is 

disabled. 
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5 To select the appropriate role for the user or group, choose from the pull‐down 

menu. Click OK.

6 To propagate the privileges to the children of the assigned inventory object, click 

the Propagate check box. 

Removing Access Permissions
Removing a permission for a user or group does not remove the user or group from the 

list of those available. It also does not remove the role from the list of available items. It 

removes the user or group + role pair from the selected inventory object.

To remove a permission role for a user or group

1 From the VI Client, click the Inventory button in the navigation bar. Expand the 

inventory as needed, and click the appropriate object.

2 With the object selected, click the Permissions tab.

3 To select the user or group + role pair that you want to delete, click the appropriate 

line item. 

4 Choose Inventory > Permissions > Delete. 

The VMware Infrastructure server removes the permission setting. 

NOTE There is no additional warning that the permission is going to be removed. 
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This chapter describes how to monitor performance of the data presented in the VI 

Client. It also describes using the VI Client Maps feature. This chapter contains the 

following topics:

 “Monitoring Your VMware Infrastructure Environment” on page 269

 “Performance Charts” on page 270

 “Maps” on page 276

Monitoring Your VMware Infrastructure Environment
After you add hosts to VirtualCenter and create and power on virtual machines, you 

must customize and monitor your environment. This section looks at some available 

options. 

To monitor your Virtual Infrastructure environment

1 Select the Datacenter.

Notice that you can click either the Tasks or the Events button below the line of 

tabs. You can then select individual tasks or events to see additional information in 

the Details pane at the bottom of the window.

2 To view just events, click Events in the navigation bar.

Selecting Events displays alarms or informational messages. You can export them 

to a file by clicking Export Events. See the VI Client Online Help for more 

information. 

Monitoring Your Vmware 
Infrastructure Environment 16



Basic System Administration

270 VMware, Inc. 

When you are ready to expand or restructure your Virtual Infrastructure 

environment, you might find it useful to view a map of hosts and virtual machines, 

hosts and storage devices, or other information. 

3 Select the item for which you want more information and click the Maps tab. 

The VI Client displays a map, which you can customize as needed. 

Performance Charts
This section describes the performance‐monitoring features of the Virtual 

Infrastructure Client data.

The Performance tab is available when you select a cluster, resource pool, host, or 

virtual machine from the inventory panel. The Performance tab displays the selected 

object’s resource performance in graph and list form. Performance views show graphs 

for resources specific to the selected inventory object.

ESX Server systems connected to a VI Client directly have limited statistical 

information that is displayed in the Performance tabs. To get the full chart functionality, 

have the VirtualCenter Server manage the ESX Server.

Refer to “Performance Chart Measurements” on page 349 for a reference list of the 

values measures.

This chapter contains the following topics:

 “Performance Chart Resources” on page 270

 “Performance Chart View” on page 271

Performance Chart Resources
The resources that are monitored and reported in the performance charts are:

 CPU – Shows the CPU usage in MHz of the selected inventory object. Available for 

cluster, resource pool, host, and virtual machine.

 Memory – Shows the amount of memory granted to the selected inventory object. 

Available for cluster, resource pool, host, and virtual machine.

 Disk – Shows the aggregated storage performance statistics of the selected 

inventory object. Available for host and virtual machine.

NOTE The views and capabilities displayed vary depending on whether the VI Client is 

connected to a VirtualCenter Server or an ESX Server. Unless indicated, the process, 

task, or description applies to both kinds of VI Client.
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 Network – Shows the aggregated network performance statistics of the selected 

inventory object. Available for host and virtual machine.

 System – Available for host and virtual machine.

 DRS – Available for clusters and hosts that have DRS clusters.

Performance Chart View
All performance charts have a table listing the resources and measurements included 

in their chart. 

Figure 16-1.  Inventory > Virtual Machine > Performance Tab

Selecting Performance Chart Options

Several items are selectable for inclusion in your performance chart display. You can 

specify the resource, time range, measured resource elements, and whether to export 

the chart as an Excel file.

To see the measurement options for each resource monitored on a host, refer to the 

performance chart measurement tables in Appendix C.
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To select the resource whose performance is shown in the performance charts

The resource options are CPU, memory, disk, network, system, and resource group 

CPU.

1 From the VI Client, select the appropriate inventory object. Click the Performance 

tab.

2 Choose from the resource options pull‐down menu.

The time range options for the performance charts are Real‐time, Past Hour, Past Day, 

Week, Month, Year, and Custom. Which options are available depends on the feature 

being measured. These can be configured. For more information, see “To change 

collection intervals for statistics” on page 275.

To specify the time range for the performance charts

1 From the VI Client, select the appropriate inventory object. Click the Performance 

tab.

2 Choose from the time options pull‐down menu.

To export an .xls file of the performance chart data

1 From the VI Client, select the appropriate inventory object. Click the Performance 

tab.

2 Click the Export Chart link.

An Export Performance dialog box appears.

When you select more than one category, the charts are added on different 

spreadsheets in the same file.

3 Select the options desired. Click the chart to export. Specify a filename and 

location. Specify the size of the file to be exported.
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4 If the chart option you select has suboptions, click the Advanced button and choose 

from the list presented. Click OK.

5 To complete the export, click OK.

The chart options include line graph or stacked graph, resource objects found in group, 

and measurements specific to the resource selected. 

To specify the measured elements in the display of a performance chart

1 From the VI Client, select the appropriate inventory object. Click the Performance 

tab.

2 Click the Change Performance Counters link.

A Customize Performance Chart appears. 

3 Click the items to display as needed. Click Apply to view the change. Click OK to 

accept the change.

Viewing Stacked Graphs

A stacked graph is another way to view the statistical information. When selecting the 

stacked graph option, consider the following:

 Only one item can be selected from the list of measurements. A stacked graph 

cannot chart more than one measurement over a set of objects.
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 Per virtual machine stacked graphs are available only for hosts. In these graphs, the 

object’s list contains the host and all the virtual machines currently present on that 

host.

 Not all metrics make sense for virtual machine stacked charts. The measurements 

that do not apply are not included in the list of selectable measurements.

To view the stacked graph

1 From the VI Client, select the appropriate inventory object. Click the Performance 

tab.

2 Click the Change Performance Counters link.

3 Click one of the Line graph, Stacked graph, or Stacked graph (per VM) options. 

4 Click Apply to see the results.

5 Click OK to accept the results.

Setting the Statistics Collection Intervals

The time elements that are used to track and collect performance information are 

configurable. 
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To change collection intervals for statistics

1 From the VI Client connected to a VirtualCenter Server, choose Administration > 

VMware Virtual Infrastructure Client Settings.

2 Click the Statistics link.

3 Remove or create a new collection interval.

4 Click OK.

To create a new statistic sampling period

1 From the VI Client connected to a VirtualCenter Server, choose Administration > 

VMware Virtual Infrastructure Client Settings.

2 Click the Statistics link. 

3 From the Statistics link in the VirtualCenter Configuration panel, click Add. 

The Add Collection Interval dialog box appears. 
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A new collection interval requires that the:

 New sampling period must be the multiple of a previous one

 New sampling length must be longer than the previous one

 New sampling name must be unique

4 Enter a collection frequency, specifying how often to collect the information. Select 

the unit of measure. 

5 Enter the collection size, specifying the amount of data to store in the length of time 

statistics are collected before old data is replaced with new data. Select the unit of 

measure.

6 To complete the new sampling period, click OK.

Changing the Statistics Collection Level

 Level 1 – Basic metrics, including the average usage for CPU, memory, disk, and 

network; system uptime and heartbeat; and DRS metrics. Statistics for devices are 

not included in level 1.

 Level 2 – All metrics for CPU, memory, disk, and network counters; system uptime 

and heartbeat; DRS metrics; and device statistics. 

 Level 3 – All metrics for all counter groups. Maximum and minimum rollup types 

are excluded.

 Level 4 – All metrics supported by VirtualCenter.

Maps
The Maps feature of VI Client provides a visual understanding of the relationships 

between the virtual and physical resources available in VirtualCenter. Maps of the 

items within VirtualCenter are available in the Inventory through the Maps tabs for 

hosts, virtual machines, networks, and datastores, (Inventory Maps) and through the 

Maps button in the navigation bar (Global Maps). 

There are three map types:

 Global

 Inventory

 VMotion Resource Maps
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Global Maps
Global maps are accessible from the button in the large toolbar and provide a high‐level 

view of the relationships between all physical and virtual elements in the entire 

VirtualCenter environment. By selecting or deselecting the boxes on the side of the 

inventory, you can see which clusters or hosts are most densely populated, which 

networks are most critical, and which storage devices are being utilized (or not).

Physical, Virtual, and Custom map types exist for both inventory maps and global 

maps. They constrain and filter information on a VirtualCenter‐wide level for the global 

maps.

Inventory Maps
Inventory maps are accessible from the inventory view and show a selected itemʹs 

relevant host, virtual machine, network, and storage relationships. This makes it easy 

to understand what items are affected or attached to the item in question. These maps 

appear for folders, datacenters, clusters, resource pools, and hosts.

Physical, Virtual, and Custom map types exist for both inventory maps and global 

maps. They constrain and filter information on an item‐specific level for the Inventory 

maps.

The Maps tab is available when you select folders, datacenters, clusters, resource pools, 

hosts, or virtual machines from the inventory panel of the navigation bar. 

VMotion Resource Maps
VMotion resource maps appear only in the tabs for virtual machines selected in the 

inventory. In addition to visual representations of the resources (hosts, datastores, and 

networks) associated with a virtual machine, these maps display which hosts in a 

virtual machine’s cluster or datacenter are candidate hosts to which a virtual machine 

can migrate. Though the VMotion map is not the last word on whether VMotion is 

possible, it provides information about which hosts are heavily loaded, which are 

connected to all the same resources that the target virtual machine is connected to, and 

which hosts have compatible CPU and software with the target virtual machine.

The map considers four criteria when marking the host as a candidate for VMotion 

migration:

NOTE The views and capabilities displayed vary depending on whether the VI Client is 

connected to a VirtualCenter Server or an ESX Server. Maps are available only when the 

VI Client is connected to a VirtualCenter Server.
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 Datastore compatibility – the host must be connected to all the same datastores as 

the virtual machine.

 Network compatibility – the host must be connected to all the same networks as 

the virtual machine.

 Software compatibility – the host must have compatible software with the virtual 

machine.

 CPU compatibility – the host must have a compatibility CPU with the virtual 

machine.

If any of the four is lacking, the host is marked with a red X to denote unsuitability. If 

the cause of the unsuitability is from networking/datastore incompatibility, the user can 

discern this from the lack of edges connecting that host and the virtual machineʹs 

networks and datastores. If the cause of the unsuitability is from CPU or Software 

incompatibility, the information appears in a tool tip when the pointer hovers over the 

host in question.

If a host is compatible in all four aspects, a green circle appears behind it. This circle 

varies in intensity based on the hostʹs current load. Heavily used hosts are pale; 

low‐load hosts are saturated green.

It might take a few seconds for the map to retrieve load, CPU, and software 

information. The state of the mapʹs information retrieval process is displayed in the 

lower‐left corner of the map. As information arrives, the map is updated. A host that 

looks like a good VMotion candidate (displayed as green) might become a bad 

candidate (displayed as red) as information filters in.

If the information retrieval is taking too long, you can cancel the operation.

The VMotion map is not a conclusive statement as to whether VMotion is possible 

between a virtual machine and a target host. However, it seeks to provide information 

as to whether VMotion might be possible, and if not, what an administrator might do 

to remedy the situation.
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Map Elements and Icons
All maps have elements that are selectable depending on the inventory item and 

whether you approach the map through the Inventory tab or the Navigation bar button. 

The VMware Infrastructure map elements are described in the following table.

.

Table 16-1.  Map Elements and Icons

Attribute Description

Host icon.

A host that is compatible for VMotion migration.

A host that is not compatible for VMotion migration.

Virtual machine icon.

Network icon.

Datastore icon.

Overview section Thumbnail graphic of the full‐scale map.

Map Relationships 
section

Section that is displayed when more than one map type is available 
for the selected inventory object. Provides selection of the type of 
resource map to display.

Refresh link Maps do not auto‐refresh because adding or removing elements 
might be disruptive. To reorganize your map to the current state of 
the inventory and center the map view in the information map panel, 
click the Refresh link. 

Inventory panel When selecting through the Inventory navigation bar, a selected item 
stays highlighted to indicate map focus.

When selecting through the Maps navigation bar, all items in the 
inventory are listed with a check box. You can select or deselect any 
inventory items you do not want included in the map.



Basic System Administration

280 VMware, Inc. 

Viewing the Maps

There are two views of the map in any map panel. A larger view fills the panel and a 

miniature view fits into a fixed window. 

To view global maps

Click the Maps button in the navigation bar.

To view inventory maps

Click Inventory in the navigation bar and select the Inventory Hosts and Clusters or 

Virtual Machines and Templates options. Select a folder, datacenter, cluster, resource 

pool, or host inventory object. Click the Maps tab.

To view VMotion maps

Click Inventory in the navigation bar and select the Inventory Hosts and Clusters or 

Virtual Machines and Templates options. Select a virtual machine. Click the Maps tab.

Editing the Maps

Editing map options include:

 Including or excluding inventory objects

 Shifting the orientation, host‐centric or virtual machine‐centric

 Zooming in or out

 Shifting the area of the map being viewed

To view or hide content of a map using Map Relationships

1 From the VI Client, select the appropriate inventory object. Click the Maps tab. 

All inventory items are selected by default. 
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2 Choose an item from the Map Relationships pull‐down menu: Releasing the 

mouse button accepts the change and the map shifts to the new configuration.

The Map Relationships panel comes with two presets maps and a variable option: 

 Host Resources – Shows host‐centric physical relationships.

 Virtual Machine Resources – Shows virtual machine‐centric relationships.

 Custom Map – Allows you to choose any combination of relationships other 

than the host and virtual machine centric versions. The Custom Map option 

comes preset with all relationships selected.

3 Click the check boxes available under Host Options or VM Options. 

The map listing changes to Custom Map. Click Apply Relationships to update the 

map display. 
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To view or hide content of a global map using inventory checkboxes

1 From the VI Client, click the Maps button in the navigation bar.

2 Select or deselect any inventory items to indicate the items you want included in 

the map.

By default, selecting or deselecting selects or deselects the items below the object. 

The map removes or adds the objects automatically. 

As you click items, they appear or disappear from the map.

3 Refresh the map to organize the new list of items. Click the Refresh link.
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To zoom in or out of your map view

Click and drag in the Overview panel. 

When you zoom in or out of a map, VirtualCenter detects if the map cannot fit on the 

screen. If the map is too big to fit on the screen, you can change the zoom level by 

manipulating the size of the viewing window inside the Overview panel. Inside the 

Overview panel, a subset box represents what part of the total map is visible. Changing 

the size of this subset box changes the degree of zoom. You can only zoom in to a certain 

point, but you can zoom out until the map fits entirely into the window. 

The Overview map displays an area indicator box. The large map shifts to display only 

the area contained in the indicator box. The images in the large map shrink or expand 

to fit the information. This is more noticeable in large network environments. 

The map displays in the background of the information panel. The map has a specific 

scale, and sometimes the full map does not fit in the size the of window. The Overview 

and Map Relationships panels do not move from their upper‐right location in the 

information panel. 
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To move the map within the information panel

You can move the map two ways:

 Click and drag in the body of the information panel. 

The default pointer changes from an arrow to a hand. The map shifts direction 

corresponding to the mouse drag. Scrollbars display when the map extends 

beyond the information panel frame.

 Alternatively, click in the Overview map. The larger map shifts its center to the 

location you click.

Printing Maps
You can print the currently visible map to any ordinary printer. 

To print a map

You have two ways to print:

 From any screen on which any type of map is present, choose File > Export > Print 

Maps.

 From the Global Maps toolbar, click the Print button. 
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To alter print settings or see a print preview

From any window on which any type of map is present, choose File > Export > Print 

Preview.

Exporting Maps
You can save or export any map as a .jpg file. 

To export a graphical image of the performance chart

1 From the VI Client, select the appropriate inventory object.

2 Click the Global Maps button in the navigation bar, and click the Export Map 

button in the Maps task bar.

A Save As Image dialog box appears.

3 Select the options desired. Click the format to export. Specify a filename and 

location. Select the size of the file to be exported.

4 Complete the export. Click OK.
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Navigating Between Maps
Double‐click a host or virtual machine icon in a map from the Maps button display. The 

VI Client shifts to that icon in the inventory and displays that elementʹs maps tab, if 

applicable. In the example below, from the Maps button display, a virtual machine was 

double‐clicked. The view shifts to the virtual machine Maps tab information.

Displaying Object Menus in Maps
Maps support inventory object pop‐up menus. The functions on hosts, virtual 

machines, networks, and datastores can be performed through any of the Maps 

windows.

To display an inventory object menu

Right‐click any icon in the Maps panel.
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The corresponding pop‐up menu appears.
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This chapter describes tasks, events, and alarms. This chapter contains the following 

topics:

 “Managing Tasks” on page 289

 “Managing Events” on page 303

 “Managing Alarms” on page 308

Managing Tasks
This section describes how to view and schedule VirtualCenter tasks. Tasks are planned 

activities. These activities are scheduled or initiated manually. Tasks generate event 

messages that indicate any issues associated with the task. There are two kinds of tasks:

 An unscheduled task, which can result from performing an operation that might 

take a while, like adding a host. 

 A scheduled task, which you set up to trigger at a different time. 

This section contains the following sections:

 “Understanding Tasks” on page 290

 “Viewing and Performing Tasks” on page 290

Managing Tasks, Events, 
and Alarms 17

NOTE The views and capabilities displayed vary depending on whether the VI Client is 

connected to a VirtualCenter Server or an ESX Server. Unless indicated, the process, 

task, or description applies to both kinds of VI Client connections. The Tasks 

option is not available when the VI Client is connected to an ESX Server, but it does 

offer the recent tasks window at the bottom of the VI Client window.
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 “Managing Scheduled Tasks” on page 293

 “Rescheduling a Scheduled Task” on page 300

 “Removing a Scheduled Task” on page 300

 “Canceling a Task” on page 301

Understanding Tasks
The scheduled tasks option allows you to configure selected VirtualCenter activities to 

occur at designated times. The timing options include immediately, later, or on a 

recurring basis. Scheduled tasks are performed in addition to manually driven 

activities. 

Create a scheduled task through the New Task wizard, which displays the available 

task options. After you select an option, the wizard displays the pages that are relevant 

to the type of task you are scheduling. The New Task wizard ends when you set the 

timing of the task. You can reschedule tasks.

If the directions of manually driven and scheduled activities conflict, VirtualCenter 

performs whichever activity is due first. If a virtual machine is in an incorrect state to 

perform any activity, manual or scheduled, VirtualCenter sends a message to the log 

and does not perform the task.

When you create a scheduled task, VirtualCenter verifies that you have the correct 

permissions to perform the actions on the relevant datacenters, hosts, and virtual 

machines. Once the task is created, the task is performed even if you no longer have 

permission to perform the task.

When an object is removed from VirtualCenter, all associated tasks are also removed.

Events are logged to the event log at start and completion of the tasks. Any errors that 

occur during the task are also recorded in the event log. 

Viewing and Performing Tasks
You have the option to view the list of tasks associated with particular inventory objects 

or the complete list of tasks assigned to the entire VirtualCenter inventory. Tasks 

include activities such as powering on or off a virtual machine, cloning a virtual 

machine, or adding a virtual machine to a resource pool.

Tasks are not tracked or scheduled on your ESX Server host unless the ESX Server is 

registered and connected to a VirtualCenter Server. 

CAUTION Do not schedule multiple tasks to be performed at the same time on the 

same object. The results are unpredictable.
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To view recent tasks

From the VI Client connected to an ESX Server or a VirtualCenter Server, click the Tasks 

toggle button on the lower left side of the VI Client window. 

To perform a task on an ESX Server

1 From the VI Client connected to an ESX Server, click the Inventory button in the 

navigation bar. Expand the inventory as needed, and click the object where the 

action is to be performed.

2 Choose the activity from the main or pop‐up menu associated with the object.

For example, select a virtual machine, right‐click, and choose the Power On option. 

To schedule or view a list of tasks on an ESX Server

Add the host to the VirtualCenter inventory. 

Refer to “Adding a Host” on page 101 for more information.

To schedule a task on a VirtualCenter Server, refer to “Managing Scheduled Tasks” on 

page 293.

To view a list of tasks completed on a VirtualCenter Server

1 From the VI Client, click the Inventory, and click the root folder. 

2 Click the Task & Events tab. Click the Tasks button on the Tasks & Events panel.

3 Click a task in the panel. 
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Detailed information appears in the Task Details pane. 

To sort the list of tasks

1 From the VI Client, display the inventory panel, select the appropriate object and 

view the Tasks & Events panel.

2 Click the column title. It toggles between ascending and descending sort. 

To filter the list of tasks

1 From the VI Client, expand the inventory as needed, and click the appropriate 

object. 

2 Click the Task & Events tab. Click the Tasks button on the Tasks & Events panel.

3 Choose View > Filtering, if needed.

4 Click the list arrow, and click the column to include in the filter search. 

5 Type a keyword into the box, and press Return. 
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The list of tasks displays only those items that contain the keyword you typed. 

Notice in the example below how the Name and Reason columns both have items 

that contain the filter keyword, power. 

Managing Scheduled Tasks
You can schedule tasks to occur at designated times. Each schedule task option runs the 

corresponding wizard for the task and adds a scheduling time option at the end of the 

wizard. The possible tasks that can be scheduled through the New Task wizard are 

listed below. Refer to the listed document for information on completing the individual 

task wizards:

 Change the power state of a virtual machine (refer to “Changing Virtual Machine 

Power States” on page 141)

 Create a virtual machine template (refer to “Creating Templates” on page 204)

 Move a virtual machine with VMotion (refer to “Migration with VMotion” on 

page 233)

 Create a virtual machine (refer to “Using the New Virtual Machine Wizard” on 

page 114)

 Make a snapshot of a virtual machine (refer to “Understanding Snapshots” on 

page 221)
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 Customize a virtual machine (refer to “Preparing for Guest Customization (SEE 

UPDATE)” on page 190)

 Add a host (refer to “Adding a Host” on page 101)

To create a scheduled task

1 From the VI Client connected to a VirtualCenter Server, click the Scheduled Tasks 

option in the navigation bar.

The current list of scheduled tasks appears.

2 Click New in the toolbar, or choose File > New > Scheduled Task.

3 Click the pull‐down menu, and choose the appropriate option. Click Next.

4 Complete the task‐specific information.

The New Task wizard displays a series of pages that correspond to the pages you 

refer to when you perform the task starting from the selected object. 

Refer to the section or the manual that is appropriate for each option for specific 

information on each task. Most of the scheduling processes differ from manually 

performed tasks only in that you must specify the virtual machine, host, or 

datacenter to which the task applies and specify the time to perform the task.

NOTE Any operation can be set as a scheduled task through the VMware Infrastructure 

API. However, only a subset of all operations can be part of a scheduled task 

through the VI Client.
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5 Specify the timing of the task.

The default frequency and scheduled time is Now. The task starts when you finish 

creating the task. 

6 To schedule a one‐time occurrence, set the Frequency to Once. Set the Start Time 

to Later. Type a clock time in the Time field. 

To view the calendar, click the Date arrow. 

NOTE Only one timing schedule can be set per task. To set more than one frequency type, 

set up additional tasks. 

NOTE The time when a scheduled task occurs is relative to the VirtualCenter Server and 

not to the local VI Client from which you configure the task.
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7 Click the left and right arrows to view additional months. Click the month and 

choose from the list. Click the year, and click the up and down arrows.

When you click the calendar date, the calendar accepts the new date and closes.

8 To run the task after startup, click After Startup and enter the amount of the delay.

NOTE The time set is relative to the VirtualCenter Server and not to the VI Client.
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9 To run the task hourly, click Hourly. Enter the start time after the beginning of the 

hour and the interval (for example, 15 minutes after every eight hours).

10 To run the task daily, click Daily. Enter the start time and interval. 

For example, enter 14:30 every fourth day to run the task at 2:30 pm every four 

days.

11 To run the task weekly, click Weekly. Enter the start time, day of the week, and 

interval. 
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For example, Tuesdays and Thursday, 8:00 am, every second week. You can select 

multiple days of the week.

12 To run the task monthly, click Monthly. Enter the start time, day of the month, and 

interval. 

For example, enter second Thursday of the month, 11:00 every third month.

If you select a day higher than 28, a warning message is displayed because some 

months are 29, 30, or 31 days.
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13 The last <day> of the month selects the last week in the month that the day occurs. 

If you select the last Monday of the month, and the month ends on a Sunday, the 

last Monday will be six days before the end of the month.

14 To complete the wizard, click Finish.

VirtualCenter adds the task to the list in the Scheduled Tasks tab.
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Rescheduling a Scheduled Task
After a scheduled task is created, you can change its timing and frequency, as well as 

the specifics of the task. 

To reschedule a scheduled task

1 From the VI Client connected to a VirtualCenter Server, click the Tasks option in 

the navigation bar.

The list of scheduled tasks appears.

2 To choose the appropriate task from the list, click Properties in the toolbar.

The Change a <task> wizard, corresponding to the task, appears. 

3 Click through the wizard using the Next button, and make changes as needed.

Removing a Scheduled Task
Removing a scheduled task removes all future occurrences of the task. The history 

associated with all previous executions of the task remains in the VirtualCenter 

database.

To remove a task that has been scheduled

1 From the VI Client connected to a VirtualCenter Server, click the Scheduled Tasks 

option in the navigation bar.

The list of scheduled tasks appears.

2 Select the appropriate task from the list. Choose Inventory > Scheduled Task > 

Remove.

VirtualCenter removes the task from the scheduled task list.

3 To verify that you want to remove the task, click OK.

The task is deleted from the list of tasks.

NOTE Scheduled task calculation and execution are based on time zone and the time set 

in the VirtualCenter Server. If the VI Client and VirtualCenter Server are in 

different time zones, the task schedule is offset by the difference in time zones of 

the VirtualCenter Server and VI Client. 

NOTE Removing a task differs from canceling a task. Canceling a task stops a task currently 

occurring, whether started manually or schedule. Removing a task removes future 

occurrences of a scheduled task.
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Canceling a Task
Only tasks that are in process can be canceled. And only selected (scheduled or 

manually initiated) tasks can be canceled while in process. Canceling a task while it is 

running requires that you have the appropriate permissions assigned to the host where 

the task is occurring.

Canceling a task differs from removing a task. Canceling a task stops a task currently 

occurring, whether started manually or scheduled. Removing a task removes future 

occurrences of a scheduled task.

The tasks that can be canceled after they start are:

 Connecting to a host

 Cloning a virtual machine

 Migrating a virtual machine

 Deploying a template

 Creating a template from a virtual machine

 Cloning a template

NOTE The canceling operation is not allowed if one or both of the hosts involved is an ESX 

Server version 2.0.1.
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To cancel a task that is currently running

1 From the VI Client connected to a VirtualCenter Server, view the Recent Tasks 

panel.

2 Click Show toggle at the lower‐right corner of the inventory panel.

3 Select the appropriate task from the list. 

4 Right‐click the task, and choose Cancel.

VirtualCenter stops progress on the task, returns the objects to their previous 

states, and displays the task as canceled.
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Managing Events
An event is any action that is of interest to the VirtualCenter Server or the ESX Server. 

Each event triggers an event message. All event messages are archived on the 

VirtualCenter Server’s database. View event messages from two locations:

 The Events option in the navigation bar displays all events that have occurred on 

the VirtualCenter Server. 

 An Events tab for any object under the Inventory button. These Events tab listings 

show only the events that occurred on or to the selected datacenter, host, or virtual 

machine. 

The most recent events appear at the end of a scrollable list. Messages are identified by 

type: Information, Error, or Warning. Messages are also color‐coded. A shortened event 

message appears in the description portion of the panel. A more detailed version of a 

selected event message appears in the Event Details portion of the panel. Typically, the 

Event Detail entry indicates the host or virtual machine on which the event occurred 

and describes the action that occurred. The object of the event is a link to the object’s 

individual event page.

This section contains the following:

 “Viewing All Event Messages” on page 303

 “Viewing Selected Event Messages” on page 305

 “Sorting and Filtering Event Messages” on page 306

 “Exporting Event Messages” on page 307

Viewing All Event Messages
The Events tab is available when you select a resource pool, host, or virtual machine 

object from the Inventory panel. This view of the events is available when the VI Client 

is connected to an ESX Server. 

NOTE When connected to a VirtualCenter Server, Events are combined with the Tasks tab.
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Figure 17-1.  VI Client Connected to ESX Server > Inventory > Virtual Machine > 
Events Tab

To view event details

From the Inventory panel, click the Events tab. Click an event. 

The Event Details field displays additional information about the event:

 Events are messages that report Virtual Infrastructure Client activity. Event 

messages are predefined in the product. 

 Logs are stored reference information related to selected event messages. Logs are 

predefined in the product. You can configure whether selected logs are generated 

or not.

NOTE The views and capabilities displayed vary depending on whether the VI Client is 

connected to a VirtualCenter Server or an ESX Server. Unless indicated, the process, 

task, or description applies to both kinds of connections.
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Viewing Selected Event Messages
Each object in the inventory panel has an Events tab in the information panel. Each 

event that appears is an object‐specific subset of all the server events. 

To view the event messages and event detail for an object

1 From the VI Client connected to either a VirtualCenter Server or an ESX Server, 

click the Inventory button in the navigation bar. Expand the inventory as needed.

2 In the inventory panel, select a folder, cluster, resource pool, host, or virtual 

machine, as appropriate. 

If you select a host, the event messages for all the virtual machines on that host are 

included in the Events log.

3 Click the Events tab.

4 Click the event.

A full text message with links to related objects appears in the Event Details box.

5 Click any of the blue highlighted items in the Events Details box. 

The view changes to display the selected linked object.
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Sorting and Filtering Event Messages
Sort all items in the list by clicking in the column label heading. A triangle in the column 

head shows the sort order as ascending or descending. 

To sort a list 

Click the column heading to resort the list by the entries in that column. The current 

selection does not change. 

To change ascending or descending order 

Click the column heading to toggle between ascending and descending order.

To choose items in a list 

Click an individual item. Use Shift‐click or Ctrl‐click to choose multiple items in the 

Events panel. 

To view selected columns only 

Right‐click any column head, and choose from the list of data fields to be displayed. 

To search and list selected items 

1 Choose View > Filtering to see the filtering options. 

2 Enter text into the data field. Click Clear to empty the data field.
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Entries in multiple columns that match the search term are displayed. In the 

example, the search word “power” is found in both the Description and the Task 

column entries.

Exporting Event Messages
There is an option for exporting all or part of your events log file. 

To export the events file

1 From the VI Client connected to a VirtualCenter Server, choose File > Export > 

Export Events. 

2 Specify the time range of messages and the type of messages to export.

3 Specify a file name, file type, and location for the exported file. Click the Browse 

button to view the Save As dialog box. 

The file is saved as a text file. 

4 Select the Type radio button to indicate the type of errors to include in the exported 

file. 

You can specify whether to include user‐generated or system‐generated events. 

You can specify all users, or you can specify These users and click Browse to select 

a subset of users. 
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5 Specify the time range of events to export. Options are Hours, Days, Weeks, 

Months, and From/To date ranges. 

6 Specify the number of events to export, either all or a specific number. 

7 Click OK to create a file of the selected data. 

VirtualCenter creates a file of the selected data based on the file extension provided and 

stores the file at the specified location. If no file extension is provided, the default is a 

text file. The file contains Type, Time, and Description.

Managing Alarms
Alarms are specific notifications that occur in response to selected events. Some alarms 

are defined by product default. Additional alarms can be created and applied to 

selected inventory objects or all inventory objects. 

This section contains the following topics:

 “Understanding Alarms” on page 309

 “Preparing for Email Message SMTP Alarm Notification (SEE UPDATE)” on 

page 311

 “Preparing for SNMP Alarm Notification” on page 312

 “Creating Alarms” on page 314

 “Editing Alarms” on page 320

 “Removing Alarms” on page 321

The Alarms tab in the inventory panel displays the list of alarms for the selected object 

that are activated upon designated events. Alarms can apply to hosts and virtual 

machines, and can be defined in parent entities such as folders or resource pools.

The Alarms tab has two views available through buttons:

 Alarms – Displays triggered alarms against the selected inventory item.

NOTE The views and capabilities displayed vary depending on whether the VI Client is 

connected to a VirtualCenter Server or an ESX Server. The Alarms option is not available 

when the VI Client is connected to an ESX Server. 

NOTE Alarms are configurable only through the VirtualCenter Server. ESX Server hosts 

connected to a VI Client directly do not have the alarms functionality. To get the alarm 

features, have the VirtualCenter Server manage the ESX Server.
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Figure 17-2.  VI Client Connected to VirtualCenter Server > Inventory: Hosts and 
Clusters > Host > Alarms Tab > Alarms Button

 Definitions – Displays the alarms that are monitoring the selected inventory item. 

If the event configured in an alarm occurs, the alarm is triggered and the server 

takes the configured action (for example, sends an email notification).

Figure 17-3.  VI Client Connected to VirtualCenter Server > Inventory: Hosts and 
Clusters > Host > Alarms Tab > Definitions Button

Understanding Alarms
Alarms send notification messages when selected events occur to or on hosts or virtual 

machines. Alarms indicate the status levels of an object or collection of objects in the 

hierarchy. Alarms can be defined at all hierarchical levels, including folders, 

datacenters, clusters, resource pools, hosts, and virtual machines. 

Alarms are inherited from parent levels and cannot be changed or overridden at a child 

level. When you add new alarms to any object you contribute to the collection of alarms 

that are in force at any of its child levels. 
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When an alarm is created, VirtualCenter verifies the user permissions to perform the 

actions on the relevant datacenters, hosts, and virtual machines. After the alarm is 

created, the alarm is performed even if the creating user no longer has permission to 

create the alarm.

Alarms are applied to either hosts or virtual machines. Each alarm has a triggering 

event and a notification method.

There are two kinds of alarm triggers:

 Percentage — Monitors host processor (or CPU) usage, host memory usage, 

virtual machine processor (or CPU) usage, virtual machine memory, and virtual 

machine heartbeat.

The triggering options are Is Above (percent) and Is Below (percent). The default 

monitor for virtual machine heartbeat is set to Is Below. The default monitor for all 

other percentage options is set to Is Above.

 State — Monitor host state and virtual machine state.

The triggering options are: Is (state) and Is Not (state).

There are several types of alarm notification methods:

 Send a notification email message 

SMTP sends an email message. The SMTP must be ready when the email message 

is sent. There are two ways to set SMTP: through VirtualCenter or through 

Microsoft Outlook Express. The VirtualCenter setup is not always needed if the 

SMTP setting in Outlook Express is correct. 

The VirtualCenter Server generates the subject and body text of the email message. 

Only the To list (receiver) is required from user input. Specify the email message 

address where the message should be sent. Separate the names of multiple 

recipients with commas or semicolons.

 Send a notification trap

The VirtualCenter Server is the default SNMP notification receiver. An SNMP trap 

viewer is required to view a sent trap. The VirtualCenter Server host must be 

configured to receive SNMP traps. Refer to “Preparing for SNMP Alarm 

Notification” on page 312.

 Run a script 

The user script command and its arguments must be formatted into one string.
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The user script is running as separate process and does not block the VirtualCenter 

Server processes. But the script does run and consume the resources on the 

VirtualCenter Server machine, such as processor and memory.

 Suspend the virtual machine

 Power off the virtual machine

 Reset the virtual machine

The actions available with alarms are described in the following sections:

 “Preparing for Email Message SMTP Alarm Notification (SEE UPDATE)” on 

page 311

 “Preparing for SNMP Alarm Notification” on page 312

 “Creating Alarms” on page 314

 “Editing Alarms” on page 320

 “Removing Alarms” on page 321

Preparing for Email Message SMTP Alarm Notification (SEE 
UPDATE)

If you are want to use email messages to send SMTP notifications, you must:

 Define the SMTP and email message addressing information. 

 Specify the email message address for those intended to receive the notification 

when you create the alarm.
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To define the SMTP and email message addressing information

1 From the VI Client, choose Administration > Server Settings > Mail.

2 For email message notification, set the SMTP server and SMTP port:

 SMTP Server – The DNS name or IP address of the SMTP gateway to use for 

sending email messages.

 Sender Account – The email address of the sender, for example, mail_server

datacenter.com.

3 Click OK.

Preparing for SNMP Alarm Notification
To use SNMP traps, you must configure:

 The VirtualCenter Server host.

 The SNMP receiver server to accept the traps from VirtualCenter.

When you create an alarm, only one trap is triggered and sent. The alarm parameters 

include:

 Type – The state VirtualCenter is monitoring for the alarm. Options include Host 

Processor (or CPU) usage, Host Memory usage, Host State, Virtual Machine 

Processor (or CPU) usage, Virtual Machine Memory usage, Virtual Machine State, 

Virtual Machine Heartbeat.
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 Name – The name of the host or virtual machine that triggers the alarm.

 Old Status – The alarm status before the alarm was triggered.

 New Status – The alarm status when the alarm is triggered.

 Object Value – The object value when the alarm is triggered.

To define the SNMP information

1 From the VI Client, choose File > VirtualCenter Settings, and click the Advanced 

tab.

2 Enter the SNMP and mail addressing, as appropriate.

Configure up to four receivers of SNMP traps. They must be configured in 

numerical order, 1, 2, 3, and 4. Each SNMP trap requires a corresponding host 

name, port and community. For example:

 Receiver URL – The DNS name and IP address of the SNMP receiver.

 Receiver port – The port number of the receiver.

If the port value is empty, VirtualCenter uses the default port. The default port 

is 902.

 Community String – The community identifier.

3 Click OK.
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Creating Alarms
If you plan to use email message or SNMP notification, refer to “Preparing for Email 

Message SMTP Alarm Notification (SEE UPDATE)” on page 311 and define the address 

information before you create your alarm.

To create an alarm

1 From the VI Client connected to a VirtualCenter Server, click the Inventory button. 

Expand the inventory as needed, click the appropriate object, click the Alarms tab, 

and click the Definitions button.

2 Choose File > New > Alarm.

If you start from a folder, datacenter, or cluster, the Alarm Properties dialog box 

displays the option to create an alarm for either a host or a virtual machine. If you 

start from a resource pool, host, or a virtual machine, Monitor a host or Monitor a 

VM is preselected and the other option is dimmed.
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3 Select the alarm type.

4 In the General tab, specify a name for the alarm, the object to be monitored (host 

or virtual machine), the trigger priority, and whether to enable this alarm. 

Trigger priorities can be set to Red or Green:

 Red – The default, triggers the alarms prioritized red as first, then yellow, and 

green alarms last.

 Green – Triggers the alarms prioritized as green first, then yellow, and red 

alarms last.

5 To define the alarm but not make it active, deselect the Enable box.

6 Click the Triggers tab and the Add button.
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In the Triggers tab, there are four pull‐down menus:

 Trigger Type

The options listed apply to either the host or virtual machine.

For host alarms, the options are Host Processor (or CPU) Usage, Host 

Memory Usage, Host Network Usage, Host Disk Usage, and Host State.

For virtual machine alarms, the options are VM Processor (or CPU) Usage, 

VM Memory Usage, VM Network Usage, VM Disk Usage, and VM State.

 Condition

The options for percentage triggers are Is Above (percent) and Is Below 

(percent).

The options for state triggers are Is (state) and Is Not (state).

 Warning (Yellow) state or percentage and Alert (Red) state or percentage

Percentage options range from 5 percent to 100 percent in 5 percent 

increments. Exiting condition is considered a yellow condition at n 

percentage.

Virtual machine state options correspond to these activities: Creating, 

Migrating, Connecting, Disconnecting, Migrating with VMotion, 

Reconnecting, Removing, Resetting, Resuming, Starting, Stopping, 

Suspending, Disconnected, Initial, Orphaned, Powered Off, Powered On, and 

Suspended. Host state options correspond to these activities: Connecting, 

Disconnecting, Reconnecting, Removing, Shutting down, Connected, and 

Disconnected. Exiting state is considered a yellow condition at selected state.

The colors corresponding to the exiting/from and entering/to states are set in 

the Actions tab. The default is From yellow to red.
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7 (Optional) Define multiple conditions for the alarm triggering event. Click Add. 

Enter the parameters for each condition. 

8 Specify the reporting frequency when the alarm is triggered. Enter a value for 

Tolerance and one for Frequency. 
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9 Specify the action to be taken when the alarm is triggered.

10 Click the Actions tab. Click the Add button. Click the appropriate check box.

There are four different level changes: green to yellow, yellow to red, red to yellow, 

and yellow to green. Attach an action for each change from one level to another.

11 Choose the action to be taken when the event is triggered and specify the 

associated information. 

The options are:

 Send a notification email.

Provide the email address of the notification recipient in the Value field.

SMTP sends a notification email. The SMTP must be ready when the email is 

sent. There are two ways to set SMTP: through VirtualCenter or through 

Microsoft Outlook Express. VirtualCenter setup is not always needed if the 

SMTP setting in Outlook Express is correct.

VirtualCenter Server generates the email message subject and body text. Only 

the “to” list (receiver) is required from user input. Specify the email address 

to which the message should be sent. Separate multiple recipients with 

commas or semicolons. Refer to “Preparing for Email Message SMTP Alarm 

Notification (SEE UPDATE)” on page 311.

 Send a notification trap.

There is a default SNMP notification receiver, the VirtualCenter Server. An 

SNMP trap viewer is required to view a sent trap. The VirtualCenter Server 
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host must be configured to receive SNMP traps. Refer to “Preparing for SNMP 

Alarm Notification” on page 312.

 Run a script. (SEE UPDATE)

Provide the path to the script.

The user script command and its arguments must be formatted into one 

string.

The user script runs in other processes and does not block the VirtualCenter 

Server from running. However, the script consumes server resources, such as 

processor and memory. 

{eventDescription} — full formatted message for alarm triggering 
event
{entityName} — name of the entity name where the alarm is triggered
{alarmName} — name of the alarm that is triggered
{triggeringSummary} — summary info of the alarm with triggering 
values
{declaringSummary} — summary info of the alarm declaration
{oldStatus} — alarm status before it is triggered
{newStatus} — alarm status after it is triggered
{entityObject} — inventory object as triggering alarm
Example scripts:
"c:\MyAlarmProcess.bat {entityName} {alarmName}"

Two alarm‐triggering parameters are passed to the back file. The first 

parameter is the name of the entity, and the second is the name of the alarm. 

When the entity name is MyEntity and alarm name is MyAlarm, the script 
becomes "c:\MyAlarmProcess.bat MyEntity MyAlarm".

"d:\tools\alarm.exe '{entityName}' '{alarmName}' {newStatus}"

Three alarm‐triggering parameters are passed to the execution file. The first is 

the entity name, the second is the alarm name, and the third is the alarm status 

after triggering. When the entity name is my dummy vm, the alarm name is my 
test alarm, and the new status is red, the script becomes:

"d:\tools\alarm.exe ‘my dummy vm’ ‘my test alarm’ red”

 Power on, Power off, Suspend, or Reset the virtual machine.

These apply only to a virtual machine alarm. 

12 To complete the alarm, click OK.
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VirtualCenter verifies the configuration of the alarm and adds the alarm to the list 

of alarms for the selected object.

Notice that the Defined In column indicates where in the inventory hierarchy the 

alarm is defined.

Editing Alarms
Alarms can be modified, but you must edit them at the hierarchical level where they 

were created. A simple change is to enable or disable the alarm. If an alarm is disabled, 

an X appears on the alarm listing icon.

To edit an existing alarm

1 From the VI Client connected to a VirtualCenter Server, click the Inventory button 

in the navigation bar. Expand the inventory as needed, click the Alarms tab, and 

click the Definitions button.

2 If the alarm you want to change is not defined at the current location, click the 

linked object in the Defined in column. 

VirtualCenter displays the Alarms panel for the object where the alarm was 

defined.
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3 Select the alarm to edit. Choose Inventory > Alarm > Edit Settings. The entry in 

the Defined in column for the alarm must be This object. 

4 Edit the alarm general settings, triggers, or actions, as needed. Click OK.

VirtualCenter verifies the configuration of the alarm and edits the alarm for the 

selected object. Refer to “Creating Alarms” on page 314 for additional information.

Removing Alarms
Remove alarms from the object in which they were defined. You cannot remove them 

from a child that inherited the alarm. 

To remove an alarm

1 From the VI Client connected to a VirtualCenter Server, click the Inventory button 

in the navigation bar. Expand the inventory as needed, click the Alarms tab, and 

click the Definitions button.

2 If the alarm you want to change is not defined at the current location, click the 

linked object in the Defined in column. VirtualCenter displays the Alarms panel 

for the object where the alarm was defined.
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3 To remove the alarm, select the alarm, and choose Inventory > Alarm > Remove.

A confirmation pop‐up window appears. 

4 Click Yes. 

The alarm is removed.
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A

The following tables list the default privileges that, when selected for a role, can be 

paired with a user and assigned to an object. The following tables use VC to indicate 

VirtualCenter Server and HC to indicate Host Client, a standalone ESX Server. 

When setting permissions, verify all the object types are set with appropriate privileges 

for each particular action. Some operations require access permission at the root folder 

or parent folder in addition to access to the object being manipulated. Some operations 

require access or performance permission at a parent folder and a related object. Refer 

to Chapter 15, “Managing Users, Groups, Permissions, and Roles,” on page 247 for 

information on applying privileges to inventory objects.

Refer to Table 15‐1, “Default Roles,” on page 255 for a list of predefined grouped 

privileges. 

This appendix contains these topics:

 “Alarm Management” on page 326

 “Datacenter” on page 327

 “Datastore” on page 327

 “Folders” on page 328

 “Global” on page 329

 “Host Configuration” on page 330

 “Host Inventory” on page 331

 “Host Local Operations” on page 332

 “Network” on page 333

Defined Privileges A
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 “Permissions” on page 334

 “Performance” on page 333

 “Permissions” on page 334

 “Scheduled Task” on page 336

 “Sessions” on page 336

 “Virtual Machine Configuration” on page 337

 “Virtual Machine Interaction” on page 339

 “Virtual Machine Inventory” on page 340

 “Virtual Machine Provisioning” on page 341

 “Virtual Machine State” on page 342

Alarm Management
Table A-1.  Alarm Management Privileges

Privilege 
Name Description Used

Pair with 
Object

Effective 
on Object

Create Alarm1 Creates a new alarm.

User interface element – Alarm tab 
pop‐up menu, File menu

VC only Alarm 
object 
parent

All 
inventory 
items

Delete Alarm Deletes an existing alarm.

User interface element – Alarm tab 
pop‐up menu, File menu

VC only Alarm 
object 
parent

All 
inventory 
items

Modify Alarm Changes the properties of an existing 
alarm.

User interface element – Alarm tab 
pop‐up menu, File menu

VC only Alarm 
object 
parent

All 
inventory 
items

1 When creating alarms with a custom action, privilege to perform the action is verified when the use 
creates the alarm.
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Datacenter

Datastore

Table A-2.  Datacenter Privileges

Privilege 
Name Description Affects

Pair with 
Object

Effective on 
Object

Create 
Datacenter

Creates a new datacenter.

User interface element – Inventory 
pop‐up menu, toolbar button, and File > 
New Datacenter

VC only Datacenter Datacenter 
folders

Delete 
Datacenter

Removes a datacenter.

User interface element – Inventory 
pop‐up menu, Inventory > Datacenter > 
Remove, Edit > Remove

VC only Datacenter 
plus parent 
object

Datacenters

Move 
Datacenter

Moves a datacenter.

Privilege must be present at both the 
source and destination.

User interface element – Inventory 
drag‐and‐drop

VC only Datacenter, 
source and 
destination

Datacenters, 
Datacenter 
folders

Rename 
Datacenter

Changes the name of a datacenter.

User interface element – Inventory 
object, inventory pop‐up menu, Edit > 
Rename, Inventory > Datacenter > 
Rename

VC only Datacenter Datacenters

Table A-3.  Datastore Privileges

Privilege 
Name Description Affects

Pair with 
Object

Effective on 
Object

Browse 
Datastore

Browses files on a datastore.

User interface element – Add existing 
disk, browse for CD‐ROM or Floppy 
media, serial or parallel port files

HC and VC Datastores Datastores

Delete 
Datastore

Removes a datastore.

User interface element – Inventory 
datastore pop‐up menu, Edit > Remove, 
Inventory > Datastore > Remove

HC and VC Datastores Datastores
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Folders

Delete 
Datastore File

Deletes a file in the datastore.

User interface element – Datastore 
Browser toolbar button and Datastore 
pop‐up menu

HC and VC Datastores Datastores

Rename 
Datastore

Renames a datastore.

User interface element – Datastore 
Properties dialog Change button, host 
Summary tab pop‐up menu

HC and VC Datastores Datastores

Table A-3.  Datastore Privileges (Continued)

Privilege 
Name Description Affects

Pair with 
Object

Effective on 
Object

Table A-4.  Folder Privileges

Privilege 
Name Description Affects

Pair with 
Object

Effective on 
Object

Create Folder Creates a new folder.

User interface element – Taskbar 
button, File menu, pop‐up menu

VC only Folders Folders

Delete Folder Deletes a folder.

User interface element – File menu, 
pop‐up menu

VC only Folders plus 
parent object

Folders

Move Folder Moves a folder.

Privilege must be present at both the 
source and destination.

User interface element – Inventory 
drag‐and‐drop

VC only Folders, 
source and 
destination

Folders

Rename Folder Changes the name of a folder.

User interface element – Inventory 
pane object text field, pop‐up menu, File 
menu

VC only Folders Folders
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Global
Table A-5.  Global Privileges

Privilege 
Name Description Affects

Pair with 
Object

Effective on 
Object

Cancel Task Cancels a running or queued task.

User interface element – Recent tasks 
pane pop‐up menu, Tasks & Events 
pop‐up menu. Can currently cancel 
clone and clone to template.

HC and VC Any object Inventory 
object 
related to the 
task

Diagnostics Gets list of diagnostic files, log header, 
binary files, or diagnostic bundle.

User interface element – File > Export > 
Export Diagnostic Data, Admin System 
Logs tab

VC only Any object Root folder

Licenses Sees what licenses are installed and 
adds or removes licenses.

User interface element – Licenses tab, 
Configuration > Licensed Features

HC and VC Any object Root folder

Log Event Logs a user‐defined event against a 
particular managed entity.

User interface element – Should ask for 
a reason when shutting down or 
rebooting a host.

HC and VC All objects All 
inventory 
objects

Manage 
Custom 
Properties

Adds, removes, renames custom fields 
for a managed entity.

User interface element – 
Administration > Custom Attributes

VC only All objects Root folder

Set Custom 
Properties

Views, creates, and removes custom 
fields.

User interface element – Any list view 
shows the fields defined and allows 
setting them

VC only All objects All 
inventory 
objects

Settings Reads and modifies runtime VC 
configuration settings.

User interface element – 
Administration > VMware 
VirtualCenter Settings file menu

VC only All objects Root folder

VC Server Prepares or initiates a VMotion send 
operation or a VMotion receive 
operation.

No user VI Client interface elements are 
associated with this privilege.

VC only All objects Root folder
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Host Configuration
Table A-6.  Host Configuration Privileges

Privilege 
Name Description Affects

Pair with 
Object

Effective on 
Object

Advanced 
Configuration

Sets advanced options in host 
configuration.

User interface element – Host Config > 
Advanced Settings, Inventory hierarchy 
pop‐up menu

HC and VC Hosts Hosts

Change SNMP 
Settings

Edits, restarts, and stops SNMP agent.

No user VI Client interface elements are 
associated with this privilege.

HC and VC Hosts Hosts

Connection Changes the connection status of a host 
(connected or disconnected).

User interface element – Right‐click 
Host

VC only Hosts Hosts

Hyper 
Threading

Enables and disables hyperthreading in 
the host CPU scheduler.

User interface element – Host Config > 
Processors

HC and VC Hosts Hosts

Maintenance Puts the host in and out of maintenance 
mode, shuts down and restarts the host.

User interface element – Host pop‐up 
menu, Inventory > Host > Enter 
Maintenance Mode

HC and VC Hosts Hosts

Memory 
Configuration

Sets configured service console memory 
reservation.

User interface element – Host Config > 
Memory

HC and VC Hosts Hosts

Internet 
Service

Enables and disables internet services 
provided by service console, such as 
SSH, Telnet, SNMP.

User interface element – Host Config > 
Security Profile

HC and VC Hosts Hosts

Network 
Configuration

Configures network, firewall, and 
VMotion network.

User interface element – Host Config > 
Networking, Network Adapter, DNS 
and Routing

HC and VC Hosts Hosts
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Host Inventory

System 
Resource 
Settings

Updates the configuration of the system 
resource hierarchy.

User interface element – Host Config > 
System Resource Allocation

HC and VC Hosts Hosts

Storage 
Partition 
Configuration

Manages VMFS datastore and 
diagnostic partitions. Scans for new 
storage devices. Manages iSCSI.

User interface element – Host Config > 
Storage, Storage Adapters, Host 
Configuration tab datastore pop‐up 
menu

HC and VC Hosts Hosts

Virtual 
Machine 
Auto‐start 
Configuration

Changes auto‐start and auto‐stop order 
of virtual machines on a single host.

User interface element – Host Config > 
Virtual Machine Startup or Shutdown

HC and VC Hosts Hosts

Table A-6.  Host Configuration Privileges (Continued)

Privilege 
Name Description Affects

Pair with 
Object

Effective on 
Object

Table A-7.  Host Inventory Privileges

Privilege 
Name Description Affects

Pair with 
Object

Effective on 
Object

Add Host To 
Cluster

Adds a host to an existing cluster.

User interface element – Inventory 
pop‐up menu

VC only Hosts Clusters

Add 
stand‐alone 
Host

Adds a standalone host.

User interface element – Toolbar 
button, inventory pop‐up menu, 
Inventory > Datacenter > Add Host, File 
> New > Add Host, Host tab pop‐up 
menu

VC only Hosts Datacenters, 
Host folders

Create Cluster Creates a new cluster.

User interface element – Toolbar 
button, inventory pop‐up menu, 
Inventory > Datacenter > New Cluster, 
File > New > Cluster

VC only Clusters Datacenters, 
Host folders

Delete Cluster Deletes a cluster or standalone host.

User interface element – Inventory 
pop‐up menu, Edit > Remove, 
Inventory > Cluster > Remove

VC only Clusters plus 
parent object

Clusters, 
Hosts
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Host Local Operations

Modify 
Cluster

Changes the properties of a cluster.

User interface element – Inventory 
pop‐up menu, Inventory > Cluster > 
Edit Settings, Summary tab

VC only Clusters Clusters

Move Cluster Moves a cluster between folders.

Privilege must be present at both the 
source and destination.

User interface element – Inventory 
hierarchy

VC only Clusters, 
source and 
destination

Clusters, 
Host folders

Move Host Moves a set of existing hosts into a 
cluster.

Privilege must be present at both the 
source and destination.

User interface element – Inventory 
hierarchy drag‐and‐drop

VC only Hosts, source 
and 
destination

Clusters, 
Host folders

Remove Host 
From Cluster

Destroys a host in a cluster or 
standalone host.

User interface element – Inventory 
drag‐and‐drop out of cluster, pop‐up 
menu, Inventory > Host > Remove

VC only Clusters plus 
parent object

Clusters, 
Host folders

Rename 
Cluster

Renames a cluster.

User interface element – Inventory 
single click, inventory hierarchy pop‐up 
menu, Inventory > Cluster > Rename

VC only Clusters Clusters

Table A-7.  Host Inventory Privileges (Continued)

Privilege 
Name Description Affects

Pair with 
Object

Effective on 
Object

Table A-8.  Host Local Operations Privileges

Privilege 
Name Description Affects

Pair with 
Object

Effective on 
Object

Create Virtual 
Machine

Creates a new virtual machine from 
scratch on a disk without registering it 
on the host.

No user VI Client interface elements are 
associated with this privilege.

HC only Root folder Root folder

Delete Virtual 
Machine

Deletes a virtual machine on disk, 
whether registered or not.

No user VI Client interface elements are 
associated with this privilege.

HC only Root folder Root folder
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Network

Performance

Install Agent Installs and uninstalls various agents on 
a host, for example, vpxa and aam.

No user VI Client interface elements are 
associated with this privilege.

HC only Root folder Root folder

Manage User 
Groups

Manages local accounts on a host.

User interface element – Users & 
Groups tab (only present if the VI Client 
logs on to the host directly)

HC only Root folder Root folder

Table A-8.  Host Local Operations Privileges (Continued)

Privilege 
Name Description Affects

Pair with 
Object

Effective on 
Object

Table A-9.  Network Privileges

Privilege 
Name Description Affects

Pair with 
Object

Effective on 
Object

Delete 
Network

Removes a network.

User interface element – Inventory 
network pop‐up menu, Edit > Remove, 
Inventory > Network > Remove

HC and VC Datacenter Datacenters

Table A-10.  Alarm Management Privileges

Privilege 
Name Description Affects

Pair with 
Object

Effective 
on Object

Modify 
Intervals

Creates, removes, and updates 
performance data collection intervals.

User interface element – VC Settings > 
Statistics

VC only Root folder Root folder
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Permissions

Resource

Table A-11.  Permissions Privileges

Privilege 
Name Description Used

Pair with 
Object

Effective 
on Object

Modify 
Permission

Defines one or more permission rules 
on an entity, or updates rules if already 
present for the given user or group on 
the entity.

User interface element – Permissions 
tab pop‐up menu, Inventory > 
Permissions menu

HC and VC Any object 
plus parent 
object

All 
inventory 
items

Modify Role Updates a roleʹs name and the 
privileges.

User interface element – Roles tab 
pop‐up menu, toolbar button, File 
menu

HC and VC Any object Root folder

Reassign Role 
Permissions

Reassigns all permissions of a role to 
another role.

User interface element – Delete Role 
dialog box radio button and associated 
menu

HC and VC Any object Root folder

Table A-12.  Resource Privileges

Privilege 
Name Description Affects

Pair with 
Object

Effective on 
Object

Apply 
Recommenda‐
tion

Asks the server to go ahead with a 
suggested VMotion.

User interface element – Cluster 
Migrations tab

VC only Clusters Clusters

Assign Virtual 
Machine To 
Pool

Assigns virtual machines to a resource 
pool.

User interface element – VM Creation 
wizard

HC and VC Resource 
pools

Resource 
pools

Cold Migrate Migrates a virtual machineʹs execution 
to a specific resource pool or host.

User interface element – Inventory 
pop‐up menu, VM Summary tab, 
Inventory > VM > Migrate, drag‐and‐ 
drop

VC only Virtual 
machines

Virtual 
machines
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Create Pool Creates a new resource pool.

User interface element – File menu, 
pop‐up menu, Summary tab, Resources 
tab

HC and VC Resource 
pools, 
clusters

Resource 
pools, 
clusters

Delete Pool Deletes a resource pool.

User interface element – Edit > 
Remove, Inventory > Resource Pool > 
Remove, inventory pop‐up menu, 
Resources tab

HC and VC Resource 
pools plus 
parent 
object

Resource 
pools

Edit Pool Changes the allocations of a resource 
pool.

User interface element – Inventory > 
Resource Pool > Remove, Resources tab

HC and VC Resource 
pools plus 
parent 
object

Resource 
pools

Hot Migrate Migrates a virtual machineʹs execution 
to a specific resource pool or host.

User interface element – Inventory 
pop‐up menu, VM Summary tab, 
Inventory > VM > Migrate, drag‐and‐ 
drop

VC only Virtual 
machines

Virtual 
machines

Move Pool Moves a resource pool.

Privilege must be present at both the 
source and destination.

User interface element – 
Drag‐and‐drop

HC and VC Resource 
pools, 
source and 
destination

Resource 
pools

Query 
VMotion

Investigates the general VMotion 
compatibility of a virtual machine with 
a set of hosts.

User interface element – Required 
when displaying the migration wizard 
for a powered‐on VM, to check 
compatibility

VC only Root folder Root folder

Rename Pool Renames a resource pool.

User interface element – Edit > 
Rename, Inventory > Resource Pool > 
Rename, single‐click, pop‐up menu

HC and VC Resource 
pools

Resource 
pools

Table A-12.  Resource Privileges (Continued)

Privilege 
Name Description Affects

Pair with 
Object

Effective on 
Object
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Scheduled Task

Sessions

Table A-13.  Scheduled Task Privileges

Privilege 
Name Description Affects

Pair with 
Object

Effective on 
Object

Create Tasks1 Schedules a task. Requires the 
privileges to perform the scheduled 
action at the time of scheduling.

User interface element – Scheduled 
Tasks toolbar button and pop‐up menu

VC only All inventory 
objects

All inventory 
objects

Delete Task Removes a scheduled task from the 
queue.

User interface element – Scheduled 
Tasks pop‐up menu, Inventory > 
Scheduled Task > Remove, Edit > 
Remove

VC only All inventory 
objects

All inventory 
objects

Modify Task Reconfigures the scheduled task 
properties.

User interface element – Inventory > 
Scheduled Tasks > Edit, Scheduled 
Tasks tab pop‐up menu

VC only All inventory 
objects

All inventory 
objects

Run Task Runs the scheduled task immediately.

User interface element – Scheduled 
Tasks pop‐up menu, Inventory > 
Scheduled Task > Run

VC only All inventory 
objects

All inventory 
objects

1 Creating and running a task (on‐demand) requires permission to invoke the associated action. For 
example, Alarms requires permissions on a folder to create alarms on objects in that folder.

Table A-14.  Session Privileges

Privilege 
Name Description Affects

Pair with 
Object

Effective on 
Object

Global 
Message

Sets the global logon message.

User interface element – Sessions tab, 
Administration > Edit Message of the 
Day

VC only Root folder Root folder

Terminate 
Session

Forces log off of one or more logged‐on 
users.

User interface element – Sessions tab

VC only Root folder Root folder
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Virtual Machine Configuration
Table A-15.  Virtual Machine Privileges

Privilege 
Name Description Affects

Pair with 
Object

Effective on 
Object

Add Existing 
Disk

Adds a virtual disk that refers to an 
existing virtual disk.

User interface element – VM 
Configuration

HC and VC Virtual 
machines

Virtual 
machines

Add New Disk Adds a virtual disk that creates a new 
virtual disk.

User interface element – VM 
Configuration

HC and VC Virtual 
machines

Virtual 
machines

Add or 
Remove 
Device

Adds or removes any non‐disk device.

User interface element – VM 
Configuration

HC and VC Virtual 
machines

Virtual 
machines

Advanced  Changes values in extraConfig.

User interface element – VM 
Configuration Wizard > Options tab > 
Advanced ‐ look for Configuration 
Parameters button

HC and VC Virtual 
machines

Virtual 
machines

Change CPU 
Count

Changes the number of virtual CPUs.

User interface element – VM 
Configuration

HC and VC Virtual 
machines

Virtual 
machines

Disk Lease Leases disks for VMware Consolidated 
Backup.

No user VI Client interface elements are 
associated with this privilege.

HC and VC Virtual 
machines

Virtual 
machines

Memory Changes the amount of memory 
allocated to the VM.

User interface element – VM 
Configuration > Memory

HC and VC Virtual 
machines

Virtual 
machines

Modify Device 
Settings

Changes the properties of an existing 
device.

User interface element – VM 
Configuration ‐ SCSI/IDE node 
selection

HC and VC Virtual 
machines

Virtual 
machines

Raw Device1 Adds or removes a raw disk mapping 
or SCSI pass through device.

User interface element – VM 
Configuration > Add/Remove raw disk 
mapping

HC and VC Virtual 
machines

Virtual 
machines
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Remove Disk Removes a virtual disk device.

User interface element – VM 
Configuration > Hard Disk (but not a 
raw disk mapping)

HC and VC Virtual 
machines

Virtual 
machines

Rename Renames a virtual machine or modifies 
the associated notes of a virtual 
machine.

User interface element – VM 
Configuration, inventory, inventory 
pop‐up menu, File menu, Inventory 
menu

HC and VC Virtual 
machines

Virtual 
machines

Reset Guest 
Information

Clears guestinfo variables.

No user VI Client interface elements are 
associated with this privilege.

HC and VC Virtual 
machines

Virtual 
machines

Resource Changes resource configuration of a set 
of VM nodes in a given resource pool.

HC and VC Virtual 
machines

Virtual 
machines

Settings Changes general VM settings.

User interface element – VM 
Configuration > Options tab (except VM 
name)

HC and VC Virtual 
machines

Virtual 
machines

Upgrade 
Virtual 
Hardware

Upgrades the virtual machine’s virtual 
hardware version from a previous 
version of VMware.

User interface element – Pop‐up menu, 
File menu (appears only if vmx file 
shows a lower configuration number)

HC and VC Virtual 
machines

Virtual 
machines

1 Setting this parameter overrides any other privilege for modifying raw devices, including connection 
states.

Table A-15.  Virtual Machine Privileges (Continued)

Privilege 
Name Description Affects

Pair with 
Object

Effective on 
Object
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Virtual Machine Interaction
Table A-16.  Virtual Machine Interaction

Privilege 
Name Description Affects

Pair with 
Object

Effective on 
Object

Answer 
Question

Resolves issues with VM state 
transitions or runtime errors.

User interface element – Summary tab, 
Inventory menu, pop‐up menu

HC and VC Virtual 
machines

Virtual 
machines

Console 
Interaction

Interacts with the virtual machine’s 
virtual mouse, keyboard, and screen; 
gets screen shot information.

User interface element – Console tab, 
toolbar button, Inventory > Virtual 
Machine > Open Console, inventory 
pop‐up menu

HC and VC Virtual 
machines

Virtual 
machines

Device 
Connection

Changes the connected state of a virtual 
machine’s disconnectable virtual 
devices.

User interface element – VM 
Configuration

HC and VC Virtual 
machines

Virtual 
machines

Power Off Powers off a powered‐on virtual 
machine, shuts down guest.

User interface element – File menu 
item, pop‐up menu, pop‐up console 
menu, toolbar button, Summary tab

HC and VC Virtual 
machines

Virtual 
machines

Power On Powers on a powered‐off virtual 
machine, resumes a suspended virtual 
machine.

User interface element – File menu 
item, pop‐up menu, pop‐up console 
menu, toolbar button, Summary tab

HC and VC Virtual 
machines

Virtual 
machines

Reset Resets VM, reboots guest.

User interface element – File menu 
item, pop‐up menu, pop‐up console 
menu, toolbar button, Summary tab

HC and VC Virtual 
machines

Virtual 
machines

Set CD Media Changes the backing of a CD‐ROM 
device.

User interface element – VM 
Configuration > DVD/CD‐ROM

HC and VC Virtual 
machines

Virtual 
machines

Set Floppy 
Media

Changes the backing of a floppy device.

User interface element – VM 
Configuration

HC and VC Virtual 
machines

Virtual 
machines
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Virtual Machine Inventory

Suspend Suspends a powered‐on virtual 
machine, puts guest in standby mode.

User interface element – File menu 
item, pop‐up menu, pop‐up console 
menu, toolbar button, Summary tab

HC and VC Virtual 
machines

Virtual 
machines

Tools Install Mounts and unmounts the VMware 
Tools CD installer as a CD‐ROM for the 
guest operating system.

User interface element – File menu 
item, pop‐up menu, pop‐up console 
menu

HC and VC Virtual 
machines

Virtual 
machines

Table A-16.  Virtual Machine Interaction (Continued)

Privilege 
Name Description Affects

Pair with 
Object

Effective on 
Object

Table A-17.  Virtual Machine Inventory Privileges

Privilege 
Name Description Affects

Pair with 
Object

Effective on 
Object

Create Creates a new virtual machine and 
allocates resources for its execution.

User interface element – File menu, 
pop‐up menu, Summary tab ‐ New 
Virtual Machine links

HC and VC Parent 
folders

Virtual 
machine 
folders

Delete Deletes a virtual machine, optionally 
removes underlying files from disk. 

User interface element – File menu, 
pop‐up menu, Summary tab

HC and VC Virtual 
machines 
plus parent 
folders

Virtual 
machines

Move Relocates a virtual machine in the 
hierarchy.

Privilege must be present at both the 
source and destination.

User interface element – Inventory 
hierarchy drag‐and‐drop in Virtual 
Machines & Templates view

VC only Virtual 
machines, 
parent 
folders

Virtual 
machines, 
virtual 
machine 
folders
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Virtual Machine Provisioning
Table A-18.  Virtual Machine Provisioning Privileges

Privilege Name Description Affects
Pair with 
Object

Effective on 
Object

Allow Disk 
Access

Opens a disk on a virtual machine for 
random read and write access. Used 
mostly for remote disk mounting.

No user VI Client interface elements are 
associated with this privilege.

n/a Virtual 
machines

Virtual 
machines

Allow ReadOnly 
Disk Access

Opens a disk on a virtual machine for 
random read access. Used mostly for 
remote disk mounting.

No user VI Client interface elements are 
associated with this privilege.

n/a Virtual 
machines

Virtual 
machines

Allow Virtual 
Machine Files 
Download

Reads files associated with a virtual 
machine, including vmx, disks, logs, 
and nvram.

No user VI Client interface elements are 
associated with this privilege.

HC and 
VC

Virtual 
machines

Root folders

Allow Virtual 
Machine Files 
Upload

Writes files associated with a virtual 
machine, including vmx, disks, logs, 
and nvram.

No user VI Client interface elements are 
associated with this privilege.

HC and 
VC

Virtual 
machines

Root folders

Clone Clones an existing virtual machine and 
allocates resources.

User interface element – File menu, 
pop‐up menu, Summary tab

VC only Virtual 
machines

Virtual 
machines

Clone Template Clones a template.

User interface element – File menu, 
pop‐up menu, Virtual Machines tab

VC only Virtual 
machines

Virtual 
machines

Create Template 
From Virtual 
Machine

Creates a new template from a virtual 
machine.

User interface element – “Clone to 
template...” File menu, pop‐up menu, 
Summary tab items

VC only Virtual 
machines

Virtual 
machines

Customize Customizes a virtual machine’s guest 
operating system without moving the 
VM.

User interface element – Clone Virtual 
Machine Wizard: Guest Customization

VC only Virtual 
machines

Virtual 
machines
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Virtual Machine State

Deploy Template Creates a new virtual machine from a 
template.

User interface element – “Deploy to 
template” file menu, pop‐up menu 
items, Virtual Machines tab

VC only Virtual 
machines

Virtual 
machines

Mark As 
Template

Marks an existing, powered off VM as a 
template.

User interface element – “Convert to 
template...” File menu, pop‐up menu 
items, Virtual Machines tab, Summary 
tab

VC only Virtual 
machines

Virtual 
machines

Mark As Virtual 
Machine

Marks an existing template as a VM.

User interface element – “Convert to 
Virtual Machine...” File menu, pop‐up 
menu items, Virtual Machines tab

VC only Virtual 
machines

Virtual 
machines

Modify 
Customization 
Specs

Creates, modifies, or deletes 
customization specifications.

User interface element – 
Customization Specifications Manager

VC only Root folder Root folder

Read 
Customization 
Specs

Views the customization specifications 
defined on the system.

User interface element – Edit > 
Customization Specifications

VC only Root folder Root folder

Table A-18.  Virtual Machine Provisioning Privileges (Continued)

Privilege Name Description Affects
Pair with 
Object

Effective on 
Object

Table A-19.  Virtual Machine State Privileges

Privilege 
Name Description Affects

Pair with 
Object

Effective on 
Object

Create 
Snapshot

Creates a new snapshot from the virtual 
machine’s current state.

User interface element – Pop‐up menu, 
toolbar button, Inventory menu

HC and VC Virtual 
machines

Virtual 
machines

Remove 
Snapshot

Removes a snapshot from the snapshot 
history.

User interface element – Pop‐up menu, 
toolbar button, Inventory menu

HC and VC Virtual 
machines

Virtual 
machines
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Rename 
Snapshot

Renames this snapshot with either a 
new name or a new description or both.

No user VI Client interface elements are 
associated with this privilege.

HC and VC Virtual 
machines

Virtual 
machines

Revert To 
Snapshot

Sets the VM to the state it was in at a 
given snapshot.

User interface element – Pop‐up menu, 
toolbar button, Inventory menu, Virtual 
Machines tab

HC and VC Virtual 
machines

Virtual 
machines

Table A-19.  Virtual Machine State Privileges (Continued)

Privilege 
Name Description Affects

Pair with 
Object

Effective on 
Object
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B

If you plan to customize a Windows guest operating system, you must first install the 

Microsoft Sysprep tools on your VirtualCenter Server machine. 

Microsoft includes the Sysprep tool set on the installation CD‐ROM discs for Windows 

2000, Windows XP, and Windows 2003. It also distributes Sysprep 1.1 from the 

Microsoft Web site. To perform a Windows customization, you must install the Sysprep 

tools either from your installation disc, or from the 1.1 download package. 

During customization, VirtualCenter searches for the Sysprep package corresponding 

to your guest operating system. If the Sysprep tools are not found under the 

corresponding operating system directory, VirtualCenter searches in the provided 

\1.1 directory. If VirtualCenter does not find any Sysprep tools, the Windows virtual 

machine customization does not proceed.

To install the Microsoft Sysprep tools from a Microsoft Web site download

1 Download the Sysprep package from:

http://www.microsoft.com/windows2000/downloads/tools/sysprep/default.asp

Although the Sysprep version indicates Windows 2000, it works with both 

Windows XP Professional and Windows Server 2003.

2 Click Next to continue.

3 Click I agree to accept the terms and conditions.

4 Click Download.

5 Save the file to your local disk.

6 Run the Microsoft installer:

Installing the Microsoft 
Sysprep Tools B
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Q257813_w2k_spl_x86_en.exe

7 Extract the files to the provided directory.

The following Sysprep support directories were created during VirtualCenter 

installation:

C:\<ALLUSERSPROFILE>\Application Data\Vmware\VMware VirtualCenter\sysprep
...\1.1\
...\2k\
...\xp\
...\svr2003\
where <ALLUSERSPROFILE> is usually \Documents And Settings\All Users\. 
This is where vpxd.cfg is also located.

Select the 1.1 subdirectory. 

8 Click OK to expand the files.

After you have extracted the files from Q257813_w2k_spl_x86_en.exe to the 
\1.1 directory, you should see:

...\1.1\docs\

...\1.1\samples\

...\1.1\tools\

...\1.1\contents.txt

To install the Microsoft Sysprep tools from the Windows operating system CD

1 Insert the Windows operating system CD into the CD‐ROM drive (often the D: 

drive.

2 Locate the DEPLOY.CAB file in the CD directory, \Support\Tools.

3 Open and expand the DEPLOY.CAB file, using a tool such as Winzip.exe or another 

tool capable of reading Microsoft CAB files.

4 Extract the files to the directory appropriate to your Sysprep guest operating 

system.

The following Sysprep support directories were created during VirtualCenter 

installation:

C:\<ALLUSERSPROFILE>\Application Data\Vmware\VMware VirtualCenter\sysprep
...\1.1\
...\2k\
...\xp\
...\svr2003\

where <ALLUSERSPROFILE> is usually \Documents And Settings\All Users\. 
This is where vpxd.cfg is also located.
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Select the subdirectory that corresponds to your operating system.

5 Click OK to expand the files.

After you have extracted the files from DEPLOY.CAB, you should see:

...\<guest>\deptool.chm

...\<guest>\readme.txt

...\<guest>\setupcl.exe

...\<guest>\setupmgr.exe

...\<guest>\setupmgx.dll

...\<guest>\sysprep.exe

...\<guest>\unattend.doc

where <guest> is either 2k, xp, or svr2003.

6 Repeat this procedure to extract Sysprep files for each of the Windows guest 

operating systems (Windows 2000, Windows XP, or Windows 2003) you plan to 

customize using VirtualCenter.

You are now ready to customize a new virtual machine with a supported Windows 

guest operating system when you clone an existing virtual machine.
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C

The following table lists the measurement options for each resource monitored on a 

host. The following tables use VC to indicate VirtualCenter Server and H to indicate 

Host Client, a standalone ESX Server.

Performance Chart 
Measurements C
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CPU

Disk

Table C-1.  CPU Performance Chart

Inventory Resource

Cluster R Pool VM Host Name Item Measured

CPU Performance Chart

VC H VC H CPU usage as percentage over the collected 
interval 

VC  VC H VC H VC H CPU usage in MHz over the collected 
interval 

VC H CPU reserved capacity

VC H CPU time spent on wait state

VC H CPU time spent on ready state

VC H CPU time spent on system processes

VC H CPU time that is extra

VC H CPU time that is guaranteed

Table C-2.  Disk Performance Chart

Inventory Object Resource

Cluster R Pool VM Host Name Item Measured

Disk Performance Chart

VC H VC H Amount of data read from the disk in the 
period 

VC H VC H Amount of data written to the disk in the 
period 

VC H VC H Aggregated storage performance statistics 

VC H VC H Number of disk writes in the period 

VC H VC H Number of disk reads in the period 

VC H VC H Resource Group CPU sample count

VC H VC H Resource Group CPU scheduling limit over 
one minute 

VC H VC H Resource Group CPU scheduling limit over 
5 minutes
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VC H VC H Resource Group CPU scheduling limit over 
15 minutes

VC H VC H Resource Group CPU running peak over 1 
minute

VC H VC H Resource Group CPU running peak over 5 
minutes

VC H VC H Resource Group CPU running peak over 15 
minutes 

VC H VC H Resource Group CPU running average over 
1 minute 

VC H VC H Resource Group CPU running average over 
5 minutes 

VC H VC H Resource Group CPU running average over 
15 minutes

VC H VC H Resource Group CPU active peak over 1 
minute 

VC H VC H Resource Group CPU active peak over 5 
minutes 

VC H VC H Resource Group CPU active peak over 15 
minutes 

VC H VC H Resource Group CPU active average over 1 
minute 

VC H VC H Resource Group CPU active average over 5 
minutes 

VC H VC H Resource Group CPU active average over 15 
minutes 

Table C-2.  Disk Performance Chart (Continued)

Inventory Object Resource

Cluster R Pool VM Host Name Item Measured



Basic System Administration

352 VMware, Inc. 

DRS

Memory

Table C-3.  DRS Performance Chart

Inventory Object Resource

Cluster R Pool VM Host Name Item Measured

DRS

VC  DRS effective CPU resources available

VC  DRS effective memory resources available

VC  DRS number of failures that can be tolerated

Table C-4.  Memory Performance Chart

Inventory Object Resource

Cluster R Pool VM Host Name Item Measured

Memory Performance Chart

VC  VC  VC H VC H Memory usage as percentage of total 
available memory 

VC  VC H VC H VC H Memory zero 

VC  VC H Memory state 

VC  VC H Free space in memory heap 

VC H Memory reserved capacity 

VC  VC H VC H VC H Amount of memory granted 

VC  VC H VC H VC H Amount of memory used by memory 
control 

VC  VC H Amount of memory that can be used by 
memory control 

VC  VC H Amount of memory that is unreserved 

VC  Amount of memory that is unreserved by 
swap

VC  VC H VC H VC H Amount of memory that is actively used 

VC  VC H VC H VC H Amount of memory that is shared 

VC  VC H Amount of memory that is used by swap

VC  VC H Amount of memory that can be swapped 
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VC H VC H Amount of memory that is swapped 

VC  VC H Amount of memory that is swapped in 

VC  VC H Amount of memory that is swapped out 

VC  VC H VC H VC H Amount of memory that is an overhead 

VC  VC H Amount of memory that is allocated for heap

VC H Amount of memory that is shared by 
common 

Table C-4.  Memory Performance Chart (Continued)

Inventory Object Resource

Cluster R Pool VM Host Name Item Measured
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Network

Resource Group

Table C-5.  Network Performance Chart

Inventory Object Resource

Cluster R Pool VM Host Name Item Measured

Network Performance Chart

VC H VC H Aggregated network performance statistics 

VC H VC H Amount of data received in the period 

VC H VC H Amount of data transmitted in the period 

VC H VC H Number of packets transmitted in the period 

VC H VC H Number of packets received in the period 

Table C-6.  Resource Group Performance Chart

Inventory Object Resource

Cluster R Pool VM Host Name Item Measured

Resource Group CPU Performance Chart

VC H VC H Resource Group CPU sample period

VC H VC H Resource Group CPU sample count

VC H VC H Resource Group CPU scheduling limit over 
one minute 

VC H VC H Resource Group CPU scheduling limit over 
5 minutes

VC H VC H Resource Group CPU scheduling limit over 
15 minutes

VC H VC H Resource Group CPU running peak over 1 
minute

VC H VC H Resource Group CPU running peak over 5 
minutes

VC H VC H Resource Group CPU running peak over 15 
minutes 

VC H VC H Resource Group CPU running average over 
1 minute 
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System

VC H VC H Resource Group CPU running average over 
5 minutes 

VC H VC H Resource Group CPU running average over 
15 minutes

VC H VC H Resource Group CPU active peak over 1 
minute 

VC H VC H Resource Group CPU active peak over 5 
minutes 

VC H VC H Resource Group CPU active peak over 15 
minutes 

VC H VC H Resource Group CPU active average over 1 
minute 

VC H VC H Resource Group CPU active average over 5 
minutes 

VC H VC H Resource Group CPU active average over 15 
minutes 

Table C-6.  Resource Group Performance Chart

Inventory Object Resource

Cluster R Pool VM Host Name Item Measured

Table C-7.  System Performance Chart

Inventory Object Resource

Cluster R Pool VM Host Name Item Measured

System Performance Chart

VC H VC H Number of seconds since startup 

VC H Number of heartbeats in this period

VC H Resource CPU usage
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A
access

permissions 262

rules 248

access permissions

assigning 263

changing 267

removing 268

active sessions 73

sending messages 73

terminating 73

adding

DVD/CD-ROMs 183

existing virtual machines 150

floppy devices 183

hosts 101

inventory objects 96

parallel port 183

serial port 181, 182

virtual machines 150

advanced configuration

hosts 110

alarms 24, 309

creating 314

editing 320

email notification 309

preparing SMTP notification 311

preparing SNMP notification 312

removing 321

tab 49

assigning

access permissions 263

audio

configuring 180

automating upgrades

VMware Tools 138

B
BusLogic SCSI adapter in virtual 

machine 126

C
canceling

scheduled task 301

changing

access permissions 267

CPU configuration 169

Ethernet adapter 165

floppy drive 162

memory 165

parallel port 166

port number 69

SCSI controllers 166

SCSI device 163

serial port 168

virtual disk 164

virtual machine power states 141

charts

performance 270

cloning

existing templates 206



Basic System Administration

358 VMware, Inc. 

existing virtual machines 215

roles 259

virtual machines to a template 205

clusters 23

removing hosts 106

shared storage 234

collecting

log files 87

commands

service console 38

configuring

audio 180

communication through a firewall 68

hosts 62

SMTP 311

SNMP 74

virtual machine hardware 160

virtual machines 159

VirtualCenter Server port 69

connecting

hosts 104

Console tab 49

CPU

advanced settings 176

changing 169

compatibility 238

configuration 169

CPUs

monitoring with SNMP 77

creating

alarms 314

roles 257

templates 204

virtual machines 114

custom

virtual machines 121

D
datacenters 23

datastores 23

deleting

exiting template 212

DHCP 38

disconnecting

hosts 104

disk

resources 179

disks

independent 225

monitoring with SNMP 77

DVD/CD-ROMs

adding 183

changing 161

E
editing

alarms 320

maps 280

roles 260

templates 208

email

notification option 311, 312

notification type 309

ESX Server

rebooting 32

ESX Server commands

viewing 65

Ethernet adapter

changing 165

events 24, 306

exporting 86, 307

navigation bar 49

tab 49

viewing messages 303
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exporting

events 86, 307

maps 285

F
firewall

configuring communication 68

floppy devices

adding 183

floppy drive

changing 162

folders 23

G
global maps 277

graphs

viewing 273

groups 248, 253

guest operating system

installing 132

H
hardware

new 181

virtual machines 160

heartbeat

monitoring with SNMP 78

host network configuration

viewing 64

hosts 22

about 99

adding 101

advanced configuration 110

automatically reconnecting 106

configuring 62

connecting 104

disconnecting 104

removing from clusters 106

removing from VirtualCenter 108

states 101

tab 49

I
image files

ISO 162

independent disks 225

installing

guest operating system 132

VMware Tools 133

inventory

maps 277

navigation bar 49

tabs overview 49

VirtualCenter 24

inventory objects

adding 96

moving 97

removing 98

ISO image files 162

K
knowledge base

accessing 13

L
license server 20

log files

collecting 87

logging off
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Last Updated: February 12, 2010

This document provides you with updates to ESX Server 3.0.1 and VirtualCenter 2.0.1 

version of Basic System Administration. Updated descriptions, procedures, and graphics 

are organized by page number so you can easily locate the areas of the guide that have 

changes. If the change spans multiple sequential pages, this document provides the 

starting page number only.

The following is a list of Basic System Administration page updates in this document:

 “Updates for the Configuring SNMP Trap Destinations Procedure on Page 80”

 “Updates for the Creating Custom Virtual Machines Procedure on Page 127”

 “Updates for the Installing and Upgrading VMware Tools Procedure on Page 134”

 “Updates for the Scheduling a Power State Change for a Virtual Machine 

Procedure on Page 149”

 “Updates for the Starting and Shutting Down Virtual Machines Procedure on 

Page 157”

 “Updates for the Changing the Audio Configuration on Page 180”

 “Addition of the Customizing a Linux Guest Operating System Procedure on 

Page 189”

 “Updates for the Preparing for Guest Customization Discussion on Page 190”

 “Updates for the Creating an Alarm Procedure on Page 319”
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Updates for the Configuring SNMP Trap Destinations 
Procedure on Page 80

The procedure “Configuring SNMP Trap Destinations” on page 80 contains errors. The 

correct procedure follows.

To enable and disable traps

1 Edit the config.xml file.

The configuration parameter snmp/generateTraps in the
/etc/vmware/hostd/config.xml file determines whether to generate a trap. By 

default, a trap is generated.

2 To disable traps, add the following entry to the file:

<plugins>
<snmpsvc><generateTraps>false</generateTraps></snmpsvc>

</plugins>

3 To reenable traps, remove the entry from the file. 

4 Restart vmware-hostd to see the change take effect.

Updates for the Creating Custom Virtual Machines 
Procedure on Page 127

Step 19 shows an incorrect screenshot for the Virtual Disk Capacity page of the New 

Virtual Machine wizard. The correct screenshot follows:
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Updates for the Installing and Upgrading VMware Tools 
Procedure on Page 134

The procedure “To install or upgrade VMware Tools (SEE UPDATE)” describes installing 

or upgrading VMware Tools on Windows guest operating systems only. The heading 

for this procedure should read “To install or upgrade VMware Tools on a Windows 

guest operating system.” 

This section of the manual omitted procedures for installing and upgrading VMware 

Tools on Linux, Solaris, and Netware guest operating systems. These procedures 

follow. 

To install or upgrade VMware Tools on a Linux guest operating system from X 
with the RPM installer

1 Open a console to the virtual machine.

2 Power on the virtual machine.

3 After the guest operating system starts, right‐click the virtual machine and choose 

Install VMware Tools.

The remaining steps take place inside the virtual machine. 

4 Do one of the following:

 If you see a VMware Tools CD icon on the desktop, double‐click it, and after 

it opens, double‐click the RPM installer in the root of the CD‐ROM.

 If you see a file manager window, double‐click the RPM installer file.

In some Linux distributions, the VMware Tools CD icon might fail to appear. In 

this case, continue to install VMware Tools from the command line.

5 When prompted, enter the root password and click OK.

The installer prepares the packages. 

6 Click Continue when the installer presents a dialog box that shows Completed 

System Preparation.

A dialog box appears with a progress bar. When the installer is done, VMware 

Tools is installed. There is no confirmation or finish button.

7 In an X terminal, as root (su -), run the following file to configure VMware Tools:

vmware-config-tools.pl

Respond to the questions. Press Enter to accept the default value.
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8 Exit from the root account:

exit 

9 In an X terminal, open the VMware Tools Properties dialog box:

vmware-toolbox &

To install or upgrade VMware Tools on a Linux guest operating system with the 
tar installer or RPM installer

1 If you have a previous installation, delete the previous vmware-tools-distrib 
directory before installing. The default location of this directory is:

/tmp/vmware-tools-distrib

2 Open a console to the virtual machine.

3 Power on the virtual machine.

4 After the guest operating system starts, right‐click the virtual machine and choose 

Install VMware Tools.

The remaining steps take place inside the virtual machine. 

5 As root (su -), mount the VMware Tools virtual CD‐ROM image and change to a 

working directory (for example, /tmp), as follows.

Some Linux distributions automatically mount CD‐ROMs. If your distribution 

uses automounting, do not use the mount and umount commands described in this 

procedure. You still must untar the VMware Tools installer to /tmp.

Some Linux distributions use different device names or organize the /dev 
directory differently. Modify the following commands to reflect the conventions 

that your distribution uses:

mount /dev/cdrom /mnt/cdrom
cd /tmp
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6 Uncompress the installer and unmount the CD‐ROM image.

Depending on whether you are using the tar installer or the RPM installer, do one 

of the following:

 For the tar installer, at the command prompt, enter:

tar zxpf /mnt/cdrom/VMwareTools-5.0.0-<xxxx>.tar.gz
umount /dev/cdrom 

where <xxxx> is the build or revision number of the release.

 For the RPM installer, at the command prompt, enter:

rpm -Uhv /mnt/cdrom/VMwareTools-5.0.0-<xxxx>.i386.rpm
umount /dev/cdrom 

where <xxxx> is the build or revision number of the release.

If you attempt to install an rpm installation over a tar installation, or the 
reverse, the installer detects the previous installation and must convert the 

installer database format before continuing.

7 Do one of the following:

 For the tar installer, run the VMware Tools tar installer:

cd vmware-tools-distrib
./vmware-install.pl

Answer the questions. Press Enter to accept the default value. 

 For the RPM installer, configure VMware Tools:

vmware-config-tools.pl

Answer the questions. Press Enter to accept the default value.

8 Log off from the root account.

exit

9 Start your graphical environment.

10 In an X terminal window, open the VMware Tools Properties dialog box:

vmware-toolbox &

To install or upgrade VMware Tools on a Solaris guest operating system

1 Open a console to the virtual machine.

2 Power on the virtual machine.
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3 After the guest operating system starts, right‐click the virtual machine and choose 

Install VMware Tools.

The remaining steps take place inside the virtual machine. 

4 Log in as root (su -) and, if necessary, mount the VMware Tools virtual CD‐ROM 

image, as follows.

Usually, the Solaris volume manager (vold) mounts the CD‐ROM in 

/cdrom/vmwaretools. If the CD‐ROM is not mounted, restart the volume 

manager by using the following commands:

/etc/init.d/volmgt stop
/etc/init.d/volmgt start

5 After the CD‐ROM is mounted, change to a working directory (for example, /tmp) 
and extract VMware Tools, as follows:

cd /tmp
gunzip -c /cdrom/vmwaretools/vmware-solaris-tools.tar.gz | tar xf -

6 Run the VMware Tools tar installer:

cd vmware-tools-distrib
./vmware-install.pl

Answer the questions. Press Enter to accept the default value. 

7 Log off from the root account.

exit

8 Start your graphical environment.

9 In an X terminal window, open the VMware Tools Properties dialog box:

vmware-toolbox &

To install VMware Tools on a NetWare virtual machine

1 Open a console to the virtual machine.

2 Power on the virtual machine.

3 After the guest operating system starts, right‐click the virtual machine and choose 

Install VMware Tools.

The remaining steps take place inside the virtual machine. 
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4 Load the CD‐ROM driver so that the CD‐ROM device mounts the ISO image as a 

volume. 

Do one of the following:

 On the system console for a NetWare 6.5 virtual machine, enter:

LOAD CDDVD

 On the system console for a NetWare 6.0 or NetWare 5.1 virtual machine, 

enter:

LOAD CD9660.NSS

When the driver finishes loading, you can begin installing VMware Tools, as 

described in Step 5.

5 On the system console, enter the following command:

vmwtools:\setup.ncf

When the installation finishes, the message VMware Tools for NetWare are now 
running appears in the logger screen (NetWare 6.5 and NetWare 6.0 guests) or the 

console screen (NetWare 5.1 guests). 

Updates for the Scheduling a Power State Change for a 
Virtual Machine Procedure on Page 149

Step 11 incorrectly describes when VirtualCenter verifies user permissions for a 

scheduled task. The correct text follows:

11 Click Finish.

Virtual Infrastructure Client adds the new task to the scheduled task list and 

completes the task at the designated time. When you create a scheduled task, 

VirtualCenter verifies that you have the correct permissions to perform the actions 

on the relevant datacenters, hosts, and virtual machines. After the task is created, 

the task is performed even if you no longer have permission to perform the task.

Updates for the Starting and Shutting Down Virtual 
Machines Procedure on Page 157

Step 9 does not clearly indicate how to enable automatic startup or shutdown of 

individual virtual machines. The step should include the following additional text:

Virtual machines listed under Manual Startup do not automatically start up or shut 

down. To automatically start up or shut down a virtual machine, you must move 

it so that it is listed under either Automatic Startup or Any Order. 
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In addition, to have the virtual machines gracefully shut down when the server is 

halted, do the following:

a Select the virtual machine and click Edit.

b In the Shutdown Settings group box, select Use Specified Settings. 

c From the Perform shutdown action list box, select Guest Shutdown. 

d Click OK. 

Updates for the Changing the Audio Configuration on 
Page 180

The instructions for “Changing the Audio Configuration” section can be ignored as the 

section incorrectly states that ESX Server supports audio devices. 

Addition of the Customizing a Linux Guest Operating 
System Procedure on Page 189

The instructions for customizing Linux guest operating systems were omitted from the 

chapter “Customizing Guest Operating Systems.” These instructions follow. 

Customizing a Linux Guest Operating System

You cannot start the Guest Customization wizard from a menu or toolbar option. The 

Guest Customization wizard starts indirectly from the Deploy Template wizard or 

Clone Virtual Machine wizard. 
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To customize a Linux guest operating system

1 Start the Guest Customization wizard.

2 On the Computer Name page, specify the Computer Name and the Domain Name 

for the virtual machine and click Next. 

The computer name is the name given to the particular instance of a guest 

operating system. The operating system uses this name to identify itself on the 

network. On Linux systems, it is called the host name. This is not the same as the 

virtual machine name that was declared earlier in the Deploy Template wizard or 

Clone Virtual Machine wizard. You can specify the computer name in these ways:

 Assign a specific name – The name can contain alphanumeric characters and 

the underscore ( _ ) and hyphen (‐) characters. It cannot contain periods (.) or 

blank spaces and cannot be made up of digits only. To ensure that the name is 

unique so that you do not incur conflicts, select Append a numeric value to 

ensure uniqueness.

 Use the virtual machine’s name – The computer name that VirtualCenter 

creates is identical to the name of the virtual machine on which the guest 

operating system is running.

 Respond to prompts for a name – The VI Client populates the Deploy Virtual 

Machine wizard with a prompt for the computer name after you complete all 

the steps in the wizard.

 Use a custom application to generate a name – The VI Client calls a custom 

application stored on the VirtualCenter Server to generate a name. If you 

select this option, enter the absolute path to the custom application in the 

associated text field.

3 To automatically configure all network interfaces from a DHCP server, select 

Typical settings on the Network page and click Next.

4 If VirtualCenter configuration is not appropriate for your environment, select 

Custom settings and click Next. 
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5 Select the NIC to customize and click Customize to make additional specifications. 

The Network Properties dialog box opens.

Use the Network Properties dialog box to perform these steps:

a On the General tab, select whether to use DHCP to obtain an IP address 

automatically or enter the IP addresses manually. Also select whether to use 

DHCP to obtain an DNS server address automatically or enter the DNS server 

addresses manually.

b Click OK to return to the previous dialog box. Click Next on the Network 

Guest Customizations page.

6 On the DNS and Domain settings page, enter the IP addresses for the DNS servers.

Specify the DNS connections by entering DNS suffixes. For each DNS suffix you 

enter, click Add. If you are adding multiple DNS connections, use Move Up and 

Move Down to specify the order in which a virtual machine is to use the 

connections. 

7 (Optional) On the Save Specification page, save the customized options as an 

.xml file by completing these steps:

a Select Save this customization specification for later use.

b Specify the path and filename for the specification and click Next.

VirtualCenter saves the customized configuration parameters in an .xml file. 
Later, you can import these predefined customized parameters when deploying a 

template or cloning an existing virtual machine. Because of encryption, saved 

customization files are unique to each VirtualCenter Server and to each version of 

VirtualCenter. You must recreate the customization files for each VirtualCenter 

Server. Encryption is preserved between upgrade versions on the same 

VirtualCenter Server. This means you can use the same files between upgrades of 

VirtualCenter. 

8 Click Finish. 

VirtualCenter closes the Guest Customization wizard and returns you to the 

Deploy Template wizard or Clone Virtual Machine wizard. 

9 Click Finish to deploy the virtual machine from the template or create the clone.
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Updates for the Preparing for Guest Customization 
Discussion on Page 190

The “Preparing for Guest Customization (SEE UPDATE)” discussion contains 

instructions to verify that the guest operating system meets the guest operating system 

customization requirements, but does not describe those requirements. This section 

should include the following additional information:

Virtual Hardware Requirements for Guest Customization

Guest customization requires that the source virtual machine used to create the clone 

or templates has the following:

 VMware Tools installed.

 At least one network interface card (NIC) configured.

When a virtual machine is cloned or used for a template, the new virtual machine 

has the same number and type of NICs, for example, AMD VLance/PcNet versus 

high‐performance VMware vmxnet. This configuration cannot be changed during 

the deployment or guest customization process.

 SCSI disks.

VirtualCenter customization operates on the disk attached to the virtual SCSI node 

with the lowest address on the SCSI controller with the lowest index. As a result, 

you must make sure that the guest operating system being customized resides on 

a disk attached as SCSI 0:0 node in the virtual machine configuration. 

For Windows guest operating systems: Both the active partition (the partition 

containing boot.ini) and the system partition (the partition containing the 
system directory, for example, \WINNT or \WINDOWS), are on the same virtual disk 

and attached the SCSI 0:0 virtual SCSI node. 

Active and system partitions are not required to be the same partition.

For Linux guests: The virtual disk containing the system partition (the partition 

containing the /etc directory) must reside on the SCSI 0:0 node.

 32‐bit or 64‐bit hardware corresponding to the 32‐bit or 64‐bit operating system 

being installed. 

Windows Requirements for Guest Customization

Guest customization of a Windows guest operating system can occur if:

 The guest operating system is not a primary or backup domain controller.



Updates for Basic System Administration

Update–12 VMware, Inc.  

 The clone or template has one of the following Windows versions installed:

 Windows 2000 Server, Advanced Server, or Professional

 Windows XP Professional

 Windows Server 2003, Web, Standard, or Enterprise Editions

 The Microsoft Sysprep tools are installed on the VirtualCenter server. 

For information on installing the Microsoft Sysprep tools, see “Installing the Microsoft 

Sysprep Tools” on page 345. 

Microsoft Sysprep tools have certain requirements and impose certain restrictions on 

the source machine. For additional information, see the Microsoft Sysprep 

documentation.

Linux Requirements for Guest Customization 

Guest customization of a Linux guest operating system can occur if:

 The clone or template has one of the following Linux versions installed:

 Red Hat Enterprise Linux AS 3.0

 Red Hat Advanced Server 2.1

 SUSE LINUX Enterprise Server 8, 9, or 10

 The clone or template has a root volume formatted with an ext2, ext3, or ReiserFS 

file system.

NOTE   Windows XP Home or Windows NT4 operating system guest 

customization is not supported. Guest customization of 64‐bit Windows operating 

systems is not supported. 

NOTE   Guest operating system customization is not supported for Linux virtual 

machines with disks managed by Logical Volume Managers. 
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Updates for the Creating an Alarm Procedure on Page 319
The description of running a script in Step 11 lists the following incorrect variable name 

entries:

 {entityName}

 {entityObject}

The correct variable name entries are as follows:

 {targetName}

 {target}
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